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Microsoft® Voice Command Version 1.5 for Windows Mobile®

IMPORTANT Do not become distracted from driving safely if
operating a motor vehicle while using Device Software.

Operating certain parts of this Device requires user attention.
Diverting attention away from the road while driving can possibly
cause an accident or other serious consequences. Even occasional,
short diversions of attention can be dangerous if your attention is
diverted away from your driving task at a critical time. Do not change
system settings or enter data non-verbally (using your hands) while
driving. Stop the vehicle in a safe and legal manner before attempting
these operations. This is important since while setting up or changing
some functions you might be required to distract your attention away
from the road and remove your hands from the wheel.

Microsoft makes no representations, warranties or other
determinations that ANY use of the Software Product is legal, safe, or
in any manner recommended or intended while driving or otherwise
operating a motor vehicle.

General Operation

Voice Command Control: Many of the functions of the Device
Software can be accomplished using only voice commands. Using
voice commands while driving allows you to initiate the command
with a button and then operate the Device mostly without removing
your hands from the wheel. Note: Voice Command not available in all
locations.

Prolonged Views of Screen: If you are driving, do not access any
function requiring a prolonged view of the screen. Pull over in a safe
and legal manner before attempting to access a function of the
system requiring prolonged attention. Even occasional short scans to
the screen may be hazardous if your attention has been diverted
away from your driving task at a critical time.

Volume Setting: Do not raise the volume excessively. Keep the
volume at a level where you can still hear outside traffic and
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emergency signals while driving. Driving while unable to hear these
sounds could cause an accident.

Let Your Judgment Prevail: The Device Software is only an aid.
Make your driving decisions based on your observations of local
conditions and existing traffic regulations. The Device Software is not
a substitute for your personal judgment.

Use of Speech Recognition Functions: Speech recognition
software is inherently a statistical process which is subject to errors.
It is your responsibility to monitor the speech recognition functions
and address any errors.
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Welcome

Congratulations on the purchase of your
Palm® Treo™ 700wx smartphone. In one
compact and indispensable device, you
now have all of the following:

« An advanced wireless smartphone

« A Windows Mobile® organizer with
portable memory card expansion
capability (MultiMediaCard/SD/SDIO)

« High-speed web browsing with support
for CDMA 1xRTT and EVDO wireless
technologies.

« A 1.3-megapixel digital camera
e Email

« Text messaging

« A media player

« Microsoft Office Mobile suite

This guide helps you set up your Treo
700wx smartphone and quickly learn to
use it.

NOTE Web, email, and text messaging
services require a service contract and
high-speed data service from your wireless

provider. Data speeds vary based on
network availability and capacity.

\What's in the box?

You should have received all of the
following items in the Treo 700wx
smartphone box:

Hardware

e Treo 700wx smartphone
« Rechargeable battery

« AC charger

« USB sync cable

e Headset

Documentation and software
e Read This First setup poster

« Treo 700wx Smartphone Quick
Reference Guide
« Getting Started CD that includes the
following:
« Using Your Palm Treo 700wx
Smartphone (this guide)
» Microsoft® Office Outlook® 2002

WELCOME



« ActiveSync® desktop synchronization
software

« Additional software for your
smartphone

o Palm warranty

What you need to
use your smartphone

As you work through the instructions in this
guide, you need all the items that came in
the Treo 700wx smartphone box (see

What's in the box? ) as well as the
following:

An activated account from your wireless
provider

A location with wireless coverage for
your smartphone

An electrical outlet

A computer you want to synchronize
your personal information with

NOTE To use email or web browsing, your
wireless provider service plan must include
data services.

2 WELCOME



Setting up your smartphone
and computer

Congratulations on the purchase of your new Palm® Treo™
700wx smartphone. You're about to discover the many things
about your smartphone that will help you better manage your
life and have fun, too.

As you become more familiar with your smartphone, you'll
want to personalize the settings and add applications to make it
uniquely yours. But first, take these few easy steps to set up
your smartphone and get it running.

Benefits
« Know where your smartphone
controls are located

« Start using your smartphone right
away

"CHAPTER
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Palm® Treo™ 700wx
smartphone
overview

Top view

Expansion
Antenna card slot Stylus

1 7
C ) «@9)

T —

Infrared (IR) port Ringer switch

DID YOU KNow? The ringer switch silences all
sounds, including music, when you need
quiet. There is no need to navigate menus.

PALM® TREO™ 700WX SMARTPHONE OVERVIEW @7
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Front view

Indicator light (phone  Earpiece

o 5-way navigator
and charge indicator)

Right action key

OK button

Power/End button

Center/Select button

Volume button

Side button

Left action key

Phone/Send button Microphone

Start button :
Multi-connector

Headset jack

TIP Be careful not to scratch or crush your
smartphone screen. Do not store it in a place
where other items might damage it. Visit
www.palm.com to find a variety of useful
accessories, including carrying cases that
protect the screen.

@ PALM® TREO™ 700WX SMARTPHONE OVERVIEW
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Back view

CHAPTER

Self-portrait mirror Battery door release

Camera lens

IMPORTANT The Palm® Treo™ 700wx
smartphone speaker includes a large
magnet, so be sure to keep your
smartphone away from credit cards or
other items that could be demagnetized.

PALM® TREO™ 700WX SMARTPHONE OVERVIEW @7
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T | 3 Insert the battery into the compartment

z Installing the battery y partme
at a 45-degree angle, and then press it
into place.

1 Use one hand to press the battery 4 Slide the battery door onto the back of
door release, and use the other hand to the smartphone until it clicks into place.
slide the battery door downward to Your smartphone screen turns on and
remove it from your smartphone. the Treo screen appears. Wait for the

2 Align the battery contacts with the progress bar on the Treo screen to fill
phone contacts inside the battery and the Windows Mobile® screen to
compartment. appear.

5 Follow the onscreen instructions to
finish the installation.

Battery door
release

@ INSTALLING THE BATTERY
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2 With the arrow on the connector facing
TIP If your smartphone does not turn on after up (toward your smartphone screen)

youiinsert the battery, youneedito charge it by connect the charger cable to the bottom
connecting it to the AC charger. If it still
of your smartphone.

doesn't start, do a soft reset. See Performing
a soft reset. e

¢

CHAPTER

TIP You can buy an extra battery as a spare for
long plane trips or periods of heavy data use.
Be sure to use batteries from Palm only.

Indicator light

Charging the battery

Before using your Palm® Treo™ 700wx
smartphone, you need to charge the
battery. See Battery life for tips on
maximizing the life of your smartphone'’s

battery.
3 Check the indicator light to confirm that

your smartphone is charging.
« Solid red indicates that your

IMPORTANT Charge the battery for 3.5
hours, or until the indicator light is solid

green. . .
smartphone is charging.
1 Plug the AC charger into a wall outlet. If « Solid green indicates that your
necessary, connect an adapter. smartphone is fully charged.

CHARGING THE BATTERY @
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DID YOu know? |f your battery ever becomes
fully drained, your info is stored safely on your
smartphone until you recharge the battery or
connect your smartphone to a power source.

TIP You can charge your smartphone using
your USB cable. The USB cable must be
directly connected to your computer or to an
externally powered (not buspowered) USB
hub.

/g | Start 1 Y| @=e:se

Battery

Service ) icon
T¥pe a name o number

Messaging

When your smartphone display is on (see
Waking up the screen and turning it off),
the onscreen battery icon displays the
charging status:

L®  Asolid lightning bolt indicates that
the battery is connected to a wall
outlet and is charging.

@, A shaded lightning bolt indicates
that the battery is connected to a
wall outlet and is fully charged.

rmm A partial battery without a lightning

bolt indicates that the battery is not
connected to a wall outlet and that
it has some power.

' Anexclamation point (1) indicates

that the battery needs to be
charged immediately.

DID YOU KNOow? Battery consumption varies
based on personal usage. Consumption
factors include signal strength, display
brightness, speakerphone usage, and the type
of calls you make (data or voice).

TIP If the indicator light does not turn on when
you connect your smartphone to the AC
charger, double-check the cable connection
and the electrical outlet to which it is
connected.

DID YOU kNow? Tapping the Battery icon

opens a window showing a percentage level
of charge left in the battery.

@ CHARGING THE BATTERY



Turning your
smartphone on/off

The phone and the screen of your Palm
Treo 700wx smartphone can be turned off
and on separately. This means you can
wake up the screen to use just the
organizer features of your device without
turning on the phone. Also, when the
screen is turned off, the phone can be on
and ready for you to receive and make
calls.

Turning your phone on and off

When you turn on your phone, it connects
to a wireless network so that you can make
and receive phone calls and use other
wireless services.

1 If you are not on a call and your screen
is off, briefly press Power/End (@) to
wake up the screen.

SETTING UP YOUR SMARTPHONE AND COMPUTER 0

wireless provider and the
signal-strength Y| icon appear at the
top of the screen, indicating that you
can use the phone and Internet features
(if supported by the local network).

Press and hold Power/End (@) again to
turn off your phone. When your phone is
off, “Phone Off” and the phone-off Ty
icon appear at the top of the screen.
Your smartphone is not connected to
any wireless network, but you can still
use the organizer and other features.

CHAPTER

DID YOu know? The indicator light flashes
green when your phone is on and you're
inside a coverage area. If you're outside a
coverage area, the indicator light flashes
amber and no bars appear in the
signal-strength icon.

TP If Sound Mode is on, you hear a series of
tones when you turn your phone on and off.
For more info on Sound Mode see Setting the
ringer switch.

2 Press Center @ on the 5-way to turn
off Keyguard.

3 Press and hold Power/End (& to turn
on your phone. When your smartphone
locates a signal, the name of your

Waking up the screen and turning it off

Wake up the screen and leave the phone
turned off when you want to use only the
organizer features of your smartphone, for
example, when you're on a plane and want

TURNING YOUR SMARTPHONE ON/OFF @
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to look at your calendar. You can also turn
off your smartphone’s screen without
turning off your smartphone’s wireless
features.

CHAPTER

1 Press Power/End [2) to wake up the
screen, and then press Center @ to
turn off Keyguard.

2 Briefly press Power/End (¥ to turn off
the screen.

TIP You can set how long the screen stays on
during a period of inactivity. Press Start,
select Settings, select the System tab, and
then select Power. Select the Advanced tab,
and then adjust the On battery power
setting.

Making your first call

The battery comes with a sufficient charge
to complete the setup process and activate
your Palm Treo 700wx smartphone. After
activation, we recommend charging your
smartphone for 3.5 hours (or until the
indicator light is solid green) to give it a full
charge.

1

2

Turn on your phone (see Turning your
phone on and off).

If you do not see your Today screen,
press Phone/Send (&).

£ | start ] Y| &= 9:59
R bl

Twpe a name or number
—

Messaging

If No Service appears in the upper left
or if you are unable to complete a call,
you may need to activate your phone.
Contact your wireless provider for
assistance.

If the name of your wireless provider
appears in the upper left, use the
number pad on the keyboard to enter
the number you want to call.

@ MAKING YOUR FIRST CALL
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Messaging

5 Press Phone/Send (&) to dial.

6 \When your call is complete, press
Power/End @) to end the call.

SETTING UP YOUR SMARTPHONE AND COMPUTER

2,
0,
B

Volume

button

What's my number?

1 Make sure your phone is on (see

TIP The Dial Lookup list might appear while
you are dialing a number. Continue entering
numbers to place the call. For more info on
the Dial Lookup list, see Dialing by contact

hame.

Turning your phone on and off).

2 If you do not see your Today screen,
press Phone/Send (&).

3 Press Menu 2 (right action key).
4 Select Preferences > Phone Settings.

Adjusting the call volume

While a call is in progress, press the
Volume button on the side of your
smartphone to adjust the call volume.

CHAPTER

MAKING YOUR FIRST CALL
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Look here for your
phone number

74 | Settings & Y| = R

Phone - (408) 555 -2760

Dialpad:

TTY/TTD:  [Off -

After calls from numbers that are not
in Contacts, ask if I want to add
themn,

Set ring bones For incoming calls.

phone | Services | Diaing | security

5 On the Phone tab, look for your phone
number below the title bar.

6 Press OK [@].

TP If your phone number doesn't appear on
the Phone Settings screen, press OK, and
then turn your phone off and back on again.
Repeat steps 2-6. If your phone number still
doesn't appear, your phone has not been
activated. Turn your phone off, wait a few
hours, and then repeat these steps. If your
phone number still does not appear, please
contact your wireless provider for assistance.

Synchronization—the
Basics

You can enter or change information on
your smartphone or in Microsoft Office
Outlook on your computer, and then
synchronize to automatically update the
info in both places; there is no need to
enter the info twice. We strongly
recommend that you synchronize your
smartphone and your computer frequently
to keep your information up-to-date (and
backed up) in both locations.

Before you can synchronize, you need to
install the desktop synchronization
software and connect the sync cable to
your computer. Even if have you have
already installed a previous version of the
ActiveSync® software, you must install the
software that came with your smartphone
on the Getting Started CD.

@ SYNCHRONIZATION—THE BASICS



TIP You can also synchronize your smartphone
with a Microsoft Exchange Server using
Microsoft Office Outlook. See Setting up an
Exchange Server email account.

TIP If you want to synchronize with a personal
information manager (PIM) other than
Microsoft Office Outlook, you must install a
third-party solution. Contact the third party or
vendor to learn whether software is available
for your Treo 700wx smartphone.

System requirements

Your computer should meet the following

minimum system requirements:

«  Windows 2000 or XP (later versions
may also be supported)

« 32MB of available memory (RAM)

« 170MB of free hard disk space

« CDdrive

« Available USB port

« USB sync cable (included with your
Palm Treo 700wx smartphone)

SETTING UP YOUR SMARTPHONE AND COMPUTER

Installing the desktop synchronization
software

BEFORE YOU BEGIN Check the following:

« You must have Windows Media Player
10 or later installed on your computer.

« |f you are installing on a computer at
work, make sure your company allows
you to install new software. Contact
your company'’s IT department for help.

1 Close any applications that are currently
running on your computer, including
those running in the background. Your
computer needs to have all its
resources available to install the
software.

2 Insert the Getting Started CD into the
CD drive on your computer.

3 Follow the onscreen instructions during
the installation. The Install program
prompts you to synchronize for the
first time. See Synchronizing contacts
and other info for more info on
synchronization.

TIP Need additional help installing the desktop
software? See Trouble installing the desktop
software?.

CHAPTER
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z Connecting your smartphone to your 1 Plug the AC charger into a wall outlet. If
computer necessary, connect an adapter.
NOTE If you're switching from a previous ~ 2 Plug the USB sync cable into an
Windows Mobile device or from a Palm available USB port or into a powered
0OS® device, you can learn more about how USB hub on your computer.
to move content, such as pictures, music, 3 With the USB cable on the left, connect
and files, to your smartphone by going to the sync cable to the bottom of your
www.palm.com/support. smartphone.

4 Connect the charger cable to the
connector on the sync cable.

USB sync
cable

This button has no function with
your Treo 700wx smartphone

@ SYNCHRONIZATION—THE BASICS


http://www.palm.com/support

TIP For best performance, plug your sync
cable directly into a USB port on your
computer. If your computer has USB ports on
both the front and back, we suggest using the
back port. If you use a USB hub, make sure it
is a powered hub.

SETTING UP YOUR SMARTPHONE AND COMPUTER 0
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2
Moving around on your

smartphone

Have you ever been to a new city and felt a bit lost until you
figured out the streets? Learning to move around on your
smartphone is similar. Most applications that work on your
smartphone use the same set of controls. So once you learn
how to use these controls, you'll be driving all over town and
you won't even need a map.

Benefits
e Quickly move around and « Access extra features with menus
complete tasks in applications « Find and open applications quickly.

using one thumb on the 5-way
navigator
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MOVi ng arou nd the screen with the stylus. As you become

familiar with your smartphone, you'll find
sScreen your own favorite way to scroll, highlight,
and select items.

The 5-way includes the Right I, Left €, Up
A, Down ¥, and Center @ buttons.

To move around the Palm® Treo™ 700wx
smartphone screen, you can use the 5-way
navigator or you can tap items on the touch

Center

MOVING AROUND THE SCREEN @
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TIP Some third-party applications may not
work with the 5-way navigator, therefore you
may be required to use your stylus instead.

DID YOU know? Custom navigation features
are available when you browse the web using
Internet Explorer. See Viewing a web page.

TIP The arrow icons that indicate directions on
the 5-way are different from the onscreen
scroll arrows and the arrows that indicate that
a list is available (see Selecting options in a
list).

Scrolling through screens

As on a computer, on your smartphone you
scroll to move from field to field or page to
page, or in some cases to highlight an item
or option in a list. There are several
methods of scrolling:

Press the 5-way on the front of your
smartphone. Press Right P, Left 4,
Up A, or Down ¥ to move to the next
field, button, or action in that direction.

Press and hold Option @ while
pressing Up a or Down ¥ to scroll
one screen at a time. These keys work
just like the Page Up and Page Down
keys on your computer keyboard.

Press and hold Option © while
pressing Left € or Right » to jump to
the top or bottom of the current screen.

When viewing a screen with tabs, such
as when adding a contact, press
Down ¥ to scroll to the tabs, and then
press Left 4 or Right » to move
between tabs.

Scroll arrows

74 | Calendar [Eu iy ®
ul 05,05 [sMEAwTFs B 4]
Submit Final Draft

Meet with Donna & Nancy =
10:00a-11:00a (Conference Cally

Lunch with Greg
12:00p-1:00p
Team meeting
1:00p-2:00p

Class

Scroll arrows

When inside a text field, press Right
or Left €4 to move to the next character,
and press Up a or Down ¥ to move
between lines.

@ MOVING AROUND THE SCREEN
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« When inside a list, press and hold Highlighting and selecting items z
Up 4 or Down ¥ to rapidly scroll On most screens, one item—a button, a
through the list. list entry, or a check box—is highlighted by
» Tap an onscreen scroll arrow. default. The highlight identifies which item
« Tap and drag the slider of an onscreen is affected by your next action. Use the

5-way to move the highlight from one item
to another before opening or selecting it.

Closing screens The highlight can take one of two forms,
To accept the information you entered ona  depending on what is highlighted:
screen and to return to the previous
screen, do one of the following:

scroll bar.

« Border glow: This rectangular border
highlights items such as an onscreen

« Press OK (@]. button (such as OK, Dismiss, or Hide),
« Use the stylus to tap [ or B in the a check box, an option, or a web link.
upperright corner of the screen.

NOTE When you close a screen, the

application still runs in memory. See » Reverse type (light text on a dark

\iewing memory usage for instructions background): This highlights items such

about viewing the amount of memory in as a phone number, an email address,

use versus the available memory. See The text, or an item in a list.

applications are running slower than usual . B

for mstrgcnons about closing applications Errel Mohil =

and freeing up memory. Outlook E-mail ]
ActiveSync -

MOVING AROUND THE SCREEN @
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After highlighting an item with the 5-way,
you can select or activate it by pressing
Center @D or by tapping the item with the
stylus.

TIP The best way to learn to use the 5-way is
to experiment. Press the 5-way buttons and as
you do, follow the movement of the border
glow around the screen. The behavior of the
5-way varies slightly in each application.

Highlighting text

You can use the stylus to highlight text on
the screen:

« Tap and drag the stylus across the text
you want to highlight. To highlight a
word, double-tap it. To highlight a
paragraph, triple-tap it.

Using the action keys

The left and right action keys give you quick
access to tasks that you can do on the
current screen, so the action key items
vary from application to application and
from screen to screen. Look on the screen
directly above the action key to see the
action that it does in the current context. In
some contexts, these keys may do nothing
at all. In most cases the right action key
—— opens the menu, and the left action
key T activates a specific command,
such as New or Edit. Remember that
action key functions vary from screen to
screen, so be sure to check the onscreen
label before pressing an action key.

@ MOVING AROUND THE SCREEN
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] LATPM TES
Left action key activates Right action key activates

this command ] Diséss this command

Left action key Right action key

Selecting menu items

In many applications, a menu provides aul 05,05 EMEwTES B 4|0
access to additional features. The menu is Submit Final Draft
hidden until you press Menu —— (right ';";;;a"‘;‘l“n';
action key). To get the most out of your Lunch with G

smartphone, it's a good idea to familiarize 20 L e+
yourself with the additional features Toom e e ’
available through the menu in various Class o .
applications. by =] E

1 Press Menu 2 (right action key) to 2

. . Press U or Down ¥ to highlight a
display an application’s menu. P ghlig

menu item.

MOVING AROUND THE SCREEN (25)
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3 If an arrow appears next to a menu
item, press Center @ or Right P to
display additional options for that item,
and then press Up a or Down ¥ to
highlight a menu item. To return to the
main menu without making a selection,
press Left €.

CHAPTER

4 Press Center @ to select the menu
item, or press Left 4 or Menu ——
(right action key) to close the menu and
cancel your selection.

DID YOU KNOw? You can use keyboard
shortcuts to select most menu items. To
quickly access a menu item, press Menu
(right action key) followed by the underlined
letter in the menu item’s name.

Selecting options in a shortcut menu

Most applications also provide access to
context-sensitive, shortcut menus—similar
to the right-click menus on a computer. The
shortcut menu options vary based on the
highlighted selection.

1 Highlight the item you want to open

the shortcut menu for.

74 | Calendar
ul 05,05 [SMAwWTES B
Submit Final Draft

Meet with Donna & Nancy
New Appointment

Beam Appointment...

Delete Appointment

Cut
Copy

Press and hold Center @D to open the
shortcut menu.

Press Up a or Down ¥ to highlight a
menu item.
Press Center @D to select the menu

item or press Left € to cancel your
selection.

TIP You can also tap and hold an item with the
stylus to open the shortcut menu.

@ MOVING AROUND THE SCREEN



Selecting options in a list

Lists let you select from a range of options.

You can identify whether a list is available
when you select the field. If a rectangle
appears around the field along with a

downward-pointing arrow, a list is available.

Lists are different from the menus
described earlier in this section.

r
/4 | calendar

Subject:
Location: v
Starks: 7/5/05  12:00 PM
Ends: 7/5/05  1:00 P H
Al Day: Mo
Occurs: Once H
Remind me
15 minute(s)
Cateqaries; NO cateqories... i
Appointment | Hates |

B Menu

Remindear:

74 | calendar [ Y| o= ok

Subject:
Location: [Meat with
Starts: [Lunch
Ends: [PiNNer

[Wisit
AlDay: |y

Ocawrs: itz
Reminder: IComplete
[Confierence

Cateqories: MO cateqories... i
Appointment. | Kotes

B Menu

To select from a list, do any of the

MOVING AROUND ON YOUR SMARTPHONE o
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following:

Use the 5-way to highlight the field, and
then press Center @ to display the
items in the list. Press Up a or Down

to highlight the item you want, and
then press Center @ to make your
selection.

Use your stylus to tap the arrow, and
then tap the item in the list.

To exit the list and cancel your selection,
press Left

TIP When selecting fields you might not see
the downward-pointing arrow until you press
Center on the 5-way.

DID YOU kKnow? In fields where you see a
downward-pointing arrow but no rectangle,
you must tap the arrow with the stylus to
expand the field.

MOVING AROUND THE SCREEN (27)
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Using the keyboard

Left action key
Phone/Send

Start

Right action key
Power/End

OK

Backspace

Option Return

Shift Shift

TIP When using the keyboard, most people
find it easiest to hold the smartphone with
two hands and to use the tips of both thumbs
to press the keys.

@ USING THE KEYBOARD



Understanding the keyboard backlight

Your smartphone includes a keyboard
backlight for low light conditions. The
keyboard backlight is activated
automatically when the screen turns on.
The backlight turns off automatically when
the screen turns off or when you are on a
call or playing music in the background for
longer than the time specified in Backlight
Settings. You can set different time
intervals depending on whether the
smartphone is operating on battery power
or is connected to an external power
source. The backlight also turns off when
an application’'s power-saving features turn
it off.

TIP You can change the backlight shut-off
interval. Press Start and select Settings.
Select the System tab, and then select
Backlight. Set the time interval on the
Battery Power tab and on the External
Power tab.

DID YOU Know? The keyboard backlight dims in
parallel to the screen backlight.

MOVING AROUND ON YOUR SMARTPHONE

Entering lowercase and uppercase letters

By default, the first letter of each sentence
or field is capitalized and the remaining text
you enter is lowercase. To enter other

uppercase letters, do one of the following:

« Press Shift Gy, and then enter a letter.
You don’t need to press and hold Shift
while entering a letter.

» Press Shift &) twice to turn on Caps
Lock, and then enter a series of letters.
When Caps Lock is on, this symbol
appears at the bottom of the screen: 4.
To turn off Caps Lock, press Shift Gy
again.

TIP You can turn off the first letter
capitalization setting. For details see Setting
input options.

CHAPTER
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Entering numbers, punctuation, and
symbols

CHAPTER

Numbers, punctuation, and symbols
appear above the letters on the keys. To
enter these characters, do one of the
following:

« Press Option @), and then press the
key of the desired character. You don't
need to hold Option while pressing the
key.

« Press Option @ twice to turn on
Option Lock, and then press the
desired keys to enter a series of
characters. When Option Lock is on,
this symbol appears at the bottom of
the screen: #. To turn off Option Lock,
press Option @ again.

Entering other symbols and accented
characters

You can enter symbols and accented
characters that don’t appear on the keys
using the alternate characters list.

Press Alt to display the alternate
character list.

Narrow the list by pressing the key that
corresponds to the character you want.
For example, to enter an &, press E. See
Symbols and Accented Characters.

Press Up a or Down ¥ to highlight the
desired character.

Press Center @ to insert the
character.

TIP The alternate characters are grouped
according to their similarity to the
corresponding key. For example, the alternate
characters available for the e key are &, &, &,
and é. If you press the wrong key, press
Backspace to return to the full list of alternate
characters. You can then press another key.

pID You kNow? [f you don't know which key to
press to narrow the list when entering a
symbol, you can scroll through the full list until
you find the character you want.
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Symbols and Accented Characters 5

Press Alt and Press Alt and

enter... to select... enter... to select...

a dasaaae S RSS§

A AAAAAA A& tor T ™

borB R u auia

c c¢© U VEVRSRU!

C C¢O x or X X a

e SEEE y 2%

E EEEE Y Yy

i it 0 ®

| (il 1 /7

lorL £ 2 :

n f 3 7

N N f f

o 6060600 F f

0 0000CEO0 $ €E¥¢
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rorR ® ? ¢
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Opening and closing
applications

Opening applications
You can access all the applications on your
smartphone through the Start menu:

1 Press Start (&) to open the Start
menu.

E@ L0
€, Today
alendar
Contacts
ternet Explorer

@

& Messaging
[ Pictures & Yideos
& Windows Media

Camera

File Explorer

% Programs
+ Settings
7 JHelp

2 Use the b-way navigator to highlight the
application you want to use. To view
additional applications, select
Programs.

3 Press Center @ to open the
highlighted application.

4 (Optional) Press OK to return to
Programs and open another
application. The current application
continues to run in the background.

TIP With the Start menu open, you can press
the letter underlined in the application’s name
to open the app. For example, press H to open
Help. You can also select the shortcut icons at
the top of the Start menu to open recently
used applications.

DID YOU KNOW? You can open apps by pressing
Option and then pressing Phone/Send, Start,
or OK. You can customize the apps assigned
to these button combinations; see
Reassigning buttons for details.

Closing applications

You can have several applications open at
once, so you don't need to exit an
application to open another one. In most
cases, applications close automatically
when available memory is low, but you can
also close applications manually.

1 Pressandhold OK to open Memory
Settings.

@ OPENING AND CLOSING APPLICATIONS



2 On the Running Programs tab, do one
of the following:
« Select the application you want to
close, and then select Stop to
close it.
« Select Stop All to close all your open
applications.

NOTE If you press OK (@] to return to
Programs, the current application
continues to run in the background.

TIP You can also open Memory Settings from
the Start menu. Press Start, select Settings,
select the System tab, and then select
Memory.

Title bar and
status info

H w | Start

Service

Speed dial
entries

Messaging

| Type a name or nurnbet

MOVING AROUND ON YOUR SMARTPHONE

Using your Today
screen

Your Today screen is your home base. From
your Today screen you can quickly look up a
contact, dial a phone number or speed dial
button, see your latest calendar
appointments, see the number of unread
email messages, and even search the web.

To access your Today screen, press
Phone/Send (&).

TIP You can select a picture for your Today
screen background and select which items
appear on the Today screen. See Today screen
settings for details.

[0 Y| = 9:59

S

—— Dial Lookup field

—— Web search field

CHAPTER
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« Title bar and status info: See What are

over a Bluetooth connection and

all those icons? to learn about the icons
that appear in this area.

« Dial Lookup field: Begin typing the
name you want to look up. See Dialing
by contact name for more info.

«  Web Search field: Enter a word you
want to find on the Internet, and press
Center @ to begin the search (data
services connection required).

» Speed dial entries: Select the speed
dial you want to dial. This can be a text
button or a picture speed dial. See
Defining speed dial buttons to create
your own.

Synchronizing
contacts and
other info

Each time you connect your smartphone to
your computer, it automatically
synchronizes the items that are set to sync.
You can synchronize using a cable or you
can sync wirelessly. See Synchronizing

Synchronizing over an infrared connection
for more information about synchronizing
wirelessly.

To use ActiveSync, you must first install the
software from the Getting Started CD that
came with your smartphone. See Installing
the desktop synchronization software for
instructions.

If you want to use Direct Push Technology,
make sure you are accessing an Exchange
Server 2003 upgraded to Service Pack 2.
See Setting up an Exchange Server email
account.

You can customize the sync settings (see
Setting synchronization options) or use the
default settings to synchronize your info in
the following applications:

B3] Contacts &) Calendar (=3 E-mail
Tasks [C51Favorites

1 Connect your smartphone to your
computer. You should hear the
ActiveSync® tone.

@ SYNCHRONIZING CONTACTS AND OTHER INFO



This button has no
function with your
Treo 700wx smartphone

Look for the ActiveSync 4¥ icon at the
top of your smartphone’s screen and
the ActiveSync @ icon in the taskbar
on your computer.

If you don't see the ActiveSync icon,
make sure the desktop
synchronization software that came
with your smartphone is running on
your computer.

If you have any problems
synchronizing, see Synchronization
(ActiveSync® software) for
troubleshooting suggestions.

MOVING AROUND ON YOUR SMARTPHONE

TIP We recommend that you install a backup
and restore application. A backup and restore
application preserves your data and settings if
your smartphone is ever lost or stolen, and it
protects your data during a hard reset. See
www.palm.com/treo700wx-support for more
information.

Battery life

BEFORE YOU BEGIN The battery comes
with a sufficient charge to complete the
setup process and activate your phone.
After activation, we recommend charging
your smartphone for 3.5 hours (or until the
indicator light is solid green) to give it a full
charge.

Battery life depends on individual usage.
When used as a smartphone, your
smartphone battery provides up to 4.7
hours of talk time or up to 15 days of
standby time.

TIP If the battery is fully drained, it may take a
few moments for the indicator light to turn on
while charging.

CHAPTER
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Maximizing battery life

CHAPTER

You can increase your smartphone's
battery life by following a few easy
guidelines. Remember that battery life
depends on how you use your smartphone.

« Charge your smartphone whenever
you're at your desk, or charge
it overnight each day. The battery in your
smartphone has a much longer useful
life when it is topped off frequently,
versus charging it after it is fully drained.

« If you spend a lot of time using the
camera, games, media players, eBooks,
or other applications, keep an eye on
the battery icon and charge when
necessary.

« Your smartphone's wireless features
(phone, email, messaging, and web)
generally consume more power than
the organizer features. If you don't plan
to use the wireless features on your
smartphone for a while, turn off your
wireless services (see Turning Wireless
Services On/Off). You can forward calls
to a different number or let all calls be
picked up by voicemail (see Forwarding
calls). To see if your wireless services

are on, tap the phone-off W icon, and
then select Wireless Manager.

Turn off your smartphone’s Bluetooth®
wireless technology feature when you
do not need to make a Bluetooth
connection.

As with any wireless phone, if you are in
an area with no wireless coverage, your
smartphone searches for a signal, which
consumes power. If you cannot move to
an area of better coverage, temporarily
turn off your phone (see Turning your
phone on and off).

Turn down the screen brightness (see
Adjusting the brightness).

Set your screen to turn off automatically
after a shorter period of inactivity (see
Viewing and optimizing power settings).

Keep your battery away from direct
sunlight and other sources of heat.
Temperatures over 120 degrees
Farenheit (50 degrees Celsius) can
permanently reduce the capacity and
life span of any lithium-ion battery.

@ BATTERY LIFE



« |f you are using Direct Push technology
(MSFP) for email, set your device to
sync every 30 minutes or more. Email
synchronization can quickly consume
battery power.

DID YOU know? |If the battery drains to

the point where your smartphone doesn’t turn
on, your smartphone stores your info safely
until you recharge the battery. To avoid
draining the battery, we recommend that you
charge and synchronize every day, especially if
you use your smartphone often.

Where to learn more

For a quick introduction

« Quick Tour: The Quick Tour highlights
many of your smartphone's features.
It is already installed on your
smartphone, and you can open it at any
time. Press Start (&), select Programs,
and then select Quick Tour @

While using your smartphone

« Help: Many of the built-in applications
include on-device Help, so that you can

MOVING AROUND ON YOUR SMARTPHONE

learn about the tasks you can perform in
that application. To access Help, go to

the application or screen you want help
with, press Start (&), and select Help.

Online support from Palm: For
up-to-date downloads, troubleshooting,
and support information, check out
www.palm.com/support.

If you need more information

Books: Many books on Windows
Mobile® devices are available in local or
online book retailers (look in the
computers section), or visit
Wwww.palm.com.

Online forums: Consult online Treo
700wx smartphone user discussion
groups to swap information and learn
about topics you may find nowhere
else. Visit www.palm.com/support for
details.

Your wireless provider customer
service: For questions about your
account or features available on the
network, contact your wireless provider
customer service.

CHAPTER
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Using Your Phone

The phone, along with the Today screen, is your home base for
making and receiving calls.

You can creatively manage multiple calls; for example, you can
swap between calls, send text messages to ignored calls, and
create conference calls.

And you can do more than manage your phone calls. You can
send text messages, open applications, go to your favorite web
pages, see your upcoming appointments, and even find out
how many unread email messages you have.

Benefits
« Stay in touch—you choose how « Create speed-dial buttons with
«  Work in other applications when pictures of your friends

on an active call
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Phone overview

You can make and receive calls and store
speed dial entries right from your Today
screen. Be sure you know how to turn on
your phone before reading this section (see
Turning your phone on and off).

IMPORTANT Depending on where you are
on a wireless network with certain
coverage conditions, you might experience
interruptions with your phone operation
while using a Wi-Fi card (you must
purchase and install a third-party Wi-Fi card
to use this feature). Palm recommends that
you turn off the phone radio when using
any Wi-Fi card with your smartphone or
remove the Wi-Fi card when not in use to
ensure that you can always make and
receive phone calls. For EMERGENCY
calls, always remove the card from your
smartphone to ensure optimal connectivity.

USING YOUR PHONE e

Accessing your Today screen
Press Phone/Send (&.

CHAPTER

r » | Start

G0 Y| o 0:59
20

Service

S Type a name or number

Messaging

TIP If you press Phone/Send while a number
is highlighted, your device dials the number.
To access the Today screen when a number is
highlighted, deselect the number before
pressing Phone/Send or select Today from
the Start menu.

What are all those icons?

You can monitor the status of several items
using icons at the top of your Today screen:

You missed an incoming call.

¢
&

You have a voicemail message.

PHONE OVERVIEW @
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[+
w
s
o
< . P
z You have a new email or text ", A 1xRTT data call is in progress.
message. Al You can make calls, but you
An error occurred during cannot receive calls; any
@ synchronization. incoming calls go to voicemail.
You h h fth When you make a call, the data
@ Oud‘a,ve m;)reé at? one ot the transmission is automatically
conditions listed above. interrupted.
_.|| Yrc])ur phor;e s on. ‘}:hihbars display EY, An EVDO data call is in progress.
the s!gnal str:engt ) b estronger 4 You can still make or receive calls.
Tf e signal, t eAdmore ars appear. When you make or receive a call,
you arebout3| € a coverage the data transmission is
area, no bars appear. automatically interrupted.
» Your phone is off. " Your phone is connected to a
You are outside your wireless “ IXRTT data network, but you are
R provider's coverage area and not actively transmitting data. You
roaming on another wireless can still make or receive calls.
service provider’'s network. EY. Your phone is connected to an
A voice call is in progress L EVDO data network, but you are
‘T|| ) not actively transmitting data. You
1% You are in an area that supports can still make or receive calls.
1XRTT data services. 4-:-; Your Palm® Treo™ 700wx
G You are in an area that supports smartphone is connected to a
EVDO data services. computer or network that is
providing a data connection.
‘_-;;‘ A data connection is not available

or your phone is off.

@ PHONE OVERVIEW



+3 ActiveSync is currently
synchronizing with the Exchange
Server.

i Your smartphone's battery is low.

m Your smartphone's battery is
charging.

@ Your smartphone is connected to
a power outlet and the battery is
fully charged.

Network Your phone is on and you are in
name  your wireless provider's coverage
area. If you are outside a

coverage area, No service or
Roaming appears instead. When
you turn off your phone, Phone
Off appears instead.

vP Voice privacy is preventing
over-the-air eavesdropping. The
icon appears during a call when
this option is turned on and when
voice privacy is available on your
wireless provider's network.

USING YOUR PHONE ‘a’

The location privacy setting is set
to Location On. Your location is
available to your wireless
provider's network and other
applications. The icon appears
with a red slash when the
Location Privacy option has
been selected. See Selecting
your privacy settings for more
information.

CHAPTER

The Bluetooth® wireless
technology status indicator
appears in gray when this feature
is off, in blue when this feature is
on, and in reverse blue when your
smartphone is communicating
with another Bluetooth device.

A call is in progress and your

smartphone is connected to a
Bluetooth headset or car kit.
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key TERM EVDO (Evolution Data Optimized): A
wireless broadband technology that is
designed for very high-speed data transfer
with average download speeds of
400-700Kbps, capable of reaching speeds up
to 2Mbps, and upload speeds up to 156Kbps.

key TERM 1XRTT (Single-carrier [1x] radio
transmission technology): A wireless
technology that can provide fast data transfer
and Internet access with average download
speeds of 60-80Kbps and bursts up to
144Kbps.

pID You kNnow? During a voice call you can
send text messages, but you cannot use data
features such as web browsing and email.

TIP Data services may not be available when
you are roaming on partner networks.

TIP To quickly turn the Bluetooth feature on
and off, tap the Bluetooth icon to access the
Bluetooth Settings screen.

TIP To display the remaining battery power,
tap the battery icon. To close the battery
status window, select Hide.

Making calls

BEFORE YOU BEGIN Make sure your
phone is on (see Jurning your phone on
and off) and that you're inside a coverage
area.

Your smartphone offers several ways to
make phone calls. Try them all and you'll
discover which methods you prefer.

Dialing with the number pad

1 Go to your Today screen (see Accessing
your Today screen).

2 Using the numbered keys on the
keyboard, enter a phone number.

3 Press Phone/Send (& to dial.

@ MAKING CALLS



NOTE You do not need to press Option to
access the numbers on the keyboard.
However, when dialing short numbers,
such as 411, the number may conflict with
a contact name. If this occurs, press
Option Q) to avoid starting a contact
lookup. You can always dial emergency call
numbers without pressing Option first.

DID YOU kKnow? After you initiate a call, you do
not need to press Option to access the * and
# keys when responding to further dialing
instructions.

Dialing by contact name

You can look up contacts quickly by
entering just a few letters of a contact’s
name directly from your Today screen.
Before you can dial a call by contact name,
you must create some contacts (see
Adding a contact) or import them by
synchronizing (see Synchronizing contacts
and other info).

1 Go to your Today screen (see Accessing
your Today screen).

USING YOUR PHONE

2 Using the keyboard, begin entering one
of the following for the contact you
want to call:

=~ Talrn, Marzi

EY

[25] Zaln, Faracla

(2] Zaln, Gayed
(630) 555-3699 m

(403) 555-0807 w

Search... -

First name (JOH for John)

Last name (SMI for Smith)

First initial, a space, and then last
initial (J S for John Smith)

First name and last name

(JOH SMI for John Smith)

For example, entering SM finds both
Smilla Anderson and John Smith.
Entering SM A finds only Smilla
Anderson.

3 Select the number you want to dial.
4 Press Phone/Send (& to dial.

CHAPTER
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DID YOU know? After you look up a contact, 7 | start [0 Y| @=a:59

you can select how you want to communicate OeliE U
with that person. Press and hold Center on s
the 5-way, and then select the I
communication method you want to use.

TIP To see a contact’s address, company, and
other details, highlight the name and press

Center on the 5-way. @3 [zearch. .

TIP To clear the Dial Lookup field and start Hesaoning

another Contacts search, press OK. To delete

letters when correcting a misspelled name, You can make a call with your speed dial
press Backspace. buttons by doing any of the following:

TIP Until you change the View By setting, your . Highlight a speed dial button with the

contact list (in the Contacts application) is 5-way, and then press Center @.
sorted by contact name.

« Tap a speed dial button with the stylus.

Dialing with a speed dial button « From the Today screen, press and hold
a Quick Key that you assigned to the

Before you can use a speed dial button, :
v P speed dial button.

you must create some speed dial entries.
See Defining speed dial buttons. To see more speed dial buttons, highlight

the picture speed dial area and press Right
) or Left 4 repeatedly, or highlight the text
speed dial area and press Up a, Down ¥,
Right b, or Left €.
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DID YOU KNOW? You can dial an alternate
number for a contact with a speed dial button.
Highlight the speed dial button, press and hold
Center on the 5-way, and then select a
number from the shortcut menu.

TIP You can customize the default speed dial
buttons. See Editing a speed dial button.

Dialing by company name
1 Press Start (#) and select Contacts.

2 Press Menu 2 (right action key) and
select View By > Company.

3 Press Phone/Send @ to go to your
Today screen.

4 Using the keyboard, begin entering the
first few letters of the company name.

EY

=] Zalm, Faradla

[E=] Zalrn, Gayed

i (650) 555-3699 m
[E=] Zalrn, Marzi

(408) 555-9807 w

Search... |

USING YOUR PHONE o

5 Select the number you want to dial.
6 Press Phone/Send (& to dial.

Dialing from a web page or message

Your smartphone recognizes most phone
numbers that appear in web pages or in
messages (text or email).

Yellow Pages s»
vellowPages.com

Canadad11

white Pages s»
555-1212
Canadad11

1 Use the 5-way to highlight the phone
number you want to dial in the web
page or message.

2 Press Center @ to open the Phone

dialog box, and then select Yes to dial.

CHAPTER
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TIP If you can't dial a phone number directly
from a web page or a message, then highlight
the number, press and hold Center on the
5-way, and select Copy. Open the Dial Pad,
and then press and hold Center on the 5-way
to paste. Press Phone/Send to dial.

Redialing a recently called number

To dial the last number you called:
Go to your Today screen, and then press
and hold Phone/Send (&).

To select from your most recently
dialed numbers: Go to your Today
screen, press Phone/Send (&),
highlight the number or contact name
you want to call, and then press Phone/
Send (&) to dial. If more than one
number is associated with a contact,
highlight the contact and press Right »
to access any alternate numbers for that
contact.

/g | Start 0 Y| @ 9:59

Service

{83 Tvpe a name or number

€9

To select from a chronological list of
calls: Go to your Today screen, press
Phone/Send (&), and then select Call
Log. Highlight the number you want to
call, and then press Call T (left
action key) to dial.

& Y| = R
Spear, Midyne
(E31)953-3963 w
Faraola, Jane
(8311 555-7534 w
Spear, Midyne

(E31)953-3963 w
Spear, Midyne 7i3f05
(831} 555-3563 w
831-555-6737 7/2{05
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TIP You can also access the Call Log and Dial
Pad from the Today screen by pressing Menu
(right action key) and selecting Call Log or
Dial Pad.

Dialing using the onscreen Dial Pad

The onscreen Dial Pad provides large
numbers that you can tap with your finger
or your stylus. The numbers also include
the corresponding letters so that you can
dial numbers that are expressed as letters.

1 Go to your Today screen.

2 Press Phone/Send @ and then select
Dial Pad from the menu.

3 Tap the onscreen Dial Pad to enter the
number.

4 Press Phone/Send (&) to dial.

0 v = X

Delete

CHAPTER

DID YOU KNOw? You can paste numbers
directly into the Dial Pad. Copy a number from
another application, switch to Dial Pad, and
then press and hold Center on the 5-way to
paste the number.

Receiving calls

To receive calls, your phone must be on.
To answer a call, do one of the following:

« Press Phone/Send (&).
« Press Answer T (left action key).

« If the headset is attached, press the
headset button.

To ignore a call and send it to voicemail, do
one of the following:

« Press Power/End ().

e Press Menu 2 (right action key) and
select Ignore.

« Press Menu 2 (right action key) and
select Ignore with text message to
send the caller a text message.

RECEIVING CALLS @
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To silence the ringer while your
smartphone is ringing:

CHAPTER

« Press any key on your smartphone
except Phone/Send, Power/End,
Start, OK, Alt, or the 5-way. You can
also use the Volume button to turn the
ringer sound all the way down.

« To immediately silence all system
sounds including the ringer, slide the
Ringer switch to Sound Mode Off .
All sounds remain off until you slide the
Ringer switch back to Sound Mode
On o).

When you silence the ringer, you can either

answer the call or let it ring through to

voicemail.

pID You know? \When you are on a plane, you
can turn off your phone and all wireless
services using Wireless Manager (see Turning
Wireless Services On/Off). But you can still
wake up the screen and use any app that
doesn't require wireless services, like your
smartphone’s calendar, music player, and
games.

TIP See a picture of the person calling you.
Learn how to assign a caller ID picture in

Assigning a picture and ringtone ID to a
contact.

TIP If music is playing when a call arrives, the
smartphone rings softly. You can answer the
phone as you normally would. The audio
pauses during your call.
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Using voicemail

Setting up voicemail

-‘, | Start

Messaging

1 Go to your Today screen.

2 To access your wireless provider's
voicemail system, do one of the
following:

Press and hold the number Quick Key
associated with the Voicemail speed
dial (such as 1). You can also tap the
Voicemail speed dial button with your
stylus.

If a Voicemail speed dial button is not
configured, dial the phone number for
your wireless provider's voicemail

USING YOUR PHONE

system, using the keyboard. See
Making calls for more information.

« You can also create a speed dial
button for your wireless provider's
voicemail system. See Defining speed
dial buttons for more information.

3 Follow the voice prompts to set up your
voicemail.

Voicemail notification

New Yoicemail

IL Mew Yoicamsil 1:37 PM 75005

E Dismiss

When you have a new voicemail message,
a notification screen appears. To hear your
message now, press Listen T (left
action key). To retrieve your message later,
press Dismiss C—— (right action key).
When you have unretrieved voicemail
messages, a Voicemail #& icon appears at
the top of your screen and the left action
key is labeled Voicemail.

piD You know? \When a Voicemail icon
appears at the top of the screen, you can tap
this icon to retrieve your voicemail.

CHAPTER
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Retrieving voicemail messages
1 Go to your Today screen.
2 To access your wireless provider's

voicemail system, do one of the
following:

Press and hold the number Quick Key
associated with the Voicemail speed
dial button (such as 1). You can also
tap the Voicemail speed dial button
with your stylus.

If a Voicemail speed dial button is not
configured, dial the phone number for
your wireless provider’s voicemail
system, using the keyboard. See
Making calls for more information.

You can also create a speed dial
button for your wireless provider's
voicemail system. See Defining speed
dial buttons for more information.

Enter your voicemail password using
the keyboard, or press Extra Digits
) (left action key) if you defined this
option (see Creating a speed dial button
for details).

Select Play » to listen to your
messages.

TIP You do not need to press Option to enter
numbers, ¥, or # while on an active call.
TIP If you have trouble accessing a voicemail
system, try changing the Dial Pad tone
setting. See Selecting your call settings.

Clearing the Voicemail icon

After retrieving your voicemail messages,
the Voicemail icon on the top of your
screen should disappear. If it doesn't, you
can clear the icon manually.

74 | Settings 0 Y| = R

Phone

To access settings for a service, select
it from the folowing list.

Data Settings

Roarming
[Woice Privacy

Clear Yoicemail Icon

Services | Dialing | Security

Press Start and select Settings.
On the Personal tab, select Phone .
Select the Services tab.

Select Clear Voicemail Icon, and then
press Center .

B W N =
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Managing active calls

When you make or receive a call, the active
call info appears on your Today screen.

g
/g | start

G0 &) = 5:59

Call in Progress

S Type 3 name or number

Current duration
of call

Midyne Spear
(831) 555-6737 m
Caller's name
and number

Mute
Speakerphone

During a call, you can do any of the
following:

« Put the call on hold: Press Hold T——
(left action key). To take the call off hold,
press Off Hold T (left action key).

« Use the built-in speakerphone: Select
Speakerphone = &z . To turn off the
speakerphone, select [IEE

* Mute the microphone so you can’t be
heard: Select Mute @ . To turn the
microphone back on, select [T

USING YOUR PHONE

» Switch to another application: Press
Start (&) and select the application.

CHAPTER

TIP When a call lasts longer than one minute,
the screen dims. Press any key, except
Power/End, to wake up the screen.

DID YOU KNOw? You can send and receive text
messages during a call. This is a great way to
stay connected with colleagues during a long
call.

Ending a call
Do one of the following:

« Press Power/End(¥).

« Press the headset button (if the
headset is attached and has a button on
it). Some headsets do not have a
button.

Returning to an active call from another
application

You can use many other applications on
your smartphone while holding a phone
conversation, including the organizer and
text messaging features. You cannot
browse the web or send and receive email
while on a voice call.

MANAGING ACTIVE CALLS
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From any application, press Phone/Send
(&) to return to your Today screen.

Saving phone numbers

After you complete a call, you are
prompted to add the number if it is not
already in your Contacts list.

« Tocreate a new contact for this number,
select Create New Contact.

o To add this number to an existing
contact, select Copy and Add, and
then select a contact name.

« To decline adding the number, press
Dismiss <) (left action key).

o To disable the Add Contact prompt,
select Don’t show this again.

If you don't add a number right away, follow

these steps to add it later:

1 Go to the Call Log (see Redialing a
recently called number).

2 Highlight the number you want to save.

3 Press and hold Center @ to open the

shortcut menu, and then select Save to
Contacts.

Enter the information for the entry.

5 Press OK (@].

TIP You can also save contact info from other
applications, such as Messaging.

DID YOU know? If an incoming call uses caller
ID blocking, you do not see the Add Contact
prompt.

TIP You can re-enable the Add Contact prompt
even if you chose Don't show this again. See
Selecting your call settings for more
information.

More ways to
manage calls

Your Treo 700wx smartphone offers many
advanced telephone features, including call
waiting, three-way calling, and call
forwarding.

@ MORE WAYS TO MANAGE CALLS



Making a second call

74| start 0 &) mmo:26
Call in Progress 2]

(| Type a name ar number

Jane Faraola Active
(831)355-7534 w 00:04

& | &

You can make a second call while your first
call is still active.

1 Press Hold ©— (left action key) to put
the first call on hold.

2 To dial a second number, use any of the
methods described in Making calls. If
you're dialing by contact name or with
the keyboard, you must first use the
B-way to select the Dial Lookup field.

When two calls are active, your Today

screen includes two call status sections,

each representing one of the calls.

USING YOUR PHONE

Answering a second call (call waiting)

When you're on a call and you receive a
second call, the call-waiting notification
appears. You can do any of the following:

« Place the current call on hold and
answer the new call:
Press Answer <) (left action key) or
Phone/Send ().

« Send the new caller a text message:
Press Menu = (right action key) and
select Ignore with text message. This
option also send the call to voicemail.

« Hang up the first call: Press
Power/End [?). The second call
becomes an incoming call alert that you
can choose to answer or ignore.

« Send the new call to voicemail: Press
Menu 2 (right action key) and select
Ignore.

CHAPTER
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pip You kNow? When the second call is 7 | start [0 £ = 4:40
outgoing, you can conference the two calls, Call in Progress S
but you cannot swap between them. Type a name or number

Group Conference

When the second call is incoming, you can
swap between the two calls, but you cannot
conference them.

When two calls are active and you press
Power/End, you hang up both calls. To return
to the first call, wait for the person on the
second call to hang up.

End confer...

2 Press Conference T (left action
key); this joins the two active calls in a
conference.

When you've finished, press End
Conference T (left action key); this
ends the second call and returns you to
the first call. If you're ready to hang up
both calls, press Power/End (¥
instead.

Making a conference call

When the second call is outgoing, you can
join two calls in a conference session.
Additional charges may apply and minutes
in your account may be deducted for each
active call. Please contact your wireless
provider for more information.

1 Put the first call on hold, and then place
a second call. Using Flash mode during an active call

Flash mode is an alternate way to manually
manage your calls while one or more calls
are active. The preferred methods are
described in Making a second call
Answering a second call (call waiting), and
Making a conference call. Flash mode is
often used during a conference call when

@ MORE WAYS TO MANAGE CALLS



one of the calls has ended but the other
remains connected.

1 Press Phone/Send @ from the Active
Call screen.

2 Select Send Key (Flash) to enter Flash
mode.

3 Depending on the state of your active
call, pressing the Flash T (left
action key) does one of the following:

« If you have two active calls, you can
swap between them if the second call
is an incoming call.

If you have one active call, you can

dial another number. You can press

Flash T (left action key) again to

set up a conference call.

If you have two calls in conference,

press Flash < (left action key) to

hang up the second call, and then dial

another number.

4 Press Power/End (@) to exit Flash
mode and end all calls.

USING YOUR PHONE ‘a’

Forwarding calls

You can forward calls to another phone
number. Please contact your wireless
provider for the code used to turn call
forwarding on or off. In addition, check with
your wireless provider about availability and
pricing of forwarded calls; additional
charges may apply.

1 Go to your Today screen.

2 Enter the code to turn on call forwarding
(contact your wireless provider for
details), followed by the number where
you want to forward your calls. For
example: *72 415-555-1234.

3 Press Phone/Send (& to dial.

4 \When you're ready to turn off call
forwarding, enter the code to turn off
call forwarding (contact your wireless
provider for details), and then press
Phone/Send ().

TIP Contact your wireless provider to obtain
the forwarding codes for your area.

After you turn on call forwarding, call your
smartphone to confirm that call forwarding is
active.

CHAPTER
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Viewing minutes usage

1 Go to the Call Log (see Redialing a
recently called number).

2 Press Menu C_— (right action key) and
select Call Timers to view voice
minutes, or Data Log to view data
minutes.

CHAPTER

3 (Optional) To reset the counters to zero,
select Reset.

4 Press OK (@].

TIP Keep in mind that your billing statement
may vary slightly from the information you see
onscreen. Usage is charged based on your
calling plan, and calling plans vary.

Defining speed dial
buttons

Your smartphone lets you create both
picture and text speed dial buttons, so that
you can select a button on the Today
screen to quickly dial a number.

Creating a speed dial button

You can create up to 20 picture buttons and
50 text buttons.

1
2

3

Go to your Today screen.

Press Menu = (right action key) and
select New Speed Dial.

/g | Start 0 Y| @=z00 SR

Lirk:  Spear, Midyne [4E]
Lol
Quick Key:

1 () Text Speed Dial

i S @ [Picture Speed Didl

Cancel = Delete

Do one of the following:

« Select Link, select the contact you
want to link to this button, and then
select the number you want to dial
with this button.

« Select Label and enter a name for this
button, and then select Number and
enter the phone number you want to
dial with this button.

@ DEFINING SPEED DIAL BUTTONS



4

» (Optional) Enter a Quick Key. \When
the Today screen is displayed, you can
press and hold the Quick Key to
instantly dial this number.

TIP You can add a special ringtone to a contact
associated with the speed-dial button. See
Adding a contact.

TIP Quick Keys can be letters or numbers, but
you can't use both the letter and number for
the same key. For example, the voicemail
Quick Key is usually 1. The letter equivalent for
that key is E, so you cannot assign E as a
Quick Key to another speed dial button.

If this button is linked to a contact entry
with a picture, select either Text Speed
Dial or Picture Speed Dial to indicate
which type of button you want to
create. If this button is not linked to a
contact or the contact doesn't have a
picture, the Picture Speed Dial option is
not available.

5
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(Optional) Select the Advanced tab and
set any of the following options:

79 |start

Exta Digs:

[ 7| ™= 626 [GR

(Comma = pause 1 secand)

Dial extra digits automatically

Shigw woice mal buttons
FI T =

[44 sz e ]
Speed dial | Advanced |

Cancel E

Delete

Extra Digits: Defines additional
numbers to dial, such as a password or
extension. In addition to numbers, you
can enter the following symbols: star
(%) and pound (#). You can enter a
comma (,) to insert a one-second pause.

Dial extra digits automatically: Dials
predefined extra digits immediately
after dialing the phone number. If you
do not check this box, you need to press
Extra Digits — 5 (left action key) to
dial these digits.

Show voice mail buttons: Displays the
voicemail playback controls after you
dial this speed dial number. When this
option is checked, you can enter

CHAPTER
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numbers below each control to tailor
the controls to your voicemail system.

% Plays the previous message.
Saves the current message.

> Plays the current message.

@ Deletes the current message.
®  Repeats the current message.
> Plays the next message.

6 Press OK [@].

Editing a speed dial button

1
2

Go to your Today screen.

Highlight the speed dial button you want
to edit.

Press and hold Center @ to open the
shortcut menu, and then select Edit
Speed Dial.

Make the desired changes.
Press OK (@.

TIP You can also edit a speed dial button by
pressing Menu and selecting Speed Dial
Options, and then selecting the button you
want to edit.

Deleting a speed dial button

1
2

5

Go to your Today screen.

Highlight the speed dial button you want
to delete.

Press and hold Center @ to open the
shortcut menu, and then select Edit
Speed Dial.

Press Delete T (right action key).
Select Yes to confirm deletion.

Arranging your speed dial buttons

/g | start

& Y| @33z BR

Today : Speed Dial Options

Press Option + scrall to move @ button

FRET

Jane (w)

David (h)

Go to your Today screen.

Press Menu = (right action key) and
select Speed Dial Options.

@ DEFINING SPEED DIAL BUTTONS



3 Highlight the button you want to move.

4 Press Option © + Up a, Down v,
Right P, or Left €4 to move the button
in that direction.

Using a phone
headset

You can connect a phone headset for
hands-free operation. If you need to use
your smartphone while driving and this is
permitted in your area, we recommend
using the phone headset included with
your device, or a hands-free car kit (sold
separately).

TIP You can use the headset that came with
your smartphone or a compatible third-party
headset.

TIP The headset designed for Treo 180/270/
300 smartphones is not compatible with the
Palm Treo 700wx smartphone.

USING YOUR PHONE ‘a’
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Headset button
Microphone

The headset button is multi-functional, and
it performs different actions based on the
situation. You can press the headset button
to perform any of the following tasks:

« Answer an incoming call

« Respond to call waiting

« Hang up all calls

« Swap between calls if the second call is
an incoming call

« Create a conference call if the second
call is an outgoing call

USING A PHONE HEADSET @
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Headset specifications

Your smartphone works with headsets that
have a 2.5mm, 3-pin connector (look for
two black bands on the plug). When in
doubt, ask the third-party headset
manufacturer if the product is compatible
with Palm Treo 700wx smartphones. If you
hear a headset buzz or poor microphone
performance, your headset may be
incompatible with your smartphone.

DID YOU KNow? To hear stereo through the jack
(such as music), you need to use a stereo
adapter or other accessory (sold separately).
For info on compatible audio accessories, visit
www.palm.com/treo700wx-support.

Using a hands-free device with Bluetooth
wireless technology

Your Treo 700wx smartphone is also
compatible with many headsets and car
kits enabled with Bluetooth wireless
technology version 1.1 or 1.2. Please note,
however, that you cannot use a Bluetooth
headset to listen to MP3 files on your
smartphone.

For a list of compatible hands-free devices
with Bluetooth wireless technology, go to
www.palm.com/treo700wx-support.

To learn how to set up and connect to
Bluetooth devices, see:

Connecting to devices with Bluetooth®
wireless technology.

Here are tips for working with a Bluetooth
hands-free device:

« To transfer a call from the handset to a
Bluetooth hands-free device during a
call, press Menu = (right action key)
and select Connect Bluetooth. To
transfer the call back to the headset,
press Menu = (right action key) and
select Cancel Bluetooth.

« To transfer a call from a wired headset
to a Bluetooth headset or car kit that is
within range and with which you've
previously set up a partnership
(Bluetooth headset or car kit required,
sold separately), unplug the wired
headset and press the button on the
Bluetooth headset or car kit.
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DID YOU kKnow? |f you have both a compatible
Bluetooth headset and car kit, the one you
connected to your smartphone last becomes
the active device.

TIP To find out how to transfer your contacts
from your smartphone to your car kit, go to

www.palm.com/treo700wx-support.
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Staying Organized

Say good-bye to paper calendars and throw away those
scribbled to-do lists. Your smartphone is all you need to
organize your personal information and keep it with you
wherever you go.

You never lose your information, even if your battery is
completely drained. All your personal information is backed up
each time you synchronize, and your information is kept private
when you use your smartphone'’s security features. Also, you
can easily share info with others electronically.

Benefits
« Track current, future, and past « Set reminders for appointments,
appointments birthdays, important tasks, and

« Make to-do lists that get done more

CHAPTER
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Conta CtS 5 To assign the entry to one or more

categories, select Categories and then
check the categories under which you

BEFORE YOU BEGIN Install the latest want this entry to appear.
software from your Getting Started CD. 6 To add a note to an entry, select the
. Notes tab.
Adding a contact 7 To assign a ringtone to the entry, select
1 Press Start (&) and select Contacts. Ring tone and select a tone.
2 Press New —(left action key). 8 After you enter all the information, press
OK (@].
74 | Contacts 0 V== B
Mame: | M "
Picture: Select a picture... TIP If you have many contacts to enter, it's
Tobtte: best to enter them in Microsoft Office Outlook
De';::::::\: - on your computer and then sync. See
Werk tel: Synchronizing contacts and other info for
Workfac: detalls.

Work. addr:

™ TIP Be sure to enter numbers and email
etas [ etes addresses in the correct fields. Otherwise,
Messaging can't find this info when you
address a message and Calendar can't find

3 Use the 5-way navigator to move your contacts to invite them to meetings.
between fields as you enter
information. Viewing or changing contact information
4 To add a caller ID picture that appears 1 In the Contacts list (name view), begin
when that person calls, select Picture, entering one of the following for the
and then select Camera and take a contact you want to view or edit:
picture, or select an existing picture « First name

from the Thumbnails view.
« Last name

CONTACTS @
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« Firstinitial and last initial, separated by
a space

« Press Option @), and then enter the
phone number

Press Up a or Down ¥ on the 5-way

to select the entry you want to open.

Press Menu = (right action key) and

select Edit.

Make changes to the entry as

necessary.

Press OK

DID YOU know? You can find a contact by
company name. Press Menu and select View
By > Company. Select a company name to
see the contacts who work there.

TIP To view a particular group of contacts,
press Menu, select Filter, and then select the
category you want to view.

TIP You can also open Contacts from your
Today screen. Press Menu and select
Contacts.

Deleting a contact

In the Contacts list, highlight the
contact you want to delete.

2

3

Press Menu ——— (right action key) and
select Delete Contact.

Select Yes.

Customizing Contacts

1
2

4

Go to the Contacts list.

Press Menu — (right action key) and
select Options.

Set any of the following options:

Show alphabetical index: Displays the
alphabet at the top of the Contacts list.
You can use this index to find a contact.

Show contact names only: Lets you fit
more names on the Contacts list by
hiding everything but the contact’s
name.

Area code: Sets the default area code
for new contact entries.

Press OK (@].

Finding a contact in an online address
book

BEFORE YOU BEGIN Make sure you are
accessing an Exchange Server 2003
upgraded to Service Pack 2. Add access to
the online address book to your
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smartphone. See Adding an online address
book. After adding the online address book,
you must synchronize with the Exchange
Server in order for the Find Online option to
appear.

In addition to having contacts on your
device, you can also access contact
information from your organization's online
address book or Global Address List (GAL).
For more information, see Adding an online
address book.

1 Press Start (#) and select Contacts.

2 Press Menu 2 (right action key),
and select Find Online.

Calendar

Displaying your calendar
1 Press Start (&) and select Calendar.

2 Press Menu = (right action key) and
select View.

3 Select one of the following views:

STAYING ORGANIZED

Agenda: Shows your daily schedule in
list format. Upcoming appointments are
bold; past appointments are dimmed.

Day: Shows your daily schedule in
day-planner format.

Week: Shows your schedule for an
entire week.

Month: Shows your schedule for a
whole month.

FF A morning appointment
4 An afternoon appointment

B Both morning and evening
appointments

[0 An all-day event

Year: Shows a calendar for a 6-month
period.

Use the 5-way to move to another day,
week, month, or year (based on the
current view).

CHAPTER
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Creating an appointment
TIP If you have several appointments to enter,
1 Press Start and select Calendar. it's most efficient to enter them in Microsoft
2 Press Menu = (right action key) and Office Outlook on your computer and then
select New Appointment. synchronize your smartphone with your
computer. For more information, see
/g | calendar Synchronizing contacts and other info.
Subject: Wiriters' meeting a1 9 .
Lmim Conforance cal TIP To pencil in an appointment, open the
Starts; 10:00 AM appointment, select Status, and then select
Ends: 11:00 &M Tentative.
AllDay: Mo
Occurs: Every Wednesday
Reminder: Creating an untimed event
An untimed event, such as a birthday,
anniversary, or vacation, does not occur at
a particular time. These events appear as
3 Enter a subject (description) and a banr]ers at the top of your calendar; they
location don't occupy blocks of time. For example,
4 Select Start d select the starti “Submit Final Draft” in the screenshot
elect starts and select the starting shown here is an untimed event.
date and time.
5 Select Ends and select the ending date 1 Press Start and select Calendar.
and time. 2 Press Menu = (right action key) and
6 Press OK (@) select New Appointment.
3 Enter a subject (description).
Select the starting and ending dates.
5 Select All Day, and then select Yes.
CALENDAR
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ul 05,05 [sMEAwTEs B 4]
Submit Final Draft

Meet with Donna 8 Nancy [+

10:00a-11:00a (Conference Cally

Lunch with Greg

12:00p-1:00p

Team meeting

1:00p-2:00p

Class

i

a Menu

-]
£
B

6 Press OK (@]

DID YOU KNow? An untimed event can last
longer than a day.

TIP To enter a birthday or an anniversary,
create an untimed event that repeats every
year.

Scheduling a repeating appointment

1

Create an appointment or an untimed
event, and then select it.

Press Edit T (left action key).
Select Occurs, and then select a repeat
pattern. To create a repeat pattern,
select Edit pattern and follow the
onscreen instructions.

Press OK (@].
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Adding an alarm reminder to an event
1 Create an event, and then select it.
2 Press Edit ©— (left action key).

3 Select Reminder, and then select
Remind Me.

4 Enter the number of minutes, hours,
days, or weeks before the event you
would like to receive the alarm.

5 Press OK (©].

G0 Y| == ok
Subject: Birthday - Chris
Location:
starks: All day recurring
Ends: All day recurring E
AlDay: Yes

Occurs: [Every July 20 H

r
/4 | calendar

Reminder: Remind me Type Of .
3 day(s) = time units
Cateqories; _Personal +
Appointment | g — Number of
time units

TIP You can also add an alarm when you
create the event.
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Sending a meeting request

BEFORE YOU BEGIN Create contact
entries with email addresses for the people
you want to invite to a meeting. You can't
access contact entries without email
addresses from your calendar.

You can email meeting invitations to
contacts who use Microsoft® Office
Outlook® or Outlook Mobile.

1 Create an event, and then select it.
2 Press Edit < (left action key).

3 Select Attendees, and then select the
name of the contact you want to invite.
To invite other attendees, select Add
and select the names.

4 Press OK [@].

The next time you synchronize, the
meeting request is sent to the attendees.
When attendees accept your meeting
request, the meeting is automatically
added to their schedules. When you
receive their response, your calendar is
updated as well.

pID You know? |If you are using an Exchange
Server 2003 with SP 2, you can use your
corporate GAL to find contact information for
an attendee. Select Attendees, press Menu,
and then select Find Online. Enter the name
of the attendee and select Find.

Marking an event as sensitive

If other people have access to your
Microsoft Office Outlook calendar on your
computer and you don't want them to see
an appointment, you can mark that
appointment as private to hide it from other
Microsoft Office Outlook users.

1 Create an event, and then select it.
2 Press Edit T (left action key).

3 Select Sensitivity, and then select one
of the following:

Private: Displays the event on your
smartphone and on your computer.
Meeting attendees or recipients see
“Please treat this as Private” near the
top of an open appointment. If you sync
with an Exchange Server, other users
who can access your folders can't see
your private events; they see private
events as unavailable time slots.

@ CALENDAR



Personal: Displays the event on your
smartphone and on your computer.
Meeting attendees or recipients see
"Please treat this as Personal” near the
top of an open appointment.

Confidential: Displays the event on
your smartphone and on your computer.
Meeting attendees or recipients see
"“Please treat this as Confidential” near
the top of an open appointment.

4 Press OK (@].

TIP If you don't see an option on the screen,
press Down on the 5-way to scroll. For
example, when editing an event, you don't
see the Sensitivity option until you scroll
toward the bottom of the entry.

Organizing your schedule

Use categories to view various types of
events.

1 Create an event, and then select it.
2 Press Edit —— (left action key).

3 Select Category, and then check the
categories that apply to this event.
To add a new category, press New

STAYING ORGANIZED o

) (left action key), enter the
category name, and then press OK (@J.

CHAPTER
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Press OK two more times.

5 After you assign events to categories,
press Menu 2 (right action key) and
select Filter.

6 Select the type of events you want to
view.

Deleting an event
1 Highlight the event you want to delete.

2 Press Menu 2 (right action key) and
select Delete Appointment.

3 Select Yes.

CALENDAR @
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Customizing Calendar 3 Select the Appointments tab and set

1 Press Menu = (right action key) and any of the following options:
select Options.

CHAPTER
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Options

[Set reminders For new tems)

|15 v| ‘ITIII‘\LI(E(S) v|
oo [BBIH]G]R]2]
St
P

/2 | calendar 1 V)| ==

1st day of week:

ek view: S-day week

[ show half hour siots
[ show wesk numbers

General | Appointments

2 On the General tab, set any of the TIP Not all icons appear in all Calendar views.
following options:
1st day of week: Sets Sunday or Set reminders for new items: Sets
Monday as the first day of the week for ~ Whether a reminder is automatically added
all Calendar views. to new events and how long before the
event the reminder appears. You can

Week view: Sets whether five, six, or  oyerride this setting for individual events.
seven days appear in Week View. . o
Show icons: Sets which icons appear

Show half hour slots: Sets whether next to events.

time slots appear in one-hour or

half-hour increments in Day View and @ The event has a reminder.
Week View. S The event repeats in a specified
Show week numbers: Sets whether pattern.

week numbers (1-52) appear in Week & The event has a note attached.
View.

(74 CALENDAR
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@  Alocation has been assigned to
the event.

#® The eventis a meeting.
# The eventis marked private.
Send meeting requests via: Sets the

Messaging method used to send
meeting requests.

4 Press OK (@].

Tasks

You can use Tasks to remind you of tasks
you need to complete and to keep a record
of completed tasks.

Adding a task

1 Press Start (&) and select Programs.
2 Select Tasks .

3 Press New <) (left action key).

4

Enter a description of the task in the
Subiject field.

STAYING ORGANIZED

5 Set any of the following:

@ V)| == R
Subject: Create chart
Priority: MNormal
Status: Mot Completed
Starts: 7/6/2005
Due: 7/8/2005

Oceurs: Once
Reminder: Remind me
7/6/2005  8:00 AM
Cateqories; Business |

Task | Mokes

Priority: Sets the priority level for this
task. Later you can arrange your tasks
based on the importance of each task.

Status: Indicates whether the task has
been completed.

Starts: Specifies when the task begins.
Due: Sets the due date for the task.

Occurs: Indicates whether the task
repeats at regular intervals and how
often it repeats.

Reminder: Sets an alarm for this task
and indicates when you want to be
reminded.

Categories: Assigns the task to one or
more categories.

CHAPTER
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Sensitivity: Marks this task as Normal,
Personal, Private, or Confidential.

Notes: Lets you enter additional text for
the task.

6 Press OK (8],

DID YOU know? [f you want to use Tasks Over
the Air (OTA) synchronization, install the
software from your Getting Started CD. OTA
features also require an Exchange Server
2003 upgrade to Service Pack 2. The option to
synchronize tasks wirelessly in the ActiveSync
application appears only if you have the
appropriate server.

TIP You can also add a task by selecting the
Tasks entry bar at the top of the screen.

Checking off a task

/g | Tasks

m Y= X

Tap here to add a new task

Call Becky

Pick up dry cleaning
Send dad a card
Write meeting agenda

Update glossary
Create chart

Select the task you want to check off.
Press Edit T (left action key).
Select Status and select Completed.
Press OK (@].

TIP You can also mark a task complete by
tapping the box next to the task on the Tasks
list.

piD You know? Overdue tasks appear in red.

Organizing your tasks

1

In the Tasks list, press Menu 2
(right action key) and select Filter.

Select which tasks you want to view:
All Tasks, Recently Viewed,

No Categories, Active Tasks,
Completed Tasks, or a specific
category such as Business or Personal.
Press Menu — (right action key) and
select Sort By.

Select the sort method: Status,
Priority, Subject, Start Date, or

Due Date.

@ TASKS



Deleting a task

1
2

3

Highlight the task you want to delete.

Press Menu 2 (right action key) and
select Delete Task.

Select Yes.

Customizing Tasks

1
2

3

Go to the Tasks list.

Press Menu > (right action key) and
select Options.

Set any of the following options:

Set reminders for new items:
Automatically adds a reminder to new
tasks. The default reminder is set to
8:00 on the morning the task is due. You
can override this setting for individual
tasks.

Show start and due dates: Displays
task start and due dates in the Tasks
list.

Show Tasks entry bar: Displays the
Tasks entry bar at the top of the Tasks
list.

4 Press OK (@].

Notes

STAYING ORGANIZED o
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Notes are a great way to capture thoughts,
questions, and meeting notes on your Palm
Treo 700wx smartphone.

Creating a note

BEFORE YOU BEGIN Install the software
from your Getting Started CD that came
with your smartphone.

1
2
3
4

Press Start and select Programs.
Select Notes [J.

Press New <) (left action key).

Do one of the following:

« Type the text with the keyboard.

NOTES @
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« Write the text with the stylus.

« Draw a sketch with the stylus,
crossing at least three ruled lines.

5 Press OK [@].

Recording a voice note

You can create a new voice note or add a
recording to an existing note.

1

Press Start and select Programs.

& |m|) | [—— |||l
New E=

Menu

Select Notes [].

To add a recording to a note, open the
note you want to add the recording to.
To create a new voice note, skip this
step.

Press Menu —— (right action key) and
select View Recording Toolbar.

Select [@] to begin recording.

Speak into your smartphone's
microphone or hold it close to another
sound source.

When you have finished recording,
select [m] to stop recording. A
Recording icon appears in the note or
Notes list, depending on where you
recorded the note.

Press OK (@].

DID YOU KNOw? You can add several voice
notes within a single note.

TIP To play a recording, select the voice note
in the Notes list or open the note containing
the recording and select the Recording icon.

Creating a note from a template

1
2

o 0 A~ W

Go to the Notes list.

Select the Show list in the upperleft,
and then select Templates.

Open the template you want to use.
Enter the information.

Press OK (@].

Rename the note and move it to the

appropriate folder. See Organizing your
notes for details.
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TIP To create a new template, highlight the
note you want to save as a template. Press
Menu and select Rename/Move. Select
Name, and then enter a name for the
template. Select the Show list, and then
select Templates. Press OK.

Organizing your notes

You can rename your notes, move notes to
another folder, and move notes between
your smartphone and an expansion
(storage) card.

1 Go to the Notes list and highlight a note
you want to move.

2 Press Menu 2 (right action key) and
select Rename/Move.

3 Select Name, and then enter a new
name for the note.

4 Select Folder, and then select the folder
in which you want to store the note.

5 Select Location, and then select Main
memory or Storage Card.

6 Press OK (@].
7 Select the Show list in the upperleft,

and then select the folder you want to
view.

STAYING ORGANIZED o

8 Select the Sort By list in the upperright,
and then select whether you want to
sort your notes by Name, Date, Size, or
Type.

TIP To create a new folder, go to the Notes
list, select the Show list in the upperleft, and
then select Add/Delete. Select New, enter a
name for the folder, and then press OK.

Deleting a note

1 Go to the Notes list and highlight the
note you want to delete.

2 Press Menu 2 (right action key) and
select Delete.

3 Select Yes.

Customizing Notes
1 Go to the Notes list.

2 Press Menu 2 (right action key) and
select Options.

3 Set any of the following options:
Default mode: Sets the default entry
mode to Writing or Typing.

Default template: Sets the default
template for new notes.

CHAPTER
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Save to: Sets the default location
where new notes are stored.

CHAPTER

Record button action: Sets whether
the Side button opens the Notes
application or stays in the current
application.

4 Press OK (@].

Calculator

You can use Calculator for basic arithmetic
calculations, such as addition, subtraction,
multiplication, and division.

74 | Calculator ] V) o= 3

Performing calculations
1 Press Start and select Programs.
2 Select Calculator .

3 Use the keyboard or tap the screen to
enter numbers and perform
calculations, including the following:

©

IS
5

@ ®

®

Clears the last digit in a multi-digit
entry.

Clears the current calculation or
the displayed number.

Calculates the reciprocal of a
number.

Calculates percentage.

Calculates the square root of a
number.

Switches a number between
negative and positive.

Using the Calculator memory

« To store a number, select the box to the
left of the entry box. An M appears in
the box.

@ CALCULATOR



To add the displayed number to the

number stored in memory, select (%),

To display the number stored in
memory, select HR),

To clear the memory, select 9.

STAYING ORGANIZED o

DID YOu know? \When you store a number in
memory, it replaces the number that was
previously stored.

TIP To copy a number, press Edit and select
Copy. You can paste the copied number into
another application by pressing Edit and
selecting Paste.

TIP For more advanced calculations, use Excel
Mobile. See Excel Mobile for details.

CHAPTER
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Using Email and Other
Wireless Services

Now your smartphone brings you a new level of convenience. Use email or text
messaging to communicate with friends, family, and colleagues anywhere you
can access your network operator’s data network. You can send and receive
email attachments such as photos or Microsoft Word or Excel files, and send a
quick text message from anywhere on the data network.

You use the web for so many things. Now, with the built-in web browser, you
can take the web with you almost anywhere you go.

Your device's built-in Bluetooth® wireless technology helps you easily set up
wireless connections to a number of devices, so you can enjoy the
convenience of cable-free connectivity. You can also use your device to
connect your computer to the Internet and to share contacts or your favorite
photos with other people.

Benefits
« Receive and send files of almost « Store web pages for offline viewing
any type « Connect to Bluetooth headsets and
o Use text messaging to chat with car kits
friends « Connect your computer to the

« Carry the web with you Internet through your smartphone

CHAPTER
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Sending and
receiving messages
and email

BEFORE YOU BEGIN Do the following:

« Make sure your phone is on before you
send or receive messages.

« For delivery of Outlook email using
Direct Push Technology, install the
software from your Getting Started CD.
This feature also requires an Exchange
Server 2003 upgrade to Service Pack 2.

You can use the Messaging application to
exchange email or brief text messages
(SMS) with other wireless devices and
email addresses that support these forms
of messaging. You can also exchange
instant messages (IM) with Pocket MSN.
Before you use your Palm® Treo™ 700wx
to send or receive messages, consult your
wireless provider for pricing and availability
of email, text, and data services.

USING EMAIL AND OTHER WIRELESS SERVICES e

Creating and sending a text message
Each text message can hold up to 160
characters. To save time, you can select
from predefined My Text phrases, such as
“Call me" or "On my way." You can add
your own My Text phrases, and if you
prefer, you can enter the full message text
too.

1 Go to your Today screen.

2 Press Messaging <) (left action
key).

3 Press Left €4 until you see Text
Messages in the title bar.

Press New T—) (left action key).

5 Do one of the following to address the
message:

If the recipient’s name and number
are in your Contacts list, type the first
few letters of the first or last name or
simply enter the first initial, followed
by a space, and then the last initial to
find a name.

If the recipient’s name is in an online
address book, press Center @,
enter the name, press Menu ——
(right action key), and then select Find
Online. Select the name, and then

SENDING AND RECEIVING MESSAGES AND EMAIL @
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select to use either the phone
number or email address. For more
information, see See Adding an online
address book. and Using an online
address book.

« |f the recipient’s name and number
are not in your Contacts list, enter the
full number or email address.

7 | Tent Messages

G0 Y| == ok

To: "Midyne Spear” <(831
S595-3563>

On iy way. |

11/180

Enter your message, or press

Menu 2 (right action key), select
My Text, and then select a predefined
phrase you want to insert.

(Optional) Press Menu —— (right
action key) and select Spell Check.
(Optional) Press Menu 2 (right
action key) and select Message

Options. Enter a callback number and
then press OK.

9 Press Send T (left action key).

DID YOU KNow? You can send and receive text
messages even while you are on a phone call.
This is easiest when using a hands-free
headset or the speakerphone.

TIP Some symbols can’t be used in text
messages. Invalid characters are automatically
replaced by the Messaging application.

TIP To address a message to multiple
recipients, separate the addresses with a
semicolon (;). If you address a single text
message to three people, you are billed for
three messages.

Setting up an email account

You can use your smartphone to access
several types of email accounts. Before
you enter settings for your email accounts
on your smartphone, you must determine
which types of accounts you want to
access, because the steps vary for each of
the following account types:

« ActiveSync Exchange Server 2003:
Enables you to wirelessly synchronize
your email and other information

@ SENDING AND RECEIVING MESSAGES AND EMAIL



directly with the information stored on a
Microsoft Exchange Server 2003.

When the Exchange Server 2003 is
upgraded to Service Pack 2, new
features are available that allow you to
access online address books and use
Direct Push Technology. These features
include Global Address List (GAL), Tasks
Over The Air (OTA), and IP-based push
updating of Outlook information.

Direct Push Technology is the two-way
wireless delivery method used between
Microsoft Exchange Server 2003 with
Service Pack 2 (SP2) servers and a
smartphone with Windows Mobile® 5.2
with Messaging and Security Feature
Pack (MSFP) for Outlook information
(Email, Calendar, Contacts, and Tasks).

Direct Push Technology uses an Internet
Protocol (IP)-based methodology rather
than SMS-based methodology, resulting
in lower network overhead, lower costs,
and more efficient communications.

IMAP or POP3: Enables you to send
and receive email messages with a
corporate email account or an account

USING EMAIL AND OTHER WIRELESS SERVICES

that you have with an Internet service
provider (ISP).

« Hotmail: Enables you to send and

receive email messages with an MSN
Hotmail account. See Using Pocket
MSN for information on setting up an
MSN Hotmail account.

DID YOU KNOw? If you are outside a coverage
area or if your phone is off, your outgoing
messages go into the Outbox. When you
return to a coverage area, your pending
messages are sent automatically and
transferred to the Sent folder.

If your email account requires a VPN
connection to establish a secure connection,
VPN servers may require that you install
specific VPN software (sold separately) on
your smartphone before you can access

your email. See Connecting to a VPN for more
info.

DID YOU KNOW? You can receive email
messages in various formats, including HTML,
RTF, and plain text.

TIP Your computer must be connected to the
Internet when you sync your email.

CHAPTER
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Setting up an Exchange Server email
account

BEFORE YOU BEGIN Do the following:

« Install the software from the Getting
Started CD.

« For delivery of Outlook email using
Direct Push Technology, make sure that
your Exchange Server 2003 is upgraded
to Service Pack 2.

You can use your smartphone to sync
directly with Exchange Server using
Exchange ActiveSync. You may have
already set up your Exchange Server email
settings when you installed the
ActiveSync® desktop software. If you did
not enter settings for an Exchange Server
email account, work with your system
administrator to gather the following info,
and then follow the steps in this section to
enter account settings now.

« Mail server address and domain name
« Your username and password

Press Start and select Programs.
2 Select ActiveSync @.

3 Press Menu = (right action key) and
select Add Server Source.

4 Enter the Server address, and then
press Next 2 (right action key).

73 | ActiveSync

] V)| ==
Edit Server Settings [7)

Server address:

[This server requires an encrypted (SSL)|
[connection

Cancel

TIP If you have already entered settings for an
Exchange Server account, Add Server Source
does not appear on the menu; Configure
Server appears on the menu instead.

TIP The Exchange Server settings are case-
sensitive. Be sure to enter uppercase and
lowercase letters properly.




5 Enter your username, password, and
domain. The password is
case-sensitive. Your password can use
numbers and text. Check whether your

Caps Lock and Option Lock are active,

because that can affect the password
you are entering. See Entering
lowercase and uppercase letters and
Entering numbers, punctuation, and
symbols.

/4 | Activesync 1 Y| =

Edit Server Settings

User name:
Passward:

[ save password
{required for qutomatic synch

6 If you want to enter your password each
time you access this account, do not
check the Save password box. If you
want your password entered
automatically, check this box.

7 (Optional) Select Advanced to set the
rules for fixing sync conflicts.

USING EMAIL AND OTHER WIRELESS SERVICES e

/4 | Activesync 1 Y| =
Edit Server Settings [7]

Choose the data you want to synchranize:

Finish

8 Press Next ——— (right action key) and
check the boxes for the types of
information you want to synchronize
with Exchange Server.

TIP Ask your system administrator if it is OK to
store your corporate email password on your
smartphone. For increased security, you may
need to enter your password each time you
access your email.

9 (Optional) Highlight one of the items
and select Settings to change the
synchronization settings for that type
of information.

10 Press Finish —— (right action key).

CHAPTER
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11 Synchronize with your Exchange Server
and set your sync schedule. Setting a
sync schedule with an Exchange Server

NOTE Settings are not available for all
items. If you want to automatically
download more than the email message
header, select E-mail in step 9 and
increase the KB setting. If you don't
increase this setting, you can manually
download the rest of the message at your
convenience.

Setting a sync schedule with an Exchange
Server

BEFORE YOU BEGIN Enter settings for an
Exchange Server email account. Setting up
an Exchange Server email account

Follow these steps to set your sync
schedule:

1 Press Start and select Programs.
2 Select ActiveSync @.

3 Press Menu C—= (right action key) and
select Schedule.

/4 | activesync

& Y| R
Schedule [7]

Sync during
Peak times: 60 minutes

Off-peak times: |Every 4 hours -
[[] use above settings when raaming
Send outgaing items immediately

Adjust peak times o it your scheduls.
Set up device bo sync when new items arvive.,

4 Set your schedule for peak and off-peak
times. To conserve power it is
recommended that you change your
settings to synchronize every 30 or 60
minutes instead of as items arrive.

5 Set your roaming preference. If roaming
charges are not a concern, select Use
above settings when roaming.

6 Press OK (@].

Setting up an IMAP or POP email account

BEFORE YOU BEGIN Work with your
system administrator to gather the
following info:

« Account type (POP3 or IMAP)
» Mail server name for receiving mail
» Mail server name for sending mail




« Your username and password
« Any special security requirements

If you have problems configuring your
account, go to www.palm.com/emailsetup
for more information.

You can send and receive email messages
with an email account that you have with
an Internet service provider (ISP), an email
account that you access using a VPN
server connection (such as a work
account), or any other IMAP (Internet
Message Access Protocol) or POP email
account.

1 Go to your Today screen.

2 Press Messaging T (left action
key).

3 Press Menu = (right action key) and
select Tools > New Account.

USING EMAIL AND OTHER WIRELESS SERVICES

4 Enter the email address that you want
to set up, and then press Next ——>
(right action key).

74 |poP3

E-mail Setup (2/5)

Auto configuration

Attempting to automatically configurs your
e-mall settings.

To skip this step, tap Next.

Status:

5 Wait until the Status box displays
Completed, and then press Next ——
(right action key).

6 Enter your name, username, and
password.

/g |por3 1 Y| ==

E-mail Setup (3/5) e

User information

[ save password
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7 If you want to enter your password each
time you access this account, do not
check the Save password box. If you
want your password entered
automatically, check this box.

8 Press Next ——— (right action key).

/2 | outlook E-mail Fagh 1|

E-mail Setup (4/5) e

Account information

Account bype: [POP3 -

9 Select the Account type list, and then
select POP3 or IMAP.

10 Enter a name for this account, and then
press Next = (right action key). For
example, if this is your work email
account, enter “Work" or your
company’s name.

74 |por3

E-mail Setup (5/5) [2]

Server information

Comoms |

Finish

11 Enter the name of the Incoming mail

and Outgoing mail servers. Do not enter
anything in Domain. It is not needed for
POP3 or IMAP accounts.

12 (Optional) Select Options to select

download settings for this account.

13 Press Finish T (right action key).

TIP To delete an email account, press Menu
and select Tools > Options. Highlight the
account you want to delete. Press and hold
Center on the 5-way, and then select Delete.

DID YOU KNOow? You can set up more than one
email account. Press Menu, select Tools, and
then select New Account. Enter the account
information in the E-Mail Setup wizard.

S
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Creating and sending an email message
1 Go to your Today screen.

2 Press Messaging <) (left action
key).

3 Press Left 4 to cycle through your
Messaging accounts until you see the
email account you want to use in the
title bar.

Press New T (left action key).

5 Do one of the following to address the
message:

If the recipient’s name and email
address are in your Contacts list,
enter the first few letters of the
recipient’s first or last name, and then
select the recipient’s name.

If the recipient’'s name is in an online
address book, you can find the name
and add it. For more information, see
Adding an online address book and
Using an online address book.

If the recipient’s name and email
address are not in your Contacts list,
enter the full email address.

6 Select Subject and enter a title for the
message.

USING EMAIL AND OTHER WIRELESS SERVICES e

7 Enter your message, or press Menu
C—— (right action key), select My Text,
and then select a predefined phrase you
want to insert.

# & | outlook E-mail

[ | = S

Frorm: Midyne
<midyne@anycorp.com:
(Outlook E-maily

To: donna@anycorp.com

Subject: Files

hen do you need those files?

Midyne

8 (Optional) Do any of the following:

* Press Menu = (right action key)
and select Insert. Select the type of
item you want to attach, and then
select the file or record a voice note.
Press Menu = (right action key)
and select Spell Check.

Press Menu = (right action key)
and select Message Options. Select
the Priority list, select a setting for
the message, and then press OK (@].

9 Press Send T (left action key).

CHAPTER
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TIP Not ready to send that message yet? You
can save it without sending it. While creating
a message, press Menu and select Save to
Drafts. To access the draft, select the Show
list in the upperleft, and then select Drafts.

DID YOU KNOW? You can also access the
Messaging application from the Start menu.

DID YOU KNOW? You can receive email

messages in various formats, including HTML,

RTF, and plain text.

Adding an online address book
BEFORE YOU BEGIN Do the following:

» Ask your system administrator for the
name of the directory service and the
server, and whether authentication is

required for accessing an online address

book.

« If your company is using an Exchange
Server 2003 upgraded to Service Pack
2, you must first synchronize with the
Exchange Server to enable the Global
Address List to find a Contact.

Many email servers, including servers

running Exchange Server, can verify names

with an online address book, also called a
directory service or a Global Address List.

After you enter settings for an email
account, Messaging checks your Contacts
list and then the directory service to verify
names that you enter in the To, Cc, and Bcc
fields.

1

(3]

In the message list, press Menu ——
(right action key) and select Tools >
Options.

Select the Address tab.

Select the address book you want to
check for email addresses, and then
select Add.

Enter the name of the directory service.
Enter the server name.

If your server requires authentication,
check the box, and then enter your
username and password.

(Optional) Check the Check name
against this server box to enable this
directory service.

Press OK (@].




TIP When you sync your Microsoft Office
Outlook email account, disable your online
address books to avoid errors. Press Menu
and select Tools > Options. Select Address
and uncheck the Check name against this
server box.

TIP To delete a directory service, highlight it,
press and hold Center on the 5-way, and then
select Delete.

Using an online address book
BEFORE YOU BEGIN Add an online
address book to your smartphone. See
Adding an online address book.

You can access contact information, such
as an email address or phone number, from
your organization’s online address book or
Global Address List (GAL). To access a
GAL, make sure you are accessing an
Exchange Server 2003 upgraded to Service
Pack 2.This feature is useful only if you
know the exact name as it appears in the
directory.

1 Inanew message, tap the To box.

2 Press Menu > (right action key),
and select Add Recipient.

USING EMAIL AND OTHER WIRELESS SERVICES

3 Press Menu = (right action key),
and select Find Online.

4 Enter the contact name as it appears in
the directory, and tap Find. You must
spell the contact name correctly.

DID YOU KNOW? You can use the Global
Address List to find a contact. In Contacts,
press Menu, and then select Find Online.
When sending a meeting request, select
Attendees, press Menu, and then select Find
Online.

TIP If your organization’s GAL uses
abbreviated extension numbers, you can set
your smartphone to automatically dial the
complete number. See Setting your

abbreviated dialing preferences for more
information.

Synchronizing your default email account

To send and receive messages for your
default email account, simply synchronize
your smartphone with your computer. See
Setting the synchronization schedule for
details. During synchronization, new
messages are copied to your smartphone's
Inbox, and messages in the smartphone’s
Outbox are sent.
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DID YOU know? By default, email messages
you send are saved in the Sent folder. If you
want to save memory on your smartphone,
you can turn this option off. In the Messaging
list, press Menu and select Tools > Options.
Select Message, and then uncheck the Keep
copies of sent items in Sent folder box.

Synchronizing your other email accounts

To send and receive email messages for
additional email accounts, such as an
Internet service provider (ISP) account or
an account that you access using a VPN
server connection (typically a work
account), follow these steps:

1 Go to your Today screen.

2 Press Messaging <) (left action
key).

3 Press Left 4 to cycle through your
Messaging accounts until you see the
account you want to download in
the title bar.

4 Press Menu = (right action key) and
select Send/Receive to synchronize
your smartphone with your email
server.

Receiving attachments

1 Select the attachment (below the
subject) to mark it for download.

2 Synchronize the email account that
contains the message as described in
the previous sections.

3 Select the attachment to open it.

If you have a Microsoft Office Outlook

e-mail account and want to download

attachments automatically, do the
following:

1 Press Start and select Programs.

2 Select ActiveSync @ .

3 Press Menu = (right action key) and
select Options.

4 Select E-mail, and then select
Settings.

5 Check the Include file attachments
box.

6 Press OK (@].

DID YOU KNOW? You can receive and open
attachments in a number of formats, including
Word, Excel, PowerPoint, and PDF.




To automatically download attachments
from an IMAP4 email account (typically an
ISP account) or an account that you access
using a VPN server connection (typically a
work account), do the following:

1 Go to your Today screen.

2 Press Messaging — ) (left action
key).

3 Close any open messages.

4 Press Menu 2 (right action key) and
select Tools > Options.

5 On the Accounts tab, select the IMAP4
account name.

6 Press Next ——— (right action key) until
you reach Server information, and then
select Options.

7 Press Next ——— (right action key)
twice, and then select Get full copy of
messages and When getting full copy,
get attachments.
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TIP To store attachments on an expansion
card, press Menu, and select Tools >
Options. Select Storage and then check the
Store attachments on a storage card box.

DID YOU know? Embedded images and objects
cannot be received as attachments, unless
you have an IMAP4 email account with TNEF
disabled. Note that TNEF must be enabled to
receive meeting requests.

DID YOU kKNow? On the Accounts tab in
Messaging Options, an asterisk appears next
to the accounts you create.

Using links in messages

When you receive a text or email message
that contains a telephone number, email
address, or URL, you can dial the number,
send an email message, or go to the web
page immediately. Your smartphone
automatically opens the appropriate
application from the link.

1 Select a message in the list.

2 Select the phone number, email
address, or URL (appears as underlined
blue text).

SENDING AND RECEIVING MESSAGES AND EMAIL @
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1 Open the text or email message you
want to forward.

2 Press Menu C— (right action key) and
select Forward.

3 Address the message and enter any
text you want to add.

4 Press Send —— (right action key).

Managing your messages

The status icons that appear next to each
message in the Inbox and Outbox indicate
the following:

% An unread text message.
% A read text message.

E=] An unread email message.
(& A read email message.

You can rearrange the messages in any
folder or account.

1 Go to the Messaging account you want
to arrange.

2 Select the Sort By list in the upperright,
and then select the sort method you
want to use.

You can delete several messages at once
from any folder.

1 Go to the Messaging account that you
want to delete the messages from.

2 Highlight the message(s) you want to
delete. To select multiple messages,
tap and drag the stylus across the
messages.

3 Press Menu > (right action key) and
select Delete.

TIP Unread messages appear in bold.
Messages you've read appear in plain text.

pID You know? If you are working offline,
messages that you deleted from the server
are deleted from your smartphone the next
time you connect, or according to the options
you selected.

TIP To permanently remove messages from
the Deleted Items folder, press Menu and
select Tools > Empty Deleted Items.

Adding a signature to your messages

You can use a different signature with each
Messaging account.

1 Go to the Messaging list.

@ SENDING AND RECEIVING MESSAGES AND EMAIL



2 Press Menu 2 (right action key) and

3

select Tools > Options.

On the Accounts tab, select
Signatures.

Select the account you want to create a
signature for.

£ | Messaging

Signatures

Select an account:

‘Out\nnk E-nail

Use signature with this account
[[] Use when replying and forwarding

Enter a signature here.

Check the box to add this signature to
new messages you create with this
account.

(Optional) Check the box to add this
signature to messages you reply to or
forward with this account.

Select the default signature text and
enter the signature text you want to
use.

Press OK (@].
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Customizing your Messaging settings

1

Go to the Messaging list.

2 Press Menu 2 (right action key) and

3

select Tools > Options.

Select the Message tab and set any of
the following options:

74 | Messaging (0 Y| &= Bk

Options

Wéhen replying to e-mail, include body

Keep copies of sent items in Sent Folder

After deleting or moving a message:
‘Show next message v|

Accounts | Message ‘ Address | Storage
B

When replying to e-mail, include
body: Indicates whether the body of a
message you received appears in your
response to that message.

Keep copies of sent items in Sent
folder: Indicates whether messages
you send are stored in the Sent folder.

After deleting or moving a message:
Specifies what you want to appear after
you delete or move a text or email
message.

CHAPTER
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4 Select the Address tab and set any of
the following options:

CHAPTER

/2 | Messaging 1 V)| ==

Options

7 - Main memory (S9965KE frae)
/g | Messaging [ Y| == 5K Storage card (not instaled)

Options Current size of attachments (37KE)

In Contact: t e-mail addresses from:

Empty deleted tems:
Werify names using these address books:

Add...

Accounts | Msssags | Address | Storage

Accounts | Message ‘ Address | Starage
=) Store attachments on storage card:

Indicates whether you want to

In Contacts, get e-mail addresses automatically.store email attachments
from: Indicates whether you want to on an expansion card.

check Contacts in addition to any Empty deleted items: Indicates
directory services for email addresses. whether you want to automatically
Verify names using these address empty the DeIetqu Items folder, and
books: Indicates which directory when you want this to occur.

services you want to check for email 6 Press OK (@].

addresses.

Add: Lets you add directory services to

the list of online address books. U S | ﬂg POCket M S N

5 Select the Storage tab and set any of
the following options: BEFORE YOU BEGIN To use the Hotmail
and IM features in Pocket MSN, you must
first sign up for a MSN account. You must
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also subscribe to data services from your
wireless provider.

Pocket MISN provides quick access to the
following:

« MSN Hotmail: Lets you read, write,
send, and delete email. You can also
manage your Hotmail folders.

« MSN Messenger Contacts list: Lets
you see who's online and exchange
instant messages (IM). Subscribe to
status updates for selected contacts so
you're notified when they're online.

« Options: Lets you customize your
Pocket MSN experience.

DID YOU kNow? You can add Pocket MSN to

your Today screen. See Selecting which items
appear on your Today screen for details.

TIP When you set up a Pocket MSN Hotmail
account, you can access that account in the
Messaging application. To access your instant
messages, use the MSN application or the
MSN plug-in on the Today screen.
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Signing in to Pocket MSN

1 Press Start and select Pocket
MSN.

75 | Packet MsN & Y| =

3 MSN Messenger

MSN Hotmail

’ Compose Hotmail

/I‘ MSN Mabile Home
0 Pocket MSN Help

Options

2 Select MSN Mobile Home.

3 Select Sign in.

4 Enter the email address and password
for your Passport account or your
Hotmail account.

« To create a Passport (IM) account,
go to www.passport.com.

« To create a Hotmail account, go to
www.hotmail.com.

CHAPTER
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Browsing the web

Internet Explorer Mobile provides quick and
easy access to web pages. You can view
most sites you use on your computer,
including those with security and advanced
features, such as JavaScript and frames. To
browse the web, you must subscribe to
data services from your wireless provider.

Viewing a web page

By default, Internet Explorer Mobile scales
web page content to fit your smartphone
screen so that you can view most of the
information without scrolling left or right.

1 Make sure your phone is on (see
Turning your phone on and off).

/2| mternet Explorer 55> V)| @ [

@ ttp: f fuesiesi microsoft.comfwind - 0

Welcome to Windows Mobile !

Using Windows Mobile
FHow-To & Tips
% (reate a Signature for Your E-mail
“*Free Up Memory
# Make Your Own Ring Tone

Press Start (&) and select Internet
Explorer.

Highlight the address line, enter the
address of the web page you want to
view, and then press Center .

Press Menu = (right action key),
select View, and then select any of the
following:

One Column: Arranges web pages into
one column that is as wide as the
screen, so that you don't have to scroll
horizontally.

Default: Maintains a layout similar to
what you see on a desktop computer,
but it makes items smaller and arranges
the content so that you can see most of
it without scrolling horizontally.

Desktop: Keeps the same layout and
size as on a desktop computer, which
requires both horizontal and vertical
scrolling.

Full Screen: Hides the status and
navigation areas and fills the entire
screen with the web page. To exit full
screen mode, press = (right action
key) or T (left action key). You can
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also tap and hold anywhere on the
screen and uncheck Full Screen.

Show Pictures: Shows or hides
pictures on web pages. Hiding pictures
speeds up the time it takes to load
pages.

TIP You can send email from a web page.
Email addresses appear as links on web
pages. After you configure an email
application on your smartphone, you can
select an email link to create a message to
that address.

TIP To send a link, press Menu and select
Tools > Send Link via E-mail. Select the
Messaging account you want to use to send
the link.

TIP If Internet Explorer Mobile does not
recognize a phone number as dialable, you
can copy the phone number (as text) and
paste it into the Phone Dial Pad.

5 Do any of the following:

« To view the previous page, press
Back < (left action key) or
Backspace @

« To refresh the page with the latest
content from the Internet, press

USING EMAIL AND OTHER WIRELESS SERVICES e

Menu = (right action key) and
select Refresh.

To scroll through the page in One
Column View or Default View, press
Up a or Down ¥. In Desktop View,
press Up a, Down v, Left 4, or
Right P to scroll in all directions.

To follow a link to another web page,
press Up a or Down ¥ to highlight
the link, and then press Center @ to
go to the selected page. You can also
tap the link on the screen with your
stylus.

To adjust the size of the text on web
pages, press Menu = (right action
key), select Zoom, and then select
the size you want.

To view a web page's properties,
press Menu 2 (right action key)
and select Tools > Properties.

To view each item in a list, tap the list
with your stylus.

In a list, press Left 4 or Right P to
cycle between items, and press
Center @ to accept the change.

In a form, such as a browser search
field, press Center @D to interact

CHAPTER
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with the form, and then press Center
@D to stop interacting with the form.

6 Press OK to close Internet Explorer
Mobile.

DID YOU KNOW? You can also start a web
search from your Today screen by selecting
the Web search field, entering the item you
want to find, and then pressing Center on the
5-way.

TIP To return to a recently viewed page, select
the address line list, and then press Down.
Use the 5-way to select a Web address from
the list (press Center to return to the Web
address).

TIP If you browse to a secure web page, the
Lock icon in the address line appears closed
instead of open.

Creating a favorite

Favorites lets you bookmark a web page so
that you can instantly access it without
entering the web address.

1 Go to the page you want to mark as
a favorite.

2 Press Menu = (right action key) and
select Add to Favorites.

3 (Optional) Select Name and enter a
different description.

4 (Optional) Select the folder where you
want to create the favorite.

5 Select Add.

TiIP Create the folders where you want to
store your favorites first. Once you create a
favorite, you can’t move it to another folder.

Viewing a favorite

1 Press Start (&) and select Internet
Explorer.

2 Select Favorites T (left action key).

fdddress (URLY:

https jjwww. microsoft . com/windowsmob
Create in:
Mobile Favorites -

3 Press Down ¥ to highlight the page
you want to view in the list, and then
press Center @ to go to the selected

page.
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Organizing your favorites

You can create folders for organizing your
favorites. For example, you can store travel
links in one folder, stock links in another,
and business links in a third folder.

1 Press Start (@) and select Internet
Explorer.

Select Favorites < (left action key).
Select the Add/Delete tab.

Select New Folder.

g A~ WON

Enter a name for this folder, and then
select Add.

6 Press OK (@].

TIP To delete a favorite or folder, select
Favorites (left action key). Select the Add/
Delete tab, highlight the item you want to
delete, and then select Delete. Select Yes to
confirm the deletion, and then press OK.

Downloading files and images from a web
page

You can download files that are usable on
your smartphone, such as new
applications, MIDI ringtones, or pictures
that are specifically tagged for download.

USING EMAIL AND OTHER WIRELESS SERVICES e

1 Go to the page that contains the link to
the file you want to download.

2 Press Left 4 or Right P to highlight the
link to the file.

3 Press and hold Center @D, and then
select Save As to download a file, or
tap and hold, and then select Save
Image to download an image.

CHAPTER

4 Select Name and enter a new name for
the file.

5 Select the Location list, and then select
where you want to store the file: Main
memory or Storage card.

6 Select the Folder list, and then select
the folder where you want to save the
file.

7 Press OK (@].

DID YOU KNow? The security certificates and
128-bit SSL strong encryption let you browse
secure sites, such as online shopping,
banking, and email. Remember that some
secure sites also require specific browsers
and may not work with Internet Explorer
Mobile. Ask the organization for an alternate
access point that is compatible with Internet
Explorer Mobile.
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You can copy text from a web page and
paste it into other applications.

1 Use the stylus to highlight the text you
want to copy.

2 Press Menu = (right action key) and
select Edit > Copy.

3 Go to the application in which you want
to paste, and then position the cursor
where you want to paste the text.

4 Press Menu C— (right action key) and
select Edit > Paste.

TIP You can copy the text from the entire web
page. Tap and hold on the page, and tap
Select All Text. Tap and hold on the page
again, and tap Copy.

Using the History list

The History list stores the addresses of the
pages you visited recently.

1 Press Menu = (right action key) and
select History.

2 (Optional) Select the Show list in the
upperleft, and then select how you
want to sort the History list.

3

Select the web page you want to view.

Customizing your Internet Explorer
Mobile settings

1

2

Press Menu = (right action key) and
select Tools > Options.

On the General tab, set any of the
following options:

74 | Internet Explorer

Options

Home page
http: fjhomepags
Use Default

Encoding

Default character set

|Westem European

General | Memory | Security

Home Page: Sets the page that appears
when you open Internet Explorer
Mobile. To use the page you were on
when you opened the menu, select Use
Current. To select the original home
page, select Use Default.

Encoding: Sets the character set for
the web pages you view.
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3 Select the Memory tab and set any of T
tne folowing aptions, 5
: Options
= Cookies
1 ¢ | Internet Explorer [ Alow costies
Dptions
Save links to pages visited in the past 5“\','\,"“' Tm":’ . ot
[ c=ts) M vt meins
kel ooy
m General | Memary |\
vorory [ || ) .
. = . Clear Cookies: Deletes any cookies
stored on your smartphone.
Save links to pages visited in the Warn when changing to a page that
past: _Sets h_OW many days of activity is not secure: Sets whether a message
the History list stores. appears when you switch from a secure
Clear History: Empties the History list. page to one that is not secure.
Delete Files: Removes saved pages Warn when page content is blocked
and Web files that you synchronized due to security settings: Sets whether
with your computer. a message appears when you attempt
to open a page that does not meet your
Select the. Secur_lty tab and set any of smartphone’s security standards.
the following options:
Allow cookies: Sets vvhelther your TP Internet Explorer Mobile supports
smartphone accepts cookies (small files JavaScript, Secure Sockets Layer (SSL), and
containing info about your identity and cookies, but does not support plug-ins (Flash,
preferences). The page sends the file Shockwave, and so on) or Java applets.
and stores it on your smartphone.
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Connecting to
devices with
Bluetooth® wireless
technology

With your smartphone’s built-in Bluetooth®
wireless technology, you can connect to a
number of Bluetooth devices such as a
headset, hands-free car kit, or GPS
receiver, as well as to other phones and
handhelds. For a list of hands-free devices
with Bluetooth wireless technology that
are compatible with your smartphone, go
to www.palm.com.

If your computer is enabled with Bluetooth

wireless technology, you can also
synchronize wirelessly.

Setting up a Bluetooth connection

After you set up a connection with a
Bluetooth device, you can communicate
with that device whenever it is within
range (about 30 feet) and your
smartphone’s Bluetooth feature is turned
on.

If necessary, prepare the device you
want to connect with to accept a new
connection. Check the device's
documentation for details.

2 Go to your Today screen, and then tap
Bluetooth .

74 | settings G0 )| == B

Bluetooth

[Turn on Bluetooth)

[ Make this device discoverable to ather
devices

Mode | Devices ‘ COM Ports |

3 Check the Turn on Bluetooth box to
turn on your smartphone's Bluetooth
feature.

CONNECTING TO DEVICES WITH BLUETOOTH® WIRELESS TECHNOLOGY
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4 Select the Devices tab, and then select
New Partnership.

74 | settings (0 Y| &= Bk

Bluetooth

Tap New Partnership ka scan For other
Blustoth devicss. Tap on a device to modify
its settings.

MNew Partnership...

Devices | COM Ports

5 Wait for your smartphone to search for
devices and to display the device list.
/4 | settings 1 Y| ==

Select a Bluetooth Device [7]

Select a davice to connect with and tap
Hext.

Palm Device

Cancel

6 Select the device you want to connect
with, and then press Next = (right
action key).

USING EMAIL AND OTHER WIRELESS SERVICES e

7 Enter an alphanumeric passkey

between 1 and 16 characters long, and
then press Next ——— (right action key).

IMPORTANT Some Bluetooth devices
have a built-in passkey; others let you
choose the passkey. See the
documentation for the Bluetooth device for
more info.

8

If the passkey is not built-in, enter the
same passkey on the smartphone and
the other Bluetooth device, and then
press Finish C— (right action key).
If you're connecting to a headset or
hands-free car kit, check the Hands
Free box, and then press Finish ——=
(right action key).

10 If you're connecting to a GPS device,

press Finish —— (right action key),
select the COM Ports tab, select the
GPS device you selected in step 6, and
then select New Outgoing Port. Press
Finish — (right action key). After you
set the partnership and COM port, you
can configure the GPS settings (see
Setting up a GPS device). Be sure to
select the same port you have assigned
for GPS here.

CONNECTING TO DEVICES WITH BLUETOOTH® WIRELESS TECHNOLOGY 1
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11 Press OK (©].

You can now communicate with this device
whenever it is within range (about 30 feet)
and your smartphone's Bluetooth feature is
turned on (see steps 2 and 3 earlier in this
section).

pID You know? If you're using a hands-free
Bluetooth device and it is within range, your
smartphone routes all calls to the hands-free
device instead of to your smartphone’s
earpiece. Bluetooth range is up to 30 feet in
optimum environmental conditions.

TIP Your smartphone supports only call audio
with Bluetooth headsets. It does not support
stereo music playback with Bluetooth
headsets (enabled with Bluetooth A2DP
profile).

TIP To delete the established partnership with
a device, go to the Bluetooth Settings screen
and select Devices. Highlight the connection
you want to remove, press and hold Center
on the 5-way, and then select Delete. The
deleted device can no longer automatically
connect with your smartphone.

Sending information over a Bluetooth
connection

You can send an individual entry or file.

Make sure the receiving device is ready
to receive a Bluetooth connection.

2 Highlight the entry or file you want to
send.

3 Press Menu = (right action key) and
select Beam... (the menu item changes
names based on the type of item you
highlighted).

74 | Contacts

[E5] Abbi

To beam, select a device.

1) Tren Tap to send
~il) Wayne Tap to send

4 Select the receiving device in the list. A
red icon indicates an IR connection, and
a blue icon indicates a Bluetooth
connection
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When the transmission is complete, 5 When your smartphone is receiving z
“Done” appears next to the name of the info, a notification tells you that a
receiving device. transmission is in progress. To stop the
transmission, press Cancel T (left
TIP Check your battery level before action key); to close the notification,
establishing a Bluetooth connection. If the press Dismiss = (right action key).
battery level is low, you can't make a
Bluetooth connection. TIP If you have trouble receiving info over a

Bluetooth connection, press Start and select
Settings. Select the Connections tab, and
then select Beam. Make sure the Receive all
incoming beams box is checked.

Receiving information over a Bluetooth
connection

1 Go to your Today screen, and then tap DID YOU kKNow? The Bluetooth icon on your

Bluetooth 0 Today screen indicates the status of your
2 Check the Turn on Bluetooth box to smartphone’s Bluetooth feature:

turn on your smartphone’s Bluetooth Gray = Bluetooth off.

feature. Blue = Bluetooth on.

White = Connected to a Bluetooth device.
3 Press OK ' Headset = Call in progress with a Bluetooth
4 If you have already set up a partnership headset or car kit.
with the transmitting device, your
smartphone is ready to receive the info.  Synchronizing over a Bluetooth
If you haven't set up a connection, connection

Zr_‘eCk the l';’l'ake th'; de(;"c? ) BEFORE YOU BEGIN Make sure your
Iscoverable to other devices box 10\ ter is equipped with Bluetooth

let the device find your smartphone and wireless technology and that you installed
request a connection. the synchronization software on the CD
that came with your smartphone.
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Set up your computer for Bluetooth
wireless communication. See the
documentation that came with your
computer for details. In most cases
your computer must support the Virtual
Serial Port profile and this profile must
be turned on.

Set up ActiveSync on your computer for
Bluetooth wireless communication. See
ActiveSync Help on your computer for
details.

Go to your Today screen, and then tap
Bluetooth £J.

Check the Turn on Bluetooth box to
turn on your smartphone's Bluetooth
feature.

Press OK (@].
Press Start and select Programs.
Select ActiveSync @ .

8 Press Menu > (right action key) and
select Connect via Bluetooth.

9 |If this is the first time you're making a
Bluetooth connection to this computer,
follow the onscreen prompts to set up a
Bluetooth partnership with this
computer.

10 Select Sync.

11 When synchronization has finished,
press Menu = (right action key) and
select Disconnect Bluetooth.

TIP Wi-Fi® routers, microwaves, and wireless
telephones using the 2.4GHz band may
interfere with Bluetooth connections. For best
results, move away from this equipment
when making a Bluetooth connection. If you
cannot move away, move the Bluetooth
devices closer to improve the reception.

CONNECTING TO DEVICES WITH BLUETOOTH® WIRELESS TECHNOLOGY
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Beamlng Informatlon information to another device with an IR z
] port. The IR port is located on the top of
V\/|‘th | R your smartphone, between the antenna
and the Ringer switch, behind the small

dark shield.

Your smartphone is equipped with an IR
(infrared) port that lets you beam

BEAMING INFORMATION WITH IR @
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TIP For best results, the path between the
two devices must be clear of obstacles, and
both devices kept stationary. If you have
difficulty beaming, shorten the distance and
avoid bright sunlight.

The type of information you can beam
depends on the type of device you are
beaming to. Windows Mobile devices are
always compatible with the Treo 700wx
smartphone.

Beaming a record
1 Highlight the entry or file you want to

beam.

/4 | contacts

[E5] Abbi

To beam, select a device.

1) Tren Tap to send
~il) Wayne Tap to send

Press Menu = (right action key) and
select Beam... (the menu item changes
names based on the type of item you
highlighted).

Point the IR port on your smartphone
directly at the IR port of the receiving
device.

When the name of the receiving device
appears, select it to begin the transfer.
A red icon indicates an IR connection.

Wait for “Done” to appear next to the
name of the receiving device before you
continue using your smartphone.

Receiving beamed information

1
2

Turn on your screen.

Point your smartphone’s IR port directly
at the IR port of the transmitting device.

When the Receiving Data message
appears, select Yes to receive the
beam.

TIP If you can't receive beamed info, press
Start and select Settings. Select the
Connections tab, and then select Beam.
Make sure the Receive all incoming beams
box is checked. If you still can't receive info,
try a soft reset (see Resetting your

smartphone).

14
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Synchronizing over an infrared
connection

1 Set up your computer to receive
infrared beams. See ActiveSync Help on
your computer for details.

2 Point your smartphone's IR port directly
at the IR port on your computer.

3 On your smartphone, press Start
and select Programs.

4 Select ActiveSync @ .

5 Press Menu 2 (right action key) and
select Connect via IR.

6 Select Sync.

Using your
smartphone as a
wireless modem

Your smartphone’s data capabilities enable
you to use your smartphone as a wireless
modem for your laptop computer. Use this
feature to send and receive email, browse
the Internet, and access your company'’s

network if you do not have another Internet

USING EMAIL AND OTHER WIRELESS SERVICES e

connection for your laptop. Use this feature
to connect to the Internet when working
remotely at airports and other locations.

CHAPTER

BEFORE YOU BEGIN

« To use this service, you must have
access to a wireless data network and a
separate data service plan may also be
required. Contact your wireless provider
for more information.

« Inaddition, you must have a desktop
application that supports this feature.
Your wireless provider may provide a
dedicated software application, or visit
the following web site for additional
instructions from Palm:
www.palm.com/treo700wx-support.

Preparing your smartphone for a wireless
modem connection

In order to use your smartphone as a
wireless modem, you'll need to start the
Modem Link application on your
smartphone, and then complete the
instructions at the Palm web site (provided
at the end of the following steps).

1 On your smartphone press Start
and select Programs.

USING YOUR SMARTPHONE AS A WIRELESS MODEM @
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Select Modem Link 2 .

Press OK to dismiss the message
and open Modem Link.

7 | Modem Link

Status: Inartive
Connection:

Baud rate:

Access point nams:
‘ <Nane>

Activate E

Select the Connection list, and then
select USB.

Press Activate T (left action key).

6 To complete the configuration and
connect your laptop to the Internet
using your smartphone, complete the
instructions at www.palm.com/
treo700wx-support.

TIP You cannot sync your smartphone with
your PC when Modem Link is activated. To
deactivate Modem Link, complete step 1
through step 3 and press Deactivate.

TiP While your EVDO data connection is
active, you can receive incoming calls and
place outgoing calls; however, doing either of
these suspends the data connection until you
hang up the call.

TIP To stop incoming calls from interrupting a
data session, see Selecting your data settings.
This is useful when downloading large files.
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Playing Media Files

Do you have a wallet bulging with photos of friends, family,
pets, and your most recent vacation?

Are you tired of carrying both your MP3 player and your phone?

Your smartphone solves both problems. You can keep your
favorite photos right on your smartphone—videos, too. And
there's no need to carry an expensive MP3 player; you can play
music on your smartphone. Simply transfer songs onto your
smartphone or an expansion card and then listen through your
stereo headphones.

Benefits
« Never be far from your favorite « No separate photo viewer, MP3,
people, places, and songs CD, or mini-disc player required

« Arrange your photos, videos, and
songs



In this chapter

Pictures & Videos

Windows Media Player Mobile . .......... ... ... ... .. .....



Pictures & Videos

Your Palm® Treo™ 700wx smartphone
comes with an easy-to-use, built-in,
1.3-megapixel camera with 2x digital zoom.
You can use the camera to take and view
pictures and videos and send them to your
friends and family. To add a personal touch
to your smartphone, use your pictures as
your Today screen background, and as
caller ID images, or use your videos to
create video ringtones.

You can also move pictures and videos to a
computer by synchronizing your
smartphone with your computer.

DID YOU KNOw? Pictures are captured and
stored in 16-bit color, JPG format. Resolution
settings range from 1280 x 1024 to 160 x 120
pixels (1.3-megapixels to VGA). You can
change the default setting. See Customizing
your Camera settings for details.

PLAYING MEDIA FILES

Taking a picture

By default, pictures are stored in the My
Pictures folder on your smartphone. If you
want to store your pictures on an
expansion card, see Customizing your_
Camera settings to change where pictures
are stored. For information on accessing
your pictures on your computer, see
Viewing pictures and videos on your
computer.

1 Press Start (#) and select Pictures &
Videos.

2 Select Camera [[@.

74 |Pictures & ¥ideos [0 Y| &= 5K

3 Adjust the position of your smartphone
until you see the subject you want to
photograph on the screen.

CHAPTER
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(Optional) Adjust any of the following:

Zoom: Press Up a to zoom in or
Down ¥ to zoom out.

Brightness: Press Right ) to increase
the brightness or Left € to decrease
the brightness.

Resolution: Press Menu — (right
action key) and select Resolution to
change the image quality.

(Optional) Set a 5-second timer: Press

Menu > (right action key), select

Mode, and then select Timer.

Press Center @ to capture the picture

or start the timer.

Hold your smartphone still until the

picture renders, and then do one of the

following:

« Press Camera <) (left action key)
to take another picture.

« Press OK (@] to return to the
Thumbnails View.

TIP If you see a camcorder icon below the
preview image, video mode is on. To turn on
the still camera, press Menu and select Still
Mode.

TIP You can also adjust the zoom and
brightness by pressing Menu and selecting
Zoom or Brightness.

DID YOU kNnow? After three minutes of
inactivity when previewing an image, the
camera goes into standby mode. Press any
key or tap the screen to return to the image
preview.

Taking pictures in burst mode

Burst mode takes five pictures in quick

succession, with one button press.

1 Press Start and select Pictures &
Videos.

2 Press Camera T (left action key).

3 Press Menu = (right action key) and
select Mode > Burst.

4 Press Center @.

PICTURES & VIDEOS



Recording a video

BEFORE YOU BEGIN You must have
QuickTime Player version 6.5 or later
installed on your computer to play videos
recorded by your smartphone.

Videos can be any length, provided you
have ample storage space available. By
default, videos are stored in the My
Pictures folder on your smartphone. If you
want to store your videos on an expansion
card, see Customizing your Camera
settings to change where videos are
stored. For information on accessing your
videos on your computer, see Viewing
pictures and videos on your computer.

1 Press Start (#) and select Pictures &
Videos.
2 Select Camera [[@.

3 Press Menu 2 (right action key) and
select Video Mode.

4 Adjust the position of your smartphone
until you see the subject you want to
record on the screen.

5 (Optional) Adjust the following:

PLAYING MEDIA FILES e

Brightness: Press Right P to increase
the brightness or Left 4 to decrease
the brightness.

Resolution: Press Menu —— and
select Quality to change the video
resolution. Press Center @D to start
recording.

When you've finished recording, press
Stop T (left action key) or Center
@ to stop recording.

(Optional) To review the video in
Windows Media Player Mobile, press
Thumbnails T (left action key),
highlight the video, and then press
Center @. Press OK to return to
the Thumbnails View.

/g | Pictures & Videos [0 V)| @m B

>

Thumbnails i
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DID YOU know? Videos are captured and
stored in 3G2 format. Video resolution
settings range from 352 x 288 to 176 x 144
pixels.

DID YOU know? Your smartphone has a
self-portrait mirror next to the camera lens on
the back of your smartphone. Use the mirror
when you're taking a picture or video and you
want to be in the picture too.

pID You know? |f the Camera goes to standby
while the recording is paused, the recording is
stopped and the video clip is saved.

Viewing a picture or video

1 Press Start and select Pictures &
Videos.

2 Select the picture or video you want to
view. For more info on viewing videos,
see Playing media files on your
smartphone.

3 Press OK (@] to return to the
Thumbnails View.

TIP To view pictures or videos in a different
folder, select the Show list in the upperleft,
and then select the album you want to view.

DID YOU kKNow? You can also download
animated GIF files and view them in Internet
Explorer Mobile.

Viewing a slide show

1

Press Start and select Pictures &
Videos.

Press Menu ——— (right action key) and
select Play Slide Show. The slide show
plays automatically.

Press Center @D to display the slide
show toolbar, which you can use to
Rotate @, Play @, Pause ), Reverse
@. Forward @, and Stop & the slide
show.

TIP You can also press Right and Left on the
5-way to move forward or backward through
the slides.
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Sending a picture or video

You can send a picture or video to other
picture-enabled wireless smartphones or
to an email address.

1

Press Start (&) and select Pictures &
Videos.

Highlight the picture or video you want
to send.

Press Menu > (right action key) and
select Send.

Select the email account you want to
use to send the picture or video.

Address and send the message.

DID YOU kNnow? You cannot send copyrighted
pictures or videos that appear with a Lock icon
in the Thumbnails View.

TIP You can send pictures and videos as email
attachments.

Creating a video ringtone

You can save a video that you record as a
ringtone.

1

Press Start and select Pictures &
Videos.

PLAYING MEDIA FILES e

2 Highlight the video you want to use as a
ringtone.

3 Press Menu = (right action key) and
select Save to Contact Ring Tone.

CHAPTER

4 Select the contact to whom you want to
assign the ringtone.

NOTE Your device also supports the WMV
and 3GP file formats for video ringtones.

Organizing pictures and videos

You can move or copy pictures and videos
to other folders or between your
smartphone and an expansion card.

1 Press Start (&) and select Pictures &
Videos.

2 Highlight the picture or video you want
to move or copy.

3 Do one of the following:

« To move the picture or video to
another location, press Menu =
(right action key) and select Edit >
Cut.

« To keep the picture or video in two
locations, press Menu 2 (right
action key) and select Edit > Copy.

PICTURES & VIDEOS 123
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4 Select the Show list in the upper-left,
and select the location where you want
to place the picture or video you
selected in step 2.

5 Press Menu > (right action key) and
select Edit > Paste.
You can also view a specific folder or

expansion card and arrange the pictures
and videos by name, date, or size.

1 Press Start and select Pictures &
Videos.

2 Select the Show list in the upper-left,
and then select the folder you want to
view.

3 Select the Sort By list in the upperright,
and then select the sort method:
Name, Date, or Size.

Using a picture as the Today screen
background

1 Press Start and select Pictures &
Videos.

2 Highlight the picture you want to use.

3 Press Menu > (right action key) and
select Set as Today Background.

4

Select the Transparency Level list and
select the appropriate level. Use a
higher percentage for a more
transparent picture and a lower
percentage for a more opaque picture.

Press OK (@] to return to the
Thumbnails View.

Editing a picture

Y

Press Start (&) and select Pictures &
Videos.

Select the picture you want to edit.

Press Menu = (right action key) and
select Edit.

Do any of the following:

« To rotate a picture 90 degrees
counterclockwise, press
Rotate T (left action key).

« To crop a picture, press Menu ——
(right action key) and select Crop. Tap
and drag the stylus to highlight the
area to crop. Tap outside the box to
stop cropping.
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« To adjust the brightness and contrast 2
levels of a picture, press Menu ———>
(right action key) and select
AutoCorrect.

TIP To undo an edit, press Menu and select
Undo. To cancel all unsaved edits you made
to the picture, select Revert to Saved.

TIP For more extensive edits, just download
your picture or video to your computer and
edit it in your favorite graphics program. Then
sync the picture or video back on your
smartphone.

Deleting a picture or video

1 Press Start (&) and select Pictures &
Videos.

2 Highlight the picture or video you want
to delete.

3 Press Menu 2 (right action key) and
select Delete.

4 Select Yes. 4

Customizing your Camera settings

1 Press Start (&) and select Pictures &
Videos.

PLAYING MEDIA FILES e

Press Menu 2 (right action key) and
select Options.

CHAPTER

74 | Pictures & videos

G0 Y| == ok

Options

wihen sending pictures in e-mail, pictures can
be resized sa that they transfer faster.
Use this picture size:

when rotating 2 picture, rotate 90 degrees:

ChLeft
(@) Right
slide Show | Camera | Video

General

On the General tab, set the following
options:

Use this picture size: Sets the size of
pictures you send with the Messaging
application.

When rotating a picture, rotate 90
degrees: Sets the direction in which the
pictures rotate.

Select the Slide Show tab and set the
following options:

During slide shows, optimize for
viewing: Sets whether pictures are
optimized for portrait or landscape
format during slide shows.

PICTURES & VIDEOS @
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/2 |pictures & videos [0 V)| &= B

Options

During slide shows, optimize For vieing:
(@) [Portrait pictures
() Landscape pictures

[ Play scresnsaver when connected to my
PC and idle for 2 minutes

e Show [ Camera | Viden

Play screensaver when connected to
my PC and idle for 2 minutes: Sets
whether the pictures in your My
Pictures folder are used as a
screensaver when your smartphone is
connected to your computer and
ActiveSync® software is not running.

Select the Camera tab and set the
following options:

/g | Pictures & videos [0 )| &= BK

Options

Save files ko

Main mef

Type Flename prefix:

Stil image compression level:

High quality -

General | Side Show | Camera [ ide
=

Save files to: Determines if pictures
and videos are stored on your
smartphone or on an expansion card.

Type filename prefix: Assigns a name
to a series of pictures to be captured,
such as Seattle001, Seattle002, and so
on.

Still image compression level:
Sets the default size for newly
captured pictures.

PICTURES & VIDEOS
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6 Select the Video tab and set the Viewing pictures and videos on your
following options: computer

When you synchronize your smartphone,

your pictures and videos are copied to your
Options

CHAPTER

[ [inclode audio when recording videa filss desktop computer. You can view pictures in
JPEG, GIF, BMP and PNG format and
Time it For videos: videos in 3G2 and WMV format. You can

also send them to friends using your
desktop email application.

General | slide Shaw | Camera | tidea When you use ActiveSync to synchronize

pictures and videos, the files are stored in
C:\Documents and Settings\<Username>
\My Documents\Treo My Documents

Include audio when recording video
files: Turns the microphone on and off
so that you can record videos with or
without sound.

Time limit for videos: Limits the length
of videos you record. You can also
select the No limit option.

7 Press OK (@] to return to the
Thumbnails View.

PICTURES & VIDEOS @
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Windows Media
Player Mobile

Windows Media Player Mobile can play
music, audio, and video files that are
stored on your smartphone or on an
expansion card (sold separately) in any of
the following file formats:

- WMA

o WMV

« MP3

« 3G2

You can listen to these music, audio, and
video files through the speaker on the back
of your smartphone or through a stereo
headphone (3.5mm stereo headphone

adapter or 2.5mm stereo headphone
required, sold separately).

Transferring media files to your
smartphone

BEFORE YOU BEGIN Do the following:
« You must have Windows Media Player

10 or later installed on your computer.
See My media files won't sync.

« To sync media files with your computer,
you must set the Media sync option.
See Selecting which info to sync.

Use the Sync feature in the desktop
version of Windows Media Player 10 to
transfer digital music, audio, video, and
playlist files from your computer to an
expansion card or your smartphone. Using
Sync ensures that the files transfer
correctly.

1 On your computer, open Windows
Media Player 10.

2 (Optional) Insert a 32MB or larger
expansion card into your smartphone.

3 Connect your smartphone to your
computer with the USB sync cable.

4 \When the Device Setup Wizard opens
on your computer, click Automatic.

5 Check the Customize the playlists
that will be synchronized box.

Select the playlists you want to sync.

7 Click Finish to begin the transfer. The
next time you connect your smartphone
to your computer while the desktop
version of Windows Media Player 10 is
running, synchronization starts
automatically.

WINDOWS MEDIA PLAYER MOBILE



TIP For tips on using the desktop version of
Windows Media Player, go to the Help menu
in Windows Media Player 10 on your
computer.

TIP Be patient; transferring media files to an
expansion card can take several minutes.

Playing media files on your smartphone

1 Press Start (&) and select Windows
Media.

2 Press Menu 2 (right action key) and
select Library.

3 Select the Library list in the upperleft,
and then select the library you want to
use.

4 Select the item you want to play (such
as a song, album, or artist name).

5 Press Play T (left action key).

6 Use any of the following onscreen
controls during playback:

Center @ or » Plays the current file.

Center @ or Il Pauses the current file.

Left 4 ¥ Skips to the beginning of the
current file or to the previous file.

Right ) ¥ Skips to the next file.

PLAYING MEDIA FILES e

o~ Sets the point from which playback
begins. Tap and drag the slider to
change the current position.

CHAPTER

Volume button or & Increases the
volume level.

Volume button or & Decreases the
volume level.

<3 Turns the sound on or off.

Displays a video using the full
screen.

& Displays a website where you can
find music and videos to play.

#* Indicates the rating of the current
file. Select the star to change the rating.

Press Menu 2 (right action key) and
select any of the following during
playback:

Library: Displays the Library screen so
you can select a different song to play.

Shuffle/Repeat > Shuffle: Plays the
Now Playing playlist in random order. A
check appears next to this command
when it is on.

WINDOWS MEDIA PLAYER MOBILE @
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Shuffle/Repeat > Repeat: Plays the
Now Playing playlist repeatedly. A check
appears next to this command when it
is on.

Stop: Ends playback.

TIP If you can't find a media file on your
expansion card, update the library (see
Working with libraries).

TIP To play a file that is not in a library, go to
the Library screen, press Menu, and select
Open File.

TIP To play a file from the web, press Menu
on the Library screen, and then select Open
URL. Select URL and enter the website
address, or select History and select a site
you've visited before.

TIP To repeat the current song, press Menu
and select Repeat Song.

Working with libraries

A library represents each of the storage
locations available to Windows Media
Player Mobile, such as your Treo device or

an optional expansion card (not included).
Each library contains links to the media
files in that location. Windows Media
Player Mobile usually creates and updates
the library automatically when you add
media files for the first time. For example,
when you add media files to your Treo
device the My Device library is created.
When you insert an expansion card
containing media files, the Storage Card
library is created. When you update a
library, it automatically updates video files
(WMV and 3G2) and audio files (WMA,
MP3, QCR and WAV).

1 Press Start and select Windows
Media.

2 Press Menu C—— (right action key) and
select Library.

3 Press Menu = (right action key) and
select Update Library.

4 \Wait for the files to be added, and then
select Done.
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pID You know? \When you update a library, it
automatically updates video files (WMV and
3G2) and audio files (WMA, MP3, QCR and

WAV).

TIP To delete an item from a library: Highlight
the item and then press and hold Center on
the 5-way to open the shortcut menu. Then
select Delete from Library. Select Yes to
confirm the deletion.

TIP If you don't see a media file that you
added, manually update the library.

Working with playlists

A playlist is a list of media files that play in
a specific order. You can use playlists to
group audio files together or video files
together for convenient playback. For
example, in the desktop Player, you can
create a playlist of upbeat songs for when
you exercise and a playlist of soothing
songs for a long flight. When you
synchronize, your favorite playlists are
automatically copied to your smartphone.
Your playlists appear in your libraries (in the
My Playlists category).

A temporary playlist, called Now Playing,
appears on the Now Playing menu. It lists
the currently playing file, as well as any

PLAYING MEDIA FILES

files that are queued up to play next. You
can add to, modify, or clear the files on the
Now Playing playlist.

1 Go to the Now Playing screen:

/& | Windows Media

m Y=

Falling Angel
Electric Angel

« If the Library screen is displayed,
select the Now Playing category.

« |If the Playback screen is displayed,
press Now Playing < (left action
key).

2 Do any of the following:

« To move a file up or down one slot,
highlight the file, and then select
Move Up < or Move Down .

» To add a file, select Add [}, press
Menu = (right action key), and
then select Queue Up.

CHAPTER
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To delete a file from the playlist,
highlight the file, and then select
Remove X.

« To view more info about a file,
highlight the file and select
Properties [4].

« To remove all items from the Now
Playing playlist, press Menu ——=
(right action key) and select Clear
Now Playing.

DID YOU KNOw? You can also move a file in the
Now Playing playlist by tapping and dragging it
to a new position.

TIP If you move files between your
smartphone and an expansion card, be sure to
update your libraries, or you won't be able to
see the files in their new location.

Customizing Windows Media Player
Mobile

1 If necessary, go to the Playback screen
by pressing OK to close the current
screen.

2 Press Menu C—— (right action key) and
select Options.

3 On the Playback tab, set the following
options:
Show time as: Sets whether the time
remaining or time elapsed appears on
the Playback screen.

7 3 | Windows Media

G0 Y| == ok

Options

Show time as:

O Pause playback while using another
program

Resume playback after a phone call

s o 515

Playback

Pause playback while using another
program: Sets whether playback
continues if you switch to another
application.

Resume playback after a phone call:
Sets whether playback continues after
you finish a phone call.

132
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4 Select the Video tab and set the 8 Select the Buttons tab to change any of
following options: the available button settings:

CHAPTER

Play video in full screen: Sets whether

) i ) | - =
videos automatically play in full screen

format. Up::::;Pause B
EMTER =|
Scale to fit window: Sets whether stop |
videos are automatically scaled to fit the pan
Playback screen. ok s -]
-Ass\ n -ResEt -NDHE
5 Select the Network tab and set the Nﬂ ms . [
following options: ? =]
Protocol: Enables and disables the
available protocols. You must select at « To assign a button, highlight the item
least one protocol. You can also set a you want to set, select Assign, and
UDP Port. then press the button you want to use

Internet Connection Speed: Sets the for that item.

speed of your network connection, and + Torestore an item’s factory setting,
sets whether you want the device to highlight the item and select Reset.
detect the connection speed. » To unassign an item, highlight the

6 Select the Library tab and set whether item and select None.

you want to see the Library screen or 9 Press OK (®].
the Playback screen when you open
Windows Media Player Mobile.

7 Select the Skins tab and select
Previous or Next to set the player’s
background.

WINDOWS MEDIA PLAYER MOBILE @
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DID YOU kNow? You can also assign a button
(for instance “s”) to turn the screen off during
music playback to preserve battery life. See
Reassigning buttons for details.

pID You know? |f you close the Windows
Media Player Mobile window, your music
continues to play in the background.
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Staying Productive

Your smartphone enables you to take your office with you—
including your Microsoft Office files. With Microsoft Office, you
can carry, create, view, and edit Microsoft Word and Excel files
directly on your smartphone. You can also view, carry, and
manage PowerPoint files on your smartphone. You can keep
updated copies of the files on both your smartphone and your
computer so that you can work on them in the most
convenient location any time.

Benefits
« Manage Word, Excel, and « Improve productivity by taking
PowerPoint files on your important docs, spreadsheets, and

smartphone presentations with you



In this chapter

Word Mobile

PowerPoint Mobile. . . ... ... . . . .

Excel Mobile



Word Mobile

You can create and edit documents and
templates and save them as DOC, RTF,
TXT, and DOT files. You can also edit
Microsoft® Office Word® documents and
templates that you create on your
computer. However, keep in mind that
some of the information and formatting
may be lost when you save the document
on your smartphone.

The following features are not supported in

Word Mobile:

« Backgrounds

« Bidirectional text

« Document protection

o Metafiles

« Avrtistic page borders (lined page
borders are supported)

« Password-protected files (remove
password protection on your computer
before opening the file on your
smartphone)

« Shapes and text boxes

« Smart tags

STAYING PRODUCTIVE e

The following features are partially
supported in Word Mobile:

« Picture bullets (regular bullets are
supported)

« Revision marks (documents appear as
though all revisions were accepted; if
the document is saved, revision marks
are lost)

« Table styles (some or all of the
formatting is lost if the document
is saved)

« Underline styles (unsupported styles
are mapped to one of the four
supported styles: regular, dotted, wavy,
or thick/bold/wide)

« Legacy Pocket Word files (you can open
PSW files, but if you edit a file, you
need to save it in DOC, RTFE, TXT, or DOT
format)

The following features are not supported
on your smartphone, but they remain in the
file so that when you open the file on your
computer, they appear as expected:

« Fonts and font sizes (original fonts are
listed on your smartphone but are
mapped to the closest font available)

CHAPTER
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Footnotes, endnotes, headers, footers

Lists (indented lists are mapped to the
closest indentation level supported by
Word Mobile)

Page breaks (although undisplayed, all
page breaks, except a break placed at
the end of a document, are retained in
the document)

TIP To copy a file from your computer to your
smartphone, open My Computer or Windows
Explorer on your computer, copy the file into

the Mobile Device folder, and then sync.

Creating a document

1

g A WN

Press Start (&) and select Programs.
Select Word Mobile E

Press New < (left action key).
Enter the text of the document.

Press OK (@] to save the file.

pID YOU know? \WWhen you save a new
document, it is automatically named after the
first several words in the file.

Opening an existing document
1 Press Start and select Programs.
2 Select Word Mobile E

3 Inthe documents list, select the
document you want to open.

Creating a document from a template
1 Go to the documents list.

2 Select the Folder list in the upper-left,
and then select Templates.

3 Open the template you want to use,
and enter the information.

Press OK (@].

5 Rename the document and move it to
the appropriate folder. See Organizing
your documents for details.

TIP If you don’t see Templates in the Folder
list, select More Folders to access this folder.

TIP To create a new template, highlight the
document you want to save as a template.
Press Menu and select Rename/Move.
Select Name, and then enter a name for the
template. Select the Folder list, and then
select Templates. Press OK.
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Finding or replacing text in a document

1

Open the document containing the text
you want to find.

Press Menu —— (right action key) and
select Edit > Find/Replace.

Select Find what and enter the text you
want to find.

(Optional) Check the Match case box to
find text that matches the capitalization
in the text you entered in step 3.

(Optional) Check the Match whole
words only box to find only full words
that match the text you entered in
step 3.

Select Find to locate the first instance
of the text you entered in step 3, or
select Replace and enter the
replacement text.

Select Next to find the next instance of
the text, or select Replace to replace it.
To replace all instances of the text,
select Replace All.

When you see a message that the
search is done, press OK [@].
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Moving or copying text

CHAPTER

1 Open the document containing the text
you want to move or copy.

2 Highlight the text you want to move or
copy.

3 Press Menu = (right action key) and

select Copy to copy the text, or select
Cut to move the text.

4 Open the document where you want to
insert the text, and position the
insertion point where you want the text
to appear.

5 Press Menu 2 (right action key) and
select Paste.

TIP To zoom in or out, open a document, press
View, select Zoom, and then select the zoom
level.

Saving a copy of a document
1 Open the document you want to copy.

2 Press Menu 2 (right action key) and
select File > Save As.

3 Select Name and enter a new name for
the file.

WORD MOBILE @
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4 Select the Folder list, and then select
the folder where you want to save the
file.

5 Select the Type list, and then select the
format in which you want to save the
file.

6 Select the Location list, and then select
whether you want to store the file on
your smartphone or an expansion card.

7 Select Save.

TIP To zoom in or out, open a document, press
View, select Zoom, and then select the zoom
level.

TIP If a document was previously saved on a
computer, any unsupported formatting may be
lost when you save the file.

Formatting text

1 Open the document you want to
format.

2 Highlight the text you want to format.

3 Press Menu C—= (right action key) and
select Format > Font.

4 Set any of the following options for the
highlighted text:

Font: Sets the typeface.

Font color: Sets the color.
Size: Sets the point size.

Bold: Indicates whether the text
appears normal or thick.

Italics: Indicates whether the text
appears upright or slanted.

Underline: Indicates whether the text
appears with an underscore.

Highlight: Indicates whether the text
appears with a yellow highlight.

Strikethrough: Indicates whether the
text appears with a line through it.

5 Press OK (@] to return to the
document.

Formatting paragraphs and lists

1 Open the document you want to
format.

2 Position the insertion point in the
paragraph you want to format.

3 Press Menu = (right action key) and
select Format > Paragraph.
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4 Set any of the following options: 3 If you encounter an unknown or
misspelled word, do one of the

Alignment: Aligns the text with the
following:

left, right, or center of the paragraph.
« Select the correct word in the list if

List: Creates a bulleted or numbered . .
the word is spelled incorrectly.

list.

« Select Ignore if the word is spelled
Indentation: Changes the paragraph correctly.
margins.

« Select Add to add a new word to the
Left: Sets the left margin for the spelling dictionary.

entire paragraph.

Right: Sets the right margin for the
entire paragraph.

Special: Lets you indent the first line
or set a hanging indent.

TIP To check the spelling of specific text,
highlight it before you select the Spelling
command.

) ) Organizing your documents
By: Sets the size of the Special

You can rename your documents, move

indentation.
your documents to another folder, and
5 Press OK (@ to return to the move your documents between your
document. smartphone and an expansion (storage)

card.
TIP You can also use the Formatting toolbar to _
create a list and to align text. To indent textin 1 Go to the documents list.

lists, you must use the Formatting toolbar. 2 Highlight a file.
3 Press Menu 2 (right action key) and
Checking spelling in a document select Rename/Move.
1 Open the document you want to check. 4 Select Name, and then enter a new
2 Press Menu 2 (right action key) and name for the document.

select Tools > Spelling.
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Select the Folder list, and then select
the folder you want to move the
document to.

Select the Location list, and then select
Main memory or Storage card.

Press OK [@].

Select the Folder list in the upperleft,

and then select the folder you want to
View.

Select the Sort By list in the upperright,
and then select the sort method.

TIP To create a new folder, go to the
documents list, select the Folder list in the
upperleft, and then select Add/Delete. Select
New, enter a name for the folder, and then
press OK.

TIP When you go to a folder, you can easily
search your documents by sorting by type.

Deleting a document

1
2

Go to the documents list.

Highlight the document you want to
delete.

Press Menu = (right action key) and
select Delete.

Select Yes.

Customizing Word Mobile

1
2

3

4

Go to the documents list.

Press Menu —— (right action key) and
select Options.

Set any of the following options:
Default template: Sets the default
template for new documents.

Save to: Sets the default location
where new documents are stored.

Display in list view: Sets the types of
files that appear in the documents list.

Press OK (@].

PowerPoint Mobile

With PowerPoint Mobile, you can open and
view slide show presentations created on
your computer. Many presentation
elements such as slide transitions,
animations, and URL links are also
supported. Microsoft® Office PowerPoint®
features that are not supported on your
smartphone include the following:

Notes written for slides

POWERPOINT MOBILE



« Rearrangement or editing of slides

« Files created in PPT format earlier than
Microsoft PowerPoint ‘97

« HTML files in HTM and MHT formats

Playing a presentation
1 Press Start (&) and select Programs.
2 Select PowerPoint Mobile .
3 In the presentation list, highlight the
presentation you want to play.
Press Center @.
5 Do any of the following:
Press Right P to advance to the next
slide or Left € to view the previous
slide.
Press Menu = (right action key),

select Go to Slide, and select the
slide you want to view.

Select Next or Previous to play
animations.

Press Menu = (right action key),
select Zoom In, and then select & to
zoom in or &2 to zoom out. To scroll
within the current slide, tap and drag
the slide. To return to the slide show,
select K.

STAYING PRODUCTIVE e

» Press Menu C—— (right action key)
and select End Show.

CHAPTER

TIP If a presentation is set up as a timed slide
show, the slides advance automatically.
Presentations pause during zooming.

Setting presentation playback options

1

2

Open the presentation for which you
want to change the settings.

Press Menu > (right action key) and
select Show Options.

On the Orientation tab, select the
orientation you want. To select the
orientation that best fits your
smartphone’s screen, select Default.
Select the Playback tab, and check the
Override playback options for all files
box.

Set any of the following options:

Show without animation: Turns off
builds and other animations.

Show without slide transition: Turns
off transition effects between slides.
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Use slide timings, if present: Enables
the timings recorded with each slide in
a presentation.

Loop continuously: Advances to the
first slide after playing the last slide in a
presentation.

6 Press OK (@].

TIP To turn the presentation into a
continuously looping slide show, check both
the Use timings, if present, and the Loop
continuously boxes.

DID YOU KNOw? You can purchase SDIO
presentation modules that let you project your
PowerPoint Mobile presentations through an
LCD projector.

Excel Mobile

With Excel Mobile you can create and edit
workbooks and templates on your
smartphone. You can also edit workbooks
and templates that you create on your
computer. However, keep in mind that you
may lose some of the information and
formatting when you save the workbook on
your smartphone.

Note the following formatting
considerations:

Alignment: Vertical text appears
horizontal.

Borders: Appear as a single line.

Cell patterns: Patterns applied to cells
are removed.

Fonts and font sizes: The original font
is listed on your smartphone and
mapped to the closest font available.
Original fonts reappear on your
computer.

Number formats: Microsoft® Excel® 97
conditional formatting is displayed in
Number format.

Formulas and functions: Unsupported
functions are removed, and only the
returned value of the function appears.
Formulas containing the following are
also converted to values:

« An array or array argument, for
example, =SUM({1;2;3;4})
External link references or an
intersection range reference

« References past row 16384 are
replaced with #REF!

EXCEL MOBILE



Protection settings: Most protection
features are disabled but not removed.
However, password protection is
removed. You must remove the
password protection in Microsoft®
Office Excel® on your computer before
opening the file on your smartphone.

Zoom settings: \Worksheet-specific
zoom settings are not retained. The
zoom setting applies to the entire
workbook.

Worksheet names: Names that refer to
other workbooks, arrays, array formulas,
or intersection ranges are removed
from the name list, causing those
formulas to be resolved as “"#NAME?"
All hidden names are not hidden.

AutoFilter Settings: AutoFilters that
cause rows to be hidden are supported.
Use the Unhide command to display
hidden rows. Other AutoFilters are
removed, but you can use the AutoFilter
command in Excel Mobile to perform
similar functions.
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« Chart Formatting: All charts are saved
as they appear in Excel Mobile.
Unsupported chart types are changed to
one of these supported types: Column,
Bar, Line, Pie, Scatter, and Area.
Background colors, gridlines, data
labels, trend lines, shadows, 3D effects,
secondary axes, and logarithmic scales
are turned off.

CHAPTER

The following features aren’t supported in
Excel Mobile and are removed or modified
when you open a workbook on your
smartphone:

« Hidden, dialog, and macro sheets

« VBA modules

« Text boxes

« Drawing objects and pictures

o Lists

« Conditional formats and controls

« Pivot table data (is converted to values)

TIP For simple calculations, use the Calculator
(see Calculator).

TIP To copy a file from your computer to your
smartphone, open My Computer or Windows
Explorer on your computer, copy the file into

the Mobile Device folder, and then sync.
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2
3
4

Creating a workbook

Press Start (&) and select Programs.
Select Excel Mobile .
Press New T (left action key).

Highlight a cell where you want to enter
text or other info.

Enter the info into the cell, and then
press Enter @ .

Repeat steps 4 and 5 to enter the
remaining info.

Press OK (@] to save the file.

TIP When you save a new workbook, it is
automatically named and placed in the
workbook list.

TIP To insert a symbol, place the insertion
point where you want the symbol. Press

Open the template you want to use,
and enter the information you want to
include in the template.

Press Menu = (right action key) and
select File > Save As.

Press OK (@].

Rename the workbook and move it to
the appropriate folder. See Organizing
your documents for details.

TIP To create a new template, highlight the
workbook you want to save as a template.
Press Menu, and select Rename/Move.
Select Name, and then enter a name for the
template. Select the Folder list, and then
select Templates. Press OK.

Viewing a workbook

Menu and select Insert > Symbol. Highlight 1 Press Start and select Programs.
th bol ttoi t, and th lect .
In:esr\;m 0l you want 1o Insert, an en selec 2 Select Excel Moblle .
3 In the workbook list, select the
Creating a workbook from a template workbook you want to view.
1 Go to the workbook list. 4 Press View T (left action key), and
then select any of the following:
2 Select the Folder list in the upperleft, 4 9
and then select Templates. Full Screen: Shows as much data as
possible on the screen. To return to the
146) EXCEL MOBILE



normal view, select Restore in the
upperright.

Zoom: Sets the magnification level so

that you can easily read the worksheet.

Sheet: Lets you switch to a different
worksheet.

Split: Divides the window into two
scrollable areas. To move the split bar,
tap and drag it. To remove the split bar,
select View > Remove Split.

Freeze Panes: Locks rows or columns
so they remain visible while you scroll.
Highlight the cell at the juncture you
want to lock before you select this
command. To unlock the rows or
columns, select View > Unfreeze
Panes.

Toolbar: Sets whether the toolbar
appears onscreen.

Status Bar: Sets whether the status
bar appears onscreen.

Show: Sets whether headings and
scroll bars appear onscreen.
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TIP To jump to a cell or a region, press Menu
and select Edit > Go To. Select Cell
reference or name and enter the target cell
info or select Current region. Press OK.

DID YOU KNOwW? You can also switch
worksheets by selecting the sheet list at the
bottom of the screen.

Calculating a sum

1 Press View T (left action key) and
select Toolbar.

2 Highlight the cell where you want to
insert the sum.

3 Select F.

4 Tap and drag the stylus across the cells
you want to add.

5 Press Enter @.

Entering a formula

1 Highlight the cell where you want to
enter the formula.

2 Enter an = sign followed by any values,
cell references, name references,
operators, and functions.

Example: =(B4/
25)+100=Revenue-Expenses

3 Press Enter (@.
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~
o
< . .
z Entering a sequence automatically
DID YOU kNow? To enter symbols that are not L .
N wee BATLSEIS o 1 Highlight both the cells containing the
on the keyboard, such as the = sign, press Alt X
and select the symbol from the list. mfp you Want_to E_’Utomate and the
adjacent destination cells.
Inserting a function 2 Press Menu —— (right action key) and
1 Open the workbook where you want to select Edit > Fill.
insert the function.
. . 72 | Excel Mobile 1 Y| ==
2 Press Menu C— (right action key) and -
select Insert > Function. Orection:
Fill bype:
£ | Excel Mobile 1 V)| = seriestyps: [l | ]
Insert Function l:l
Category:
Function
|ABS(number) -
Returns the absolute value of a number,

3 Select the Direction list, and then
select the direction you want to
populate.

3 Select the Category list, and then 4 Select the Fill type list, and then
select the type of function you want to select Series.
insert. 5 Select the Series type list, and then
4 Select the Function list, and then select select the type of series you want. If
the specific function you want to insert. you select Date or Number, enter a
5 Press OK Step value increment.
6 Press OK (@].
(148) EXCEL MOBILE
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TIP Select Autofill as the series type to
quickly fill cells with repetitive data such as
numbers or repeated text. Autofill takes the
content of the first cell in the highlighted row
or column and copies it down or across the
rest of the selection.

Adding cells, rows, and columns

1 Open the workbook you want to add to.

2 Highlight the area where you want to
insert elements.

3 Press Menu = (right action key) and
select Insert > Cells.

4 Select how you want to insert the
elements:

Shift cells right: Inserts a new cell. The
highlighted cell and all cells on the right
move one column to the right.

Shift cells down: Inserts a new cell.
The highlighted cell and all cells below it
move down.

Entire row: Inserts a new row. The
entire row in which the highlighted cell
is located and all rows below it move
down.

STAYING PRODUCTIVE e

Entire column: Inserts a new column.
The entire column in which the
highlighted cells are located and all
columns to the right move one column
to the right.

5 Press OK (@].

CHAPTER

TIP To add a new worksheet, press Menu and
select Format > Modify Sheets. Select
Insert, enter a name for the worksheet, and
then press OK. To change the order of the
worksheets, highlight a worksheet you want
to move, and then select Move Up or Move
Down. Press OK to finish.

Formatting cells
1 Open the workbook you want to format.
2 Highlight the cells you want to format.

3 Press Menu > (right action key) and
select Format > Cells.

4 Select any of the following:
Size: Sets the row height and column
width.

Number: Sets the format for the
numbers in the cells.

Align: Sets whether text wraps within
the highlighted cells, and sets the
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5

horizontal and vertical alignment
position.

Font: Sets the typeface, color, size, and
style attributes.

Borders: Turns borders on and off for
various cell edges, and sets the border
and background colors.

Press OK (@).

TIP To name the highlighted cell or range of
cells, press Menu and select Insert > Define
Name. Enter the name and select Add. Press
OK.

Formatting rows and columns

1
2

Open the workbook you want to format.

Highlight the rows or columns you want
to format.

Press Menu = (right action key),
and then select Format > Row or
Format> Column.

Select any of the following:

AutoFit: Adjusts the size of the
highlighted rows or columns to their
contents.

Hide: Hides the highlighted rows or
columns.

Unhide: Displays hidden rows or
columns in the highlighted area.

DID YOU KNOow? You can adjust the column or
row size by tapping and dragging the right
edge of the column header or the bottom
edge of the row header.

Renaming a worksheet

1

Open the workbook containing the
worksheet you want to rename.

Press Menu = (right action key) and
select Format > Modify Sheets.

In the Sheets list, highlight the
worksheet you want to rename.

Select Rename, enter a new name for
the worksheet, and then press OK
twice.

Sorting info in a worksheet

1
2

Highlight the cells you want to sort.

Press Menu = (right action key) and
select Tools > Sort.

Select the Sort by list, and then select
the primary sort column.
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Check or uncheck the Ascending box to
indicate whether you want to sort in
ascending or descending order.

(Optional) Select the Then by lists, and
then select second and third level
sorting options.

Check or uncheck the Exclude header

row from sort box to indicate whether
you want to sort the header row.

Press OK (@].

Filtering info in a worksheet

1

Highlight the cells that contain the info
you want to filter.

Press Menu > (right action key) and
select Tools > AutoFilter. A list appears
at the top of each related column.
Select one of the new lists, and then
select a filter. This hides all rows that do
not include the selected filter.

(Optional) Select the other lists, and
then select other filters.
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DID YOU KNOW? You can also create custom
filters where you specify comparisons. Select
the filter list, and then select Custom.

TIP To display all rows again, select the filter
lists, and then select All. To turn off filtering,
press Menu and select Tools > AutoFilter
again.

Creating a chart

1

Open the workbook you want to create
a chart from.

Highlight the cells you want to include
in the chart.

Press Menu > (right action key) and
select Insert > Chart.

Select the type of chart, and then press
Next > (right action key).

Confirm the area you want the chart to
include, and then press Next ——>
(right action key).

Select the data layout, and then press
Next > (right action key).

Check the boxes to indicate whether

the first row and column represent
labels.

CHAPTER
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8 Select whether you want the chart to
appear as a separate worksheet within
the current workbook, or as part of the
current worksheet.

9 Press Finish —— (right action key).

Formatting or changing a chart

1 Open the workbook that contains the
chart you want to format.

2 Open the chart.

3 Press Menu = (right action key) and

select Format > Chart.
4 Select any of the following:

Titles: Sets the title of the chart and
headings, whether a legend appears,

and the where the legend is placement.

Scale: Sets the minimum and

maximum scales for charts with an x or

y axis.

Type: Sets the chart style. You can use
this setting to convert your chart to a
different format.

Series: Lets you add, modify, format, or

delete related data points without
affecting the info in your worksheet.

5 Press OK [@].

Finding or replacing info in a workbook

1 Open the workbook containing the info
you want to find.

2 Press Menu C (right action key) and
select Edit > Find/Replace.

3 Select Find what and enter the info you
want to find.

4 (Optional) Check the Match case box to
find text that matches the capitalization
in any text you entered in step 3.

5 (Optional) Check the Match whole
words only box to find only whole
words that match any text you entered
in step 3.

6 Select Find to locate the first instance
of the info you entered in step 3, or
select Replace and enter the
replacement info.

7 Select Next to find the next instance of
the info, or select Replace to replace it.
To replace all instances of the info,
select Replace All.

8 When you see a message that Excel
Mobile has finished searching,
press OK (@]
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Organizing your workbooks

You can rename your workbooks, and
move them to another folder and between
your smartphone and an expansion
(storage) card.

1 Go to the workbook list.
2 Select afile.

3 Press Menu 2 (right action key) and
select Rename/Move.

4 Select Name, and then enter a new
name for the workbook.

5 Select the Folder list, and then select
the folder you want to move the
workbook to.

6 Select the Location list, and then select
Main memory or Storage card.

7 Press OK ().

8 Select the Folder list in the upperleft,
and then select the folder you want to
view.

9 Select the Sort By list in the upperright,
and then select the sort method.

TIP When you go to a folder, you can easily
search your documents by sorting by type.

Deleting cells, rows, and columns

1
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Open the workbook containing the
elements you want to delete.

Highlight the area you want to delete.

Press Menu — (right action key) and
select Edit > Delete Cells.

Select how you want to remove the
elements:
Shift cells left: Deletes the highlighted

cells and moves all cells on the right one
column to the left.

Shift cells up: Deletes the highlighted
cells and moves all cells below them up.

Entire row: Deletes the entire row in
which the highlighted cells are located,
and moves all rows below it up.

Entire column: Deletes the entire
column in which the highlighted cells
are located, and moves all columns on
the right one column to the left.

Press OK (@].
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TIP To delete a workbook, go to the workbook
list and highlight the workbook you want to
delete. Press Menu and select Delete. Select
Yes to confirm.

TIP To delete a worksheet, press Menu and
select Format > Modify Sheets. Highlight
the worksheet you want to delete, and then
select Delete. Select Yes, and then press OK
to finish.

DID YOU know? Excel Mobile adjusts formulas
to reflect the new cell locations. However, a
formula that refers to a deleted cell displays
the #REF! error value.

Customizing Excel Mobile

1
2

Go to the workbook list.

Press Menu = (right action key) and
select Options.

Set the following options:
Template for new workbook: Sets the
default template for new workbooks.

Save new workbooks to: Specifies
where new workbooks are stored.

Files to display in list view: Specifies
which types of files appear in the
workbook list.

Press OK (@].
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Managing Files and

Applications

Your smartphone comes equipped with a variety of tools for
managing and organizing your information. To get the most out
of your smartphone, install some of the thousands of business,
education, or leisure-time applications available. After you use
your smartphone to create or capture important business and
personal information, use one of several options to share it
with others. Insert expansion cards (sold separately) for a
compact and limitless answer to the storage dilemma. And
because there's a calculator on your smartphone, you never
need to carry a separate one.

Benefits

« Locate info in any application « Keep others up-to-date with

« Install applications, games, and meaningful business and personal
other software information

« Store, carry, and exchange info
« Always have a calculator with you
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Using Find

With the built-in search features on your
smartphone, you can find information
quickly:

o Lookup: Helps you find and dial your
contacts by name or phone number.

See Dialing by contact name for details.

« Search: Looks through the text in all the
applications on your smartphone.

« File Explorer: Lets you browse through
the files and folders on your
smartphone or an expansion card.

« Global Address Lookup: Enables you
to look up names in your online
corporate address list.

Using Search

Search for files and other items stored in
the My Documents folder on your
smartphone or on an expansion card. You
can search by file name or by words
located in the item. For example, you can
search for words within notes,
appointments, contacts, and tasks.

MANAGING FILES AND APPLICATIONS e

Press Start (#) and select Programs.
Select Search p
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Type: Al data

Results
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Search = Advanced

Select Search for, and then enter the
file name, word, or other info you want
to find.

Select the Type list, and then select the
kind of information you want to find.
Press Search T—— (left action key).

Use the 5-way to select and view an
item from the results of the search.

TIP You can also open the Search screen by
pressing Option + left Shift.

TIP If you've looked for an item before, select
the Search for list, and then select the item in
the list.

USING FIND @
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Exploring files and folders

File Explorer lets you browse the contents
of folders on your smartphone. The root
folder on your smartphone is named My
Device. My Device is similar to My
Computer on your computer.

1 Press Start and select Programs.
2 Select File Explorer 55

3 Select the Show list in the upper-left,
and then select the folder you want to
explore.

4 Do any of the following:
« To open an item, select it.

« To quickly delete, rename, beam, or
email an item, highlight the item,
press and hold Center @D to open
the shortcut menu, and then select
the appropriate command.

« To move a file to another folder,
highlight the item, press and hold
Center @ to open the shortcut
menu, and then select Cut or Copy.
Open the destination folder, and press
and hold Center @ to open the
shortcut menu, and then select
Paste.

« To highlight multiple items, tap and
drag the stylus.

IMPORTANT Do not delete any files that
you cannot identify. These files may be
required for your smartphone to function
properly.

DID YOU KNOW? You can sort the contents of a
folder by name, date, size, or type. Select the
Sort by list in the upperright, and then select
the sort method.

TIP The storage card symbol appears next to
the names of files that are stored on an
expansion card.

Installing applications

Your Palm® Treo™ 700wx smartphone
comes with several built-in and
ready-to-use applications. You can also
install any of the additional software
included on the Getting Started CD as well
as other third-party applications that are
compatible with Windows Mobile® 5.2
devices, such as business software,

INSTALLING APPLICATIONS



games, and more. To learn more, go to
www.palm.com.

Applications you download to your
computer are likely to be in a compressed
format such as ZIP If the file is
compressed, you need to use a
decompression utility on your computer,
such as Winzip, before you install the
application on your smartphone.

These instructions tell you how to install
basic files onto your smartphone. Some
software uses an installer or wizard to
guide you through the process. Consult the
documentation that came with the
software for details.

TIP If an application does not have a Microsoft
Mobile to Market certificate, you will see a
message indicating that the application is
untrusted. If this occurs, you can indicate
whether you want to continue the installation.

Be sure to select and install Microsoft
Windows Mobile 5.2 software for Pocket PC
Phone Edition. Microsoft Windows Mobile 5.2
software for Smartphone is not compatible
with your Treo 700wx smartphone.

MANAGING FILES AND APPLICATIONS

Installing applications from the Internet

You can use Internet Explorer Mobile to
install Windows Mobile apps in the CAB
file format directly from the Internet. You
must use your computer to install apps in
other file formats.

1 Make sure your phone is on (see
Turning your phone on and off).

2 Press Start (&) and select Internet
Explorer.

3 Go to the page that contains the link to
the application you want to download.

4 Press Left 4 or Right P to highlight the
link to the file, and then press Center
@ to start the download process.

Press Start (&) and select Programs.
Select File Explorer 55
Go to the My Documents folder.

0 N O O

Tap the file you downloaded to start the
installation program.

DID YOU KNOw? You can purchase a third-party
application that lets you run Palm OS®
applications on your Treo 700wx smartphone.

TIP Before purchasing a third-party program,
try the free version.

CHAPTER
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Installing applications from your
computer

BEFORE YOU BEGIN To install an
application from your computer to your
smartphone, you must first install the
ActiveSync software on your computer
(see Installing the desktop synchronization

software).

1 Open My Computer or Windows
Explorer on your computer.

2 Copy the application file(s) into the
Mobile Device ﬁ folder.

3 Connect your smartphone to your
computer to synchronize and install the
application(s) on your smartphone.

Installing applications onto an expansion
card

1 Insert the expansion card into the

expansion card slot (see Removing and
inserting expansion cards).

2 Open the ActiveSync® window on your
computer.

3 Click Tools and select Explore Device.

4 Double-click My Windows
Mobile-Based Device r[ to open the
Mobile Device folder.

5 Copy the application file(s) into the
Storage Card folder inside the Mobile
Device folder.

Getting help with third-party applications
If you encounter a problem with a
third-party application (such as an error
message), contact the application’s author
or vendor. For general troubleshooting of
third-party applications, see Third-party
applications.

Make sure that the third-party application
supports 240x240 screen resolution. Some
older applications have screen-size
limitations. Third-party applications should
also be written for Windows Mobile
version 5.2 or later. Programs written for
earlier versions do not support 5-way
navigation or action keys and can have
performance problems. If you can try a free
version of the software before purchasing
it, you can test it first to make sure it works
properly.

160
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1 3 Highlight the application that you want H

RemOVIOQ to remove. ©
app“caTIOﬂS 4 Select Remove.

5 Select Yes to confirm deletion.

To free up memory on your smartphone,
you can remove applications that you no
longer use. You can remove only
applications, patches, and extensions that
you install; you cannot remove the built-in
applications that reside in the ROM portion

of your smartphone. Se.t.tl ng
1 Press Start (&) and select Settings. . .
synchronization

2 Select the System tab, and then select

TIP Some applications are factory-installed on
your smartphone and cannot be deleted.
These are not listed in the Remove Programs
list.

Remove Programs 3. 0 pt| ons
74 | Settings [ Y| o= ok
femove Programs Selecting which info to sync

Programs in storage memory:

SOTI Pogket Controler 1 Press Start [#) and select Programs.
2 Select ActiveSync Q

3 Press Menu 2 (right action key) and
select Options.

Total storage memory svalsble:  59584K

REMOVING APPLICATIONS @
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/4 | activesync % Ve = B

Options

Choose the data you want ko sync:

MBS Contacts
ME calendar
M E-mail

Tasks
Motes

Delete Settings...

Do any of the following:

« Check the box next to any items you
want to synchronize. If you cannot
check a box, you might have to
uncheck a box for the same
information type elsewhere in the list.

Uncheck the box next to any items
you want to stop synchronizing.

Select an item and then select
Settings to customize the settings for
that item. Settings are not available
for all items.

Synchronizing with an Exchange Server

You can sync directly with an Exchange
Server, using a connection to either a
wireless network or a computer.

7

Press Start and select Programs.
Select ActiveSync @ .

Press Menu —— (right action key) and
select Configure Server. If you have
not yet set up a sync with an Exchange
Server, this says Add Server Source.

Select Server address, enter the name
of the server running the Exchange
Server, and then press Next ——— (right
action key).

Enter your name, password, and
domain, and then press Next ——
(right action key). To change the rules for
resolving synchronization conflicts,
select Advanced.

Check the boxes next to the type of info
that you want to synchronize with the
Exchange Server.

Press Finish ——= (right action key)

DID YOU KNow? You can also use the Sync
Setup Wizard to set up your smartphone to
synchronize remotely with Exchange Server.
This wizard starts when you connect your
smartphone to your computer after installing
ActiveSync on your computer.

SETTING SYNCHRONIZATION OPTIONS



Synchronizing with two computers

You can set up your smartphone to
synchronize with up to two computers as
well as with an Exchange Server. When
synchronizing with two computers, the
items that you synchronize appear on both
computers.

For example, if you set up your smartphone
to sync different items with two computers
named C1 and C2, when you sync
Contacts and Calendar on your smartphone
with both computers, you see the
following result:

« The contacts and calendar
appointments that were on C1 are now
also on C2.

« The contacts and calendar
appointments that were on C2 are now
alsoon C1.

« The contacts and calendar
appointments from both computers are
on your device.

NOTE Microsoft® Office Outlook® email
can synchronize with only one computer.

MANAGING FILES AND APPLICATIONS e

TIP To stop synchronizing with one computer
completely, select the computer name and
then select Delete.

Synchronizing using Bluetooth wireless
technology

The computer with which you connect
must have Bluetooth® wireless technology,
either built-in or through a Bluetooth card.
Make sure that the computer’s Bluetooth
setting is discoverable.

1 On your computer, right-click the
ActiveSync icon in the system tray, and
select Connection Settings.

2 Check the Allow connections for one
of the following box, and then select
Bluetooth.

3 On your smartphone, press Start (%)
and select Settings.

4 Select the Connections tab, and then
select Bluetooth (3.

Check the Turn on Bluetooth box.
Press OK (©].

Press Start and select Programs.
Select ActiveSync @ .

0 N o O
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Press Menu ——— (right action key) and
select Connect via Bluetooth. If this is
the first time you're making a Bluetooth
connection to this computer, follow the
onscreen prompts to set up a Bluetooth
partnership with the computer.

10 In ActiveSync, select Sync.
11 When synchronization has finished,

press Menu = (right action key) and
select Disconnect Bluetooth.

12 (Optional) Go to your Today screen,

select Bluetooth [, and then uncheck
the Turn on Bluetooth box to conserve
power by turning off your smartphone'’s
Bluetooth feature.

DID YOU kKNOow? You can also connect your
smartphone to your computer with an infrared
(IR) or a Bluetooth® wireless connection.

Starting and stopping synchronization

If ActiveSync is running on your computer
and you connect your smartphone to your
computer, synchronization begins
automatically. If you ever need to manually
start or stop synchronization, follow

these steps:

1 Connect your smartphone to your
computer (see Connecting your
smartphone to your computer). If you
are synchronizing wirelessly only with
an Exchange Server, you do not have
to connect the device.

2 Press Start and select Programs.
3 Select ActiveSync @ .

TIP If synchronization doesn't start
automatically, press Start and select
Programs. Select ActiveSync and then select
Sync to start synchronization.

TIP To end synchronization before it
completes, select Stop.

Setting the synchronization schedule

You can schedule wireless synchronization
to occur automatically at regular intervals.
If you prefer to synchronize manually, do
not turn on these settings.

1 Connect your smartphone to your
computer (see Connecting your
smartphone to your computer). If you
are synchronizing wirelessly only with
an Exchange Server, you do not have to
connect the device.

SETTING SYNCHRONIZATION OPTIONS



2 Press Start (&) and select Programs.
3 Select ActiveSync @ .

4 Press Menu 2 (right action key) and
select Schedule.

5 Set any of the following options:

Peak times: Sets the frequency for
high-traffic time periods such as when
you are at work or when email volume
is high.

Off-peak times: Sets the frequency for
low-traffic time periods such as late at
night.

Use above settings while roaming:
Sets the frequency while you are
roaming outside your wireless provider
network. To minimize roaming charges,
uncheck this box and synchronize
manually while roaming.

Send outgoing items immediately:
Sets whether items are sent as soon as
you select Send in the Messaging
application, or whether they are held
until the next synchronization.

6 Press OK (@].
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TIP The auto shut-off timer resets itself each
time you synchronize. If your sync interval is
shorter than the auto shut-off interval, your
smartphone doesn’t turn off.

pID YOU know? Decreasing the sync
frequency settings conserves battery power.

Sharing info

Your smartphone comes equipped

with a variety of options for sharing
information, so that you can choose the
quickest, most convenient way to send
your info or to receive info from another
device.

When you have a file open in a program
such as Notes or PowerPoint Mobile,
you can easily share a file by pressing
Menu, and then selecting Send via
E-Mail or Beam File.

In Outlook, you can insert a picture or
attach a note or other file to an email.
You can also receive pictures and
attachments.

ActiveSync® enables you to share files
with your computer. You can add or

SHARING INFO @
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remove files directly from the Treo My
Documents folder, located in your My
Documents directory on your computer.
These files are updated the next time
you sync.

« If you are near someone, you can beam
files and applications between your
smartphone and your neighbor’s device
using the IR port or Bluetooth® wireless
technology.

« You can also store files on an expansion
card and share the expansion card.

Using expansion
cards

The expansion card slot on your
smartphone enables you to add SD cards
and MultiMediaCard cards to extend the
storage capacity of your smartphone. For
example, SD or MultiMediaCard expansion
cards can store the following:

o Pictures
« Videos
« MP3 audio files

« Email attachments

« Games

» eBooks

» Applications

» Databases

When purchasing an SDIO card, make sure

the card is compatible with the Treo 700wx
smartphone.

Expansion cards are sold separately. Your
smartphone comes with a dummy card
inside the expansion card slot, to protect
the slot. When you do not have a
functioning card inside the slot, reinsert the
dummy card to protect the slot opening.

TIP Check with the card manufacturer to
confirm compatibility before purchasing an
SDIO card.

TIP We recommend that you purchase
preformatted expansion cards. To format a
card on your own, you need to connect a card
reader (sold separately) to your computer.

TIP SD cards are faster than MultiMediaCard
cards for reading and writing information.
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Removing and inserting expansion cards

1 Press down and release the dummy
card.

2 After you feel the expansion card slot
eject the dummy card, remove the card
from the slot.

3 Toinsert an expansion card, hold your
smartphone with the screen facing you
and the card with the label facing you.
The notch on the card should be in the
lower-left corner next to the antenna.

4 Insert the card into the expansion card
slot until you feel it lock into place and
hear the confirmation tone.

MANAGING FILES AND APPLICATIONS
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Opening applications on an expansion
card

After you insert an expansion card into the
expansion card slot, you can open any of
the applications stored on the expansion
card.

1

Insert the expansion card into the
expansion card slot.

Press Start and select Programs.
Select File Explorer.

Select the Show list in the upperleft,
and then select Storage Card.

Select the application you want to open.

USING EXPANSION CARDS @
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TIP To run an application on an expansion card,
your smartphone must have enough free
space in the internal memory.

Saving files to an expansion card

You may find it helpful to automatically
save the info on an expansion card. For
example, when you create new Word
Mobile documents, notes, Excel Mobile
workbooks, pictures, videos, and audio
files, you can save them directly to an
expansion card. (Some applications may
not support this feature.)

1 Insert an expansion card into the
expansion card slot.

2 Open the application you want to save
the info from.

3 Press Menu = (right action key) and
select Options.

4 Select the Save to list, and then select
Storage Card.

5 Press OK [@].

TIP If you don't see the Save to list on the
Options screen, look on the other tabs (if
present). If you still can't find a Save to list, the
application may not support this feature.

Moving info between your smartphone
and an expansion card

1

6

Insert an expansion card into the
expansion card slot.

Open the application from which you
want to move the info.

Go to the list view and highlight the
item(s) you want to move.

Press Menu ——— (right action key) and
select Rename/Move.

Select the Location list, and then select
where you want to move the info:
Storage Card or Main Memory.

Press OK (@].

Copying or moving applications and files
between your smartphone and an
expansion card

Insert the expansion card into the
expansion card slot.

Press Start (&) and select Programs.
Select File Explorer.
Select the file or application you want to

copy or move (see Exploring files and
folders.).
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5 Press Menu (2 (right action key) and
select Edit > Copy or Edit > Cut.

6 Go to the folder where you want to
place the selected item.

7 Press Menu 2 (right action key) and
select Edit > Paste.

8 Press OK (@].

TIP Your applications are usually located in the
My Device / Program Files folder.

TIP Before copying information to or renaming
the files or folders on an expansion card, or
renaming the card itself, make sure the card is
not write-protected. See the instructions that
came with your card for details.

Viewing available expansion card
memory

You can view how much space is available
on the expansion card that is currently in
the expansion card slot.

1 Insert the expansion card into the
expansion card slot.
2 Press Start (&) and select Settings.

3 Select the System tab, and then select
Memory .

MANAGING FILES AND APPLICATIONS e

4 Select the Storage Card tab.
5 Press OK (@],

Exploring files on an expansion card

1 Insert the expansion card into the
expansion card slot.

2 Press Start (&) and select Programs.
3 Select File Explorer.

4 Select the Show list in the upperleft,
and then select Storage Card.

5 Select the folder or files you want to
view.

6 Press OK (@].

Renaming an expansion card

If you change the contents of an expansion
card, you may at some point want to
rename the card to better match its
contents.

1 Insert the expansion card into the
expansion card slot.

2 Press Start (&) and select Programs.

3 Select File Explorer.

4 Select the Show list in the upper-left,
and then select My Device.
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5 Highlight the current expansion card 7 Enter a new name for the card.
name (Storage Card by default). 8 Press OK (@)

6 Press Menu = (right action key) and
select Rename.

CHAPTER
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Customizing Your

Smartphone

Customizing is optional. But why not personalize your
smartphone to make it match your lifestyle and work even
harder for you?

You can easily customize your smartphone’s sounds, fonts,
screen colors, and more. Take advantage of various levels of
security. Prevent making an accidental (and expensive) phone
call by locking the keyboard. Some preference settings can help
extend the life of your smartphone's battery. There are lots of
ways to make your smartphone work better for you.

Benefits

« Conserve power

« Secure your data

» Make your screen easy to read
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Today screen settings

Selecting your Today screen background
1 Press Start and select Settings.
2 On the Personal tab, select Today %

74 | settings (0 Y| &= Bk

Today

Select a theme for your device:

Guava Bubbles Beam

Indigo

Windows Default
[Use this pickure as the background|

Browse

Appearance | Items

3 On the Appearance tab, check the Use
this picture as the background box.
Select Browse.

5 Select the picture you want to use.

6 Press OK (@]

DID YOU KNow? There are lots of third-party
plug-ins available for your Today screen. For
clocks, calculators, MP3 players, weather
guides, and much more, visit www.palm.com.

CUSTOMIZING YOUR SMARTPHONE e

Selecting which items appear on your
Today screen

1 Press Start (&) and select Settings.
2 On the Personal tab, select Today %

/4 | settings (0 Y| == B

Today

CHAPTER

Checked items appear on the Today screen.

[oate [Moveup |
Speed Dial =

[V] Today timeout:
Appearance | Tters |

3 Select the Items tab.

4 Check the boxes next to the items you
want to appear on your Today screen,
and uncheck any items that you want to
hide.

5 (Optional) Select Options (if available)
to configure the settings for the current
item. Press OK to return to Today
Settings.

6 Press OK (@].

TODAY SCREEN SETTINGS (173)
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TIP To change the color theme for your
smartphone, select a new theme from the
Appearance tab in Today Settings.

Phone settings

BEFORE YOU BEGIN Turn on your phone
to access your Phone Settings. See Turning
your phone on and off.

Selecting ringtones and vibrate settings
You can set various tones for various types
of incoming phone calls and notifications.
1 Press Start and select Settings.

2 On the Personal tab, select Sounds &
Notifications @):-.

3 Select the Notifications tab.

4

74 | Settings 0 Y| = R

Reg e

Wibrate when ringer switch off
[ wibrate when ringer switch on

soveaione [ ||
E

Select the Event list, and then select
which type of call or notification you
want to set the ringtone for:

Phone: Known Caller: An incoming call
from someone in your Contacts list or
Speed Dial list.

Phone: Missed call: A call you did not
answer.

Phone: Roaming: A call that comes in
when you're outside your home
wireless network.

Phone: Unknown Caller: An incoming
call from someone identified by caller
ID who is not in your Contacts list or
Speed Dial list.

Phone: Voice mail: A new voicemail.
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Select the Ring type list, and then
select the ring style for the selected
type of call.

Select the Ring tone list, and then
select the sound for the selected type
of call.

NOTE For the Missed call and Voice mail
options, select sound and display options
instead of ring type and ring tone options.

7

9

(Optional) Select Play @ to preview the
sound.

Check the Vibrate when... boxes to
turn the vibrate feature on/off based on
the Ringer switch setting.

Repeat steps 4-6 to select ringtones for
other types of calls.

10 Press OK (@J.

CUSTOMIZING YOUR SMARTPHONE

TIP To record, preview, delete, and send
sounds on your smartphone, select the
Manage tab. To record a sound, press Menu
and select New Sound. To play a sound,
select it. To delete a sound, highlight it and
press Backspace. To send a sound, highlight
it, press Menu, and select Send Sound.

DID YOU KNOW? You can also set sounds for
messaging notifications and calendar
reminders. See .

DID YOU KNow? You can download MP3, MIDI,
QCELR, WAV, and WMA ringtones directly to
your smartphone (see Downloading files and
images from a web page). You can also
download ringtones to your computer and
then email them to your phone. Your device
also supports the video ringtone formats
WMV, 3GE, and 3G2 (video files recorded from
your smartphone camera).

Adjusting volume settings

Call volume: While a call is in progress,
press the Volume button (on the side of
your smartphone) to adjust the call
volume.

Music/Video volume: While playing
music or a video, press the Volume
button to adjust the music/video
volume.

CHAPTER
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Ringer volume: When a call is not in
progress and you are not playing music
or a video, press the Volume button to
adjust ringer volume.

Assigning a picture and ringtone ID to a
contact

1
2

Press Start and select Contacts.
Highlight the contact to whom you want
to give a picture caller ID, and

then press Center @.

Highlight the contact's name, and press
Edit T (left action key).

Select Picture.

Select Camera to take a picture and add
it to this contact entry, or select an
existing picture for this contact entry.
Select Ring tone and then select a tone
for this contact entry.

Selecting your call settings

BEFORE YOU BEGIN Turn on your phone
to access your Phone Settings. See Turning
your phone on and off.

1

Press Start (&) and select Settings.

74 | settings 1 Y = B

Phone - (408) 555 -2760

Dialpad:

TTYTTD:  |off -

After calls from nurmbers that are not
in Contacts, ask if I want to add
themn.

Set ring ones For Incoming cals.

Phon [ Services | Dialing | security

On the Personal tab, select Phone {.

On the Phone tab, set any of the
following options:

Dialpad: Sets the style for the dial pad
tones (DTMF) in the Phone application.

« Short tones: Tones sound briefly as
you dial.

« Long tones: Tones continue to sound
until you release the key.

TTY/TDD: Lets you configure your

smartphone for use with a TTY/TDD

device for people who are deaf or hard

of hearing.
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After calls from numbers that are not
in Contacts, ask if | want to add
them: Indicates whether you are
prompted to add contact entries for
numbers that are not already in your
Contacts list.

4 Press OK (@] to finish.

TIP If you have trouble accessing a voicemail
system, try changing the Dialpad tone setting.

Setting your dialing preferences

Dialing preferences let you assign a prefix
to your phone numbers. For example, you
can automatically dial a 1 before all 10-digit
phone numbers. You can add a different
prefix based on the length of the phone
number.

1 Press Start () and select Settings.

CUSTOMIZING YOUR SMARTPHONE e
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Phone

Dialing from Morth &merica

Bhiays dial 1in front of area code
International Dialing Prefix:

Abbreviated Dialing

Phane | Services | Diaing | Security
B

On the Personal tab, select Phone .

On the Dialing tab, set any of the
following options:

Dialing from North America: Formats
phone numbers using North American
conventions (XXX-XXX-XXXX).

Always dial 1 in front of the area
code: Adds a 1 in front of 10-digit phone
numbers. This option is available only
when North American Dialing is
enabled.

International Dialing Prefix: Adds the
specified number in front of
international phone numbers. (When an
international number beginning with
"+" is dialed, the “+" is replaced with
the number in this field.)

PHONE SETTINGS @
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4 Press OK (@] to finish.

Setting your abbreviated dialing
preferences

Abbreviated dialing is used to automatically
dial a complete phone number when you
enter a shortened version of that number.
Shortened phone numbers are typically
used in corporate phone systems that
allow internal users to dial an extension
number rather than the complete number.

For example, if your co-worker's phone
number is 1-655-222-1234, you may need
to dial only the last five digits of that
number from an internal phone. In that
case, you would dial 21234. If that
shortened five-digit internal number is
entered in your contact list or in a corporate
Global Address List (GAL), your Treo 700wx
smartphone will attempt to dial an
incomplete number because it is not on
the internal phone network.

If that is the case, use the abbreviated
dialing settings to automatically complete
shortened numbers. For example, if all the
phone numbers in your office begin with
1-655-22, followed by a five-digit extension,
set your smartphone to automatically enter

1-655-22 as the prefix before any five-digit
number. When you enter your colleague's
five-digit extension, your device
automatically dials 1-5655-22 plus the
five-digit extension. The complete number
is 1-555-222-1234.

1 Press Start [#) and select Settings.
2 On the Personal tab, select Phone Q

3 On the Dialing tab, select Abbreviated
Dialing, and then check the box that
corresponds to the number of digits you
want your smartphone to dial (3, 4, 5, 6,
or 7). Selecting the option adds a prefix
to numbers with the specified number
of digits.

74 | settings

G0 Y| == ok

Abbreviated Disling

[Joist [ | bsfars S-oigit rumbers
[Joiel [ | before d-digic numbers
befare 5-digit numbers
[Joiel [ | before é-digic numbers
[Joiel [ | before 7-digic numbers

4 Press OK (@] to finish.
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Selecting your data settings 3 Select the Services tab and set any of z
1 Press Start (&) and select Settings. the following options:
2 On the Personal tab, select Phone 0’. 2| eings m Y= bR
3 Select the Services tab and select Data Phone
Settings. To access sattings for a service, select
it from the following list.
‘ Data Settings
i g | Settings e
Phone Voice Privacy
To access settings for a service, select
it from the following list.
Services | Dialing | Securit:
Location Privacy _ .
Roaming
lvoice Privacy
Voice Privacy: Prevents overthe-air
Serviczs | Diaing | seaurky eavesdropping when this option is
turned on and this feature is available on
your wireless provider network.
4 Indicate whether you want to allow a .
) . . Location Privacy: Indicates whether
voice call to interrupt a data session. Y
text (SMS) messages will not be your smartphone broadcasts your
received on the device during any data location at all times or only during an
session emergency call.
5 Press OK (®] to return to Phone 4 Press OK (¢] to return to Phone
Settings. Settings.
6 Press OK /@) to finish. 5 Press OK (@] to finish.
Selecting your privacy settings TIp For quick access to the Location Privacy
) setting, tap the Location Privacy icon on your
1 Press Start (&) and select Settings. Today Screen.
2 On the Personal tab, select Phone Q.
PHONE SETTINGS (179)
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Controlling your
roaming experience

You can roam on other digital networks
where your wireless provider has
implemented roaming agreements with
other carriers.

When you roam outside your wireless
provider's network, the Roaming R icon
appears at the top of the screen. Additional
charges may apply if you use your Treo
700wx smartphone while roaming.

To learn more about roaming, contact your
wireless provider.

Feature availability

« You can make and receive calls while
roaming.

« Other features, such as call waiting and
voicemail, may be available depending
upon your roaming network.

« Data services may not be available
when you are roaming on partner
networks.

Setting roaming preferences

Use Roaming Preferences to set specific
options for using your phone while
roaming. For example, you can set an
option to be notified that you are roaming
before placing a call or making a data
connection, so that you are aware that you
might incur extra charges.

1 Press Start (&) and select Settings.

2 On the Personal tab, select Phone .

3 Select the Services tab, and then select
Roaming.

74 | Settings 0 Y| = R

Phone

To access settings for a service, select
it from the folowing list.

[Data Settings

Locatian Privact

[Woice Privacy

Clear Yoicemail Icon

Services | Dialing | Security

4 Select the Network Selection pick list
and select the networks with which you
want to allow your phone to make a
connection:

CONTROLLING YOUR ROAMING EXPERIENCE



Allow roaming enables your phone to
determine the best network—either
home or roaming—with which to
connect.

Home network only allows your phone

to connect only to your home networks.

Roaming networks only allows your
phone to connect to roaming networks
only.

7 g | settings

Raaming

Metwork selection:

wihien roaming, warn me:
Before outgoing calls.
Before data connections,

Check the boxes to enable either or
both of the following roaming warning
options:

Before outgoing calls: Causes an alert
to appear, warning you that you are on a
roaming network when you attempt to
dial an outgoing call.

CUSTOMIZING YOUR SMARTPHONE e

Before data connections: Prevents a
data connection while roaming. An alert
appears, warning you that you are on a
roaming network when you attempt to
make a data connection.

6 Press OK (@].

CHAPTER

TIP You can dismiss the warning and make the
data connection by selecting the Don’t show
this again. Always connect when roaming
box. You must then attempt to make a data
connection again.

System sound
settings

In certain situations, such as in meetings
and theaters, you need to turn off all
sounds on your smartphone. You can
immediately silence all sounds on your
smartphone, including phone ringtones,
Calendar notifications, and system sounds.
This does not mute the speaker during
phone calls.

SYSTEM SOUND SETTINGS @
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Setting the ringer switch

1 Slide the Ringer switch to Sound
Mode Off &g .

2 To hear all sounds again, slide the

Ringer switch to Sound Mode

On o).
When you slide the Ringer switch back to
the Sound Mode On position, it restores
the previous sound settings. For example,
if the smartphone ring volume is set to the
loudest setting and you slide the Ringer
switch to Sound Mode Off, you do not hear
the smartphone ring. When you move the
Ringer switch back to Sound Mode On, the
smartphone ring volume is still set to the
loudest setting.

Sound Sound
Mode On  Mode Off

TIP If the Ringer switch is set to Sound Mode
Off, the ringer setting overrides the sound
settings and all sounds are turned off,
including any music you may be playing.

DID YOU know? Your smartphone includes a
silent alarm that can vibrate even when the
ringer switch is set to Sound Mode Off.

Selecting Sounds & Notifications

1 Press Start [#) and select Settings.

2 On the Personal tab, select Sounds &
Notifications @):-.

3 On the Sounds tab, set any of the
following options:

Events: Turns sounds on/off for system
warnings and error messages.

74 | settings 0 V== B

Sounds & Notifications

Enable sounds for

[Events (warnings, systam events)|
Programs

Wotifications (alarms, reminders)
[] Sereen taps

[ Hardware buttons

Sounds | Notifications | Manage

SYSTEM SOUND SETTINGS



Programs: Turns sounds on/off in the
applications on your smartphone.

Notifications: Turns alarms and
reminders on/off in the applications on
your smartphone.

Screen taps: Turns sounds associated
with tapping the screen on/off, and sets
the volume level when this sound is
turned on.

Hardware buttons: Turns sounds
associated with pressing buttons on/off,
and sets the volume level when this
sound is turned on.

Select the Notifications tab and set
any of the following options:

Event: Specifies which action you want
to change the settings for. The
remaining options vary based on the
action you select.

CUSTOMIZING YOUR SMARTPHONE
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Sounds &

Event: h

[ Play sound I:l
(=]

D Wibrate when ringer switch off
[ wibrate when ringer switch on

soveaione [ ||
E

Play sound: Lets you turn the sound
on/off for the selected event. To select a
different sound, select the list to the
right of this setting and then select a
different sound. To preview the sound,
select Play @.

Repeat: Indicates whether the sound
plays more than once, if turned on.

Display message on screen: Indicates
whether a notification message appears
onscreen for the selected event.

Vibrate: Indicates whether your
smartphone vibrates to notify you about
the selected event.

5 Press OK (@].

CHAPTER
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TIP To record, preview, delete, and send
sounds on your smartphone, select the
Manage tab. To record a sound, press Menu
and select New Sound. To play a sound,
select it and press Play. To delete a sound,
highlight it and press Backspace. To send a
sound, highlight it, press Menu, and select
Send Sound.

Display and
appearance settings

Adjusting the brightness
1 Press Option @), and then press @.

2 Press Left 4 and Right P to adjust the
brightness.

3 Press OK (@].

Changing the text size
1 Press Start [#) and select Settings.

2 Select the System tab, and then select
Screen .

3 Select the Text Size tab.

Press Left 4 and Right P to adjust the
text size.

5 Press OK (@].

TIP If text looks rough around the edges, open
the Screen Settings screen and select the
Clear Type tab. Check the Enable Clear Type
box, and then press OK.

Setting display formats
1 Press Start (&) and select Settings.

74 | Settings 0 Y| = R

Regional Settings

Appearance samples

Positive numbers:  123,456,789.00
Fositive currency:  $123,456,789.00
Time: 6:07:52 PM

Short date: 7i3i05

Long date: Sunday, July 03, 2005

Reegion | Kumber ‘ Currency ‘ Time | Date

Select the System tab, and then select
Regional Settings 0

On the Region tab, select a region from
the list. The region selection sets the
default format settings.

(Optional) Select any of the following
tabs to customize the format settings:
Number: Sets the decimal symbol and
number of decimal places, the digit
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grouping symbol and group size, list
separators, negative number sign
symbol and format, leading zero display,
and measurement system (metric
versus U.S.).

Currency: Sets the currency symbol
and position, the decimal symbol and
position, the digit grouping symbol and
group size, and the negative number
format.

Time: Sets the time style, separators,
and AM and PM symbols.

Date: Sets the short date style,
separators, and long date style.

5 Press OK (@].

Aligning the screen

Occasionally, your screen can move out of
alignment, causing the wrong feature to be
activated when you tap the screen. If this
occurs, you need to align your smartphone
screen.

1 Press Start (&) and select Settings.

2 Select the System tab, and then select
Screen [B..

CUSTOMIZING YOUR SMARTPHONE

3 On the General tab, select Align
Screen.

4 Tap the screen where indicated.
5 Press OK (@].

Changing the system color scheme
1 Press Start (#) and select Settings.

2 Select the Personal tab, and then
select Today %

3 Select the Appearance tab, and then
select a theme in the list.

4 Press OK (@].

TIP You can also set the background for your

Today screen (see Selecting your Today
screen background).

Application settings

Arranging the Start menu

You can select which applications appear in
the top level of the Start menu. You can still
access the remaining applications by
selecting Programs from the Start menu
and then selecting the application’s icon.

CHAPTER
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7 | settings G0 Y = Bk

Menus

Checked items appear in the Stark menu.
Others appear in Programs.

[¥lEglcantacts

Press Start (#) and select Settings.
2 On the Personal tab, select Menus

3 Check the boxes next to the
applications you want to see in the
Start menu.

4 Press OK (@],

Reassigning buttons

Buttons Settings lets you select which
applications are associated with many of
the buttons and key combinations on your
smartphone.

7 | settings G0 V)= 6
Buttons
1. Select a button:
‘ Button | Assignment -
JStart <Start Merus 5]
[AOK <0KfClnses |
T I} I

2, Assign a program:

Program Buttons | Up/Down Cantrol

Press Start and select Settings.
On the Personal tab, select Buttons

On the Program Buttons tab, highlight
the button or key combination you want
to change in the Buttons list. The
hardware buttons are mapped to the
following button numbers:

Start (&) = Start Menu
OK (@] = OK/Close

Option @ + Phone/Send (&) =
Internet Explorer

Option @ + Start = Calendar
Option © + OK (®) = Task Manager
Side button = Windows Media

186) APPLICATION SETTINGS
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4 Select the Assign a program list, and
then select the application you want to
assign to the button or key combination
you selected in step 3.

5 Press OK (@].

Setting up voice commands

Voice commands enable you to use speech
to execute some commands on the Start
menu and the Programs menu.

1 Assign the Side button to Voice
Command. See Reassigning buttons
for details.

2 Press Start (&) and select Settings.

3 On the Personal tab, select Voice
Command.

Select Enable.

5 Select the items you want to enable. If
an item is highlighted and the Options
box is active, select the Options box to
choose the features you want enabled
for the highlighted item.

Using voice commands

BEFORE YOU BEGIN Set the Ringer
switch at the top of your smartphone to
Sound Mode On.

CUSTOMIZING YOUR SMARTPHONE e

1 Hold your device about nine inches
away from your mouth, and then press
and release the Voice Command
button. A tone plays and a microphone
icon appears at the top of your screen.

CHAPTER

2 In a clear voice say the command. For

example:

To access Help, say, “Help." After
Voice Command finishes speaking, a
microphone icon appears at the top of
your screen. Say your answer. For
example, say, “General” to access
general Help topics.

To access your Calendar, say, “Start
Calendar.”

To access your music, say, “Start
Windows Media." After Voice
Command finishes speaking, a
microphone icon appears at the top of
your screen. Say your answer.

TIP You can interrupt during a question by
pressing the Voice Command button. Once
the microphone icon is visible you may say
your answer.

APPLICATION SETTINGS @
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Setting input options
1 Press Start and select Settings.
2 On the Personal tab, select Input 2.

3 Select the Word Completion tab and
set any of the following options:

Suggest words when entering text:
Indicates whether word suggestions
appear as you enter text. You can also
specify how many letters you want to
enter before a suggestion appears, how
many suggestions you want to see, and
whether a space appears after you
insert a suggested word.

74 | settings

Input
Suggest: after entering letter(s)
Suggest word(s]

Add a space after suggested word

Replacs text as you bype

Input Method | Word Completion | Options

Replace text as you type: Indicates
whether the text you type adds to
existing text or replaces it. This is similar

to the Insert function on a computer
keyboard.

Select the Options tab and set any of
the following options:

Voice recording format: Sets the
format in which you save voice notes.

/4 | settings (0 Y| == B

Input

Voics recording Format:

Default 200m level For writing: 200% ~
Default z00m level for typing: 100% ~
Capitalize first letter of sentence

Serall upon reaching the last line

Input Method | Word Completion | Options

Default zoom level for writing: Sets
the initial size of text entered using
onscreen writing methods.

Default zoom level for typing: Sets
the initial size of text entered using the
keyboard.

Capitalize first letter of sentence:
Sets whether the first letter of a
sentence automatically appears in
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uppercase, without requiring you to
press one of the Shift keys.

Scroll upon reaching the last line:
Sets whether the display automatically
scrolls when you select the last line of
visible info.

5 Press OK (@].

TIP To enter a suggested word, simply tap it.

Locking your
smartphone and info

Your smartphone includes several features
that help you protect your smartphone
from inadvertent use and keep your
information private. The built-in security
software lets you use your smartphone for

dialing emergency calls, even if it is locked.

« Keyguard: Manually disables all buttons
and the screen’s touch-sensitive feature
to prevent accidental presses in your
briefcase or pocket.

CUSTOMIZING YOUR SMARTPHONE e

» Auto-Keyguard and touchscreen
lockout: Automatically enables
Keyguard after a period of inactivity and
lets you disable the screen’s
touch-sensitive feature during an active
call.

« Phone Lock: Requires you to enter a
lock code when making calls.

« System password lock: Requires a
password for displaying any information
on your smartphone.

TIP To avoid accidentally pressing onscreen
buttons while you're holding your smartphone
up to your ear to speak, you can disable the
screen's touch-sensitive feature during active
calls. When the screen’s touch-sensitive
feature is disabled, you must use the 5-way
navigator to access items on the screen.

Using Keyguard

By default, your keyboard locks so that you
don't accidentally press buttons or activate
screen items while your smartphone is in a
pocket or bag.

« To disable Keyguard, press Center @.

CHAPTER
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» To manually turn on Keyguard when
your smartphone screen is on, press
Option @ and Power/End (9.

Using Auto-Keyguard
and touchscreen
lockout

Auto-Keyguard lets you automatically lock
the keyboard after a period of inactivity.

1 Press Start and select Settings.
2 On the Personal tab, select Keyguard

3 Set any of the following options:

74 | Settings 0 V== B

Keyguard

Prass Option-+Power button ko manually
enable the keyguard.

Disable kouchscreen:
[ while an eallin Taday Screen

Auto-Keyguard: Sets the period of
inactivity that passes before the
keyboard automatically locks or before
the auto-keyguard feature is disabled.

Disable touchscreen: Indicates
whether the screen’s touch-sensitive
feature is enabled during a call.

4 Press OK (8],

TIP If you're using a headset or hands-free
device and your smartphone is in a pocket or
bag, you can manually turn on Keyguard
during a call to prevent accidental key
presses. Press Option and Power/End to
manually turn on Keyguard.

Using Phone Lock

You can lock your smartphone to prevent
unauthorized use of your account. When
your smartphone is locked, you must enter
a lock code to place calls, except for
emergency numbers.

1 Press Start and select Settings.
2 On the Personal tab, select Phone {,.
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3 Select the Security tab and set the
following options:

73| start [ ¢y @ 4:40

Phone - Currently Unlocked

Locking prevents all outgoing calls
except emergency calls,

Auto-lock:

Change Lock Code

Phone | Services | Dialing ‘ Security
E

Auto-lock: Sets whether your
smartphone locks automatically and
when this occurs.

Change Lock Code: Lets you assign or
change the lock code used to unlock
your smartphone. Your default lock code
is the last four digits of your phone
number. If you change the lock code,
select OK to accept your new code.

4 Press OK (@] to finish.

TIP When Phone Lock is on, you can unlock
your smartphone by going to the Today
screen, entering your lock code, and then
selecting Enter. You do not need to enter your
password to answer a call.

CUSTOMIZING YOUR SMARTPHONE

Using the system password lock

To protect your personal information, you
can lock the system so that you need to
enter your password to access any of your
information or use other features of

your smartphone.

IMPORTANT If you lock your system, you
must enter the exact password to unlock it.
If you enter an incorrect password, you are
given another chance. Each time an
incorrect password is entered, you are
given progressively longer time periods
between your chances to enter the
password. If you forget the password, you
need to perform a hard reset to resume
using your smartphone. Performing a hard
reset deletes all the entries in your
smartphone. However, you can restore all
previously synchronized info the next time
you sync (see Synchronizing contacts and
other info).

1 Press Start (%) and select Settings.
2 On the Personal tab, select Lock &% .

CHAPTER
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z 3 On the Password tab, check the 8 (Optional) Select the Hint tab and enter
Prompt if device unused for box to a hint to help you recall your password.
turn on the password feature. 9 Press OK (@)

74 | settings & V= R . . -
L Entering owner information
Password
= = 3o = You can enter personal information that you
ul—Mfmm jevice unuse - pereone) i
T o = - want to associate with your smartphone,
o such as your name, company name, and
cofim ] phone number. You can also indicate

whether you want this information to

passnord e appear when you turn on your smartphone.
If you lose your smartphone, this feature
can help the person who finds it return it to
4 Select the firstlist, and then select how  you.

long a period of inactivity must pass .
before you are prompted to enter a 1 Press Start and select Settings.

password to unlock the system. 2 On the Personal tab, select Owner
Information g

5 Select the Password type list, and then

select a format for your password.

6 Select Password, tap the onscreen Ouner Information
keyboard icon, and enter your Hame: [Micyne Spear
password. Then tap the onscreen C::j:sz ;’;:gée Soeant
keyboard icon. " |any city, ca

7 Select Confirm, tap the onscreen Telephone: |{931) 555-3563
keyboard icon, and enter the £-mal: [midyne@anyisp.com
password again. Then tap the onscreen Ident fication JiEoeZ |”°"5\

keyboard icon.
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3 On the Identification tab, enter any of
the contact information you want to
include.

4 Select the Notes tab and then enter any
additional text you want to include.

5 Select the Options tab and check the
boxes to indicate which info (if any) you
want to appear on the screen when you
turn on your smartphone.

6 Press OK (@].

TIP You can also display your Owner
Information on your Today screen. See
Selecting which items appear on your
Today screen for details.

System settings

Setting the date and time

Clock & Alarms Settings lets you set the
time zone, time, and date for your home
location and a location that you visit.

1 Press Start () and select Settings.

2 Select the System tab, and then select
Clock & Alarms (9.

3
4

CUSTOMIZING YOUR SMARTPHONE

On the Time tab, select Home.

Select the first list, and then select the
time zone for your home location.

74 | Settings 0 Y| = R
Clock & Alarms

(® Home

GMT-8 Pacific US ~
£:37:10 PM -
7] 32005 -

SEETTI N

Harms | Mare |

() visiting

Select the hour, and then press Up a

or Down ¥ to increase or decrease the
hour setting. Repeat this process for the
minutes, seconds, and AM/PM settings.

(Optional) Select Visiting and set the
info for a location that you visit often.

Press OK (@].

If prompted, select Yes to accept your
changes.

CHAPTER
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TIP By default your smartphone synchronizes
the date, time, and time zone with your
wireless provider network whenever your
phone is on and you are inside a coverage
area. You can disable this option in Clock &
Alarms Settings by selecting the More tab and
then unchecking the Enable local network
time box. If you want to keep your
smartphone date and time set for your
selected location, uncheck the Use network
time zone box.

TIP To set the display format for the date and
time, see Setting display formats.

Setting system alarms
System alarms let you set alarms that are

not associated with a task or appointment.
For example, you can use your smartphone

as an alarm clock when you travel, or set

alarms to remind you when it's time to take

medication or pick up the kids.

1 Press Start [#) and select Settings.

2 Select the System tab, and then select

Clock & Alarms (3.
3 Select the Alarms tab.

74 | Settings 0 Y| = R

Clock & Alarms
Rise and shine i
£:00 AN
[ <« Description = i
sElTwTFS €00 A
[ <« Description = i
sElTwTFS €00 A
Time | Alarms | More
Edit E

Check a box to turn on that alarm.

Select the description next to the box
you checked, and enter a description for
the alarm.

Select the days of the week you want
the alarm to go off. You can select
multiple days for each alarm.

Select the time you want the alarm to
go off, and then press OK [@].

Select i, check the boxes to select
how you want the alarm to go off, and
then press OK (@.

TIP To change the alarm sound, select the
alarm sound icon, select the Play Sound list,
and then select the alarm sound you want to
use.
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9 Press OK (@] to finish.

10 If prompted, select Yes to accept your
changes.

Managing identity certificates

Your smartphone may include preinstalled
certificates. Certificates are digital
documents that are used to authenticate
and exchange information on networks.
Certificates can be issued for a user, a
device, or a service.

1 Press Start (&) and select Settings.

2 Select the System tab, and then select
Certificates .

3 Select any of the following:

Personal: Displays certificates that
establish your identity when you log in
to a secured network, such as a
corporate network.

Root: Displays certificates that identify
the computers, such as servers, that
you connect to. These certificates help
prevent unauthorized users from
accessing your smartphone and
information.

4 Press OK (@] to finish.

CUSTOMIZING YOUR SMARTPHONE e
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TIP To delete a certificate, tap and hold the
certificate in the list, and then select Delete
from the shortcut menu.

Enabling error reporting

Error Reporting sends info that helps
diagnose application errors for devices
running Windows Mobile® software. When
an error is detected, a text file is created.
You can review the file and choose
whether you want it delivered to technical
support. The information is used by
programming groups at Microsoft for
quality control and is not used for tracking
individual users or installations for any
marketing purpose. The info that is
collected is technical info about the state of
your system when the error occurred. No
documents (or any info contained in them)
are intentionally sent with the report. To
ensure further security, the report is
transmitted by means of a secure
connection and is kept confidential and
anonymous in a limited-access database.

If your smartphone is connected to your
computer when you send the error report,
you are not billed for sending error

SYSTEM SETTINGS @
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reports—provided your computer is
connected to the Internet. If you use your

wireless provider network to send an error

report, data transfer charges apply.

1 Press Start and select Settings.

2 Select the System tab, and then select

Error Reporting @4

3 Select whether you want to enable or
disable error reporting.

4 Press OK (@] to finish.

TIP This errorreporting method meets the
privacy regulations of the European Union
(EU) as well as the Fair Information Practice
Principles of the Federal Trade Commission.
To view the Fair Information Practice
Principles, visit the Federal Trade Commission
website at www.ftc.gov/reports/privacy3/
fairinfo.htm.

Setting up a GPS device

If you purchased an optional Global
Positioning System (GPS) receiver, your
smartphone can show your exact location
on a map.

1 Press Start and select Settings.

Select the System tab, and then select
GPS @.

On the Programs tab, select the GPS
program port list, and then select the
port for applications to use to access
GPS info. This port must also be
selected in your GPS application's
configuration settings.

Select the Hardware tab.

Select the GPS hardware port list, and
then select the port to which your GPS
receiver is connected. This must be a
different port from the one you set in
step 3 as your program port. To connect
to the GPS device using Bluetooth
wireless technology, you must first set
up a partnership between the two
devices (see Setting up a Bluetooth
connection.)

Select the Access tab and check the
Manage GPS automatically box. This
setting lets more than one application
simultaneously access your GPS info.

7 Press OK (@] to finish.
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Viewing memory usage

1 Press Start (&) and select Settings.

2 Select the System tab, and then select
Memory .

3 Select any of the following tabs:
Main: Displays the amount of memory
assigned to your applications and info,
as well as the amount of memory in use
versus the available memory.

Storage Card: Displays the amount of
memory available on an expansion card

CUSTOMIZING YOUR SMARTPHONE

that is inserted in the expansion slot on
your smartphone.

Running Programs: Lists the
applications that are in use on your
smartphone. To switch to an application,
highlight it and select Activate. To close
an application, highlight it and select
Stop. To close all open applications,
select Stop All.

4 Press OK (@] to finish.

74 | settings [ V)= Gk [l /| settings [ V)| == Gk [l /| settings (0 Y| == B

Memory Memory Memary
Storage Program Tokal storage card memory:  30.53 MB Running Programs List:
Total: 61.72 ME Total:  57.15ME Tnuse: 13.40MB  Free: 17.13MB Calendar

Inuss:  3.57MB Inuse: 14.25MB ActiveSync
Free: Sa.0SME  Free: szopnp | |EENNN ]

‘Storage Card

| I [stopai |
Main | Storage Card | Running Frograms ‘ Main | Storage Card | Running Frograms ‘ Main ‘ Storage Card ‘ Running Programs
Find large files using storage memary. Find large files using storage memary. Find large files using storage memory,
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T Viewing and optimizing power settings
5 _
1 Press Start and select Settings. Power
2 Select the System tab, and then select On battery power:
Power {.
3 On the Battery tab, view the power On external pawer:
- : ' Turn off device ot [5rimies -
remaining in your battery. used for
£2 | settings Battery | wireless | Advanced |
Power i ]
Main battery: Lilon
Battery power remaining: o
o I | 10 Press OK to finish.
TIP To conserve additional battery power,
adjust the display backlight setting. Press
sattery [T T Start and select Settings. Select the System
tab, and then select Backlight. On the
Battery Power tab, set whether the display
backlight turns off automatically after a period
4 Select the Advanced tab and set sl Y P
of inactivity.
whether your smartphone turns off
automatically after a specified period of
inactivity. You can assign various
intervals for battery power and external
power.
1 SYSTEM SETTINGS
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Turning Wireless Services On/Off
1 Press Start and select Settings.

2 Select the Connections tab, and then
select Wireless Manager.

74 | Wireless Manager

3 Select All to turn all wireless features
on/off.

4 Press OK (@] to finish.

You can also turn wireless services on and
off by tapping the signal-strength F] icon
at the top of the screen and then selecting
Wireless Manager.

NOTE The Wi-Fi selection appears only if a
Wi-Fi card is installed in your smartphone.
You must purchase and install a third-party
Wi-Fi card to use this feature.

CUSTOMIZING YOUR SMARTPHONE ‘E'

TIP To change the settings for one of the
displayed wireless features, press Menu and
select the wireless feature you want to
change.

Connection settings

Setting up a Wi-Fi® connection

Many corporate organizations and public
environments, such as coffee shops,
airports, and libraries, offer access to a
Wi-Fi network. A Wi-Fi network is a
wireless local area network (WLAN) based
on the 802.11 standard. When you
purchase an optional Wi-Fi SDIO card, you
can use your smartphone’s built-in
software to set up a Wi-Fi connection and
quickly connect your smartphone to a Wi-Fi
network when you're within range of an
accessible Wi-Fi network.

Some Wi-Fi networks are known as open
networks because they broadcast their
name (SSID) and do not require a
password. Other Wi-Fi networks broadcast
their name but do require a password.

CHAPTER
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want to connect to.

NOTE See Regulatory Information for

Networks that do not broadcast their name
are known as closed networks. Follow the
instructions for the type of network you

additional guidance on using a Wi-Fi card
with your Treo 700wx smartphone.

IMPORTANT Depending on where you are
on a network and certain coverage
conditions, you might experience
interruptions with your phone operation

while using a Wi-Fi card. Palm

recommends that you turn off the phone
radio when using any Wi-Fi card or remove
the Wi-Fi card when not in use to ensure
that you can always make and receive
phone calls. For EMERGENCY calls, always
remove the card from your smartphone to

ensure optimal connectivity.

TIP Turning off the Bluetooth® feature may
improve your Wi-Fi card performance. To turn
the Bluetooth feature off, go to your Today
screen, tap the Bluetooth icon, and then
uncheck the Turn on Bluetooth box.

key TERM Wi-Fi access point (also called a
hotspot) A network device with an antenna
that provides wireless connections to a larger
network.

key TERM SSID The name that identifies a
Wi-Fi network. If a network does not
broadcast its SSID, you must get the SSID
from the system administrator in order to
connect to the network.

Connecting to a network that broadcasts
its name

Wi-Fi networks in public places often
broadcast their network name. Your
smartphone automatically attempts to
detect some network settings, so you can
connect to this type of network with
minimal configuration.

1 Wake up your smartphone’s screen (see
Waking up the screen and turning it off).

2 Insert the Wi-Fi card into the expansion
slot (see Removing and inserting
expansion cards).
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3 If the Multiple Networks Detected
dialog box appears, select the network
you want to connect to.

4 \When the New Network Detected
dialog box appears, select the type of
network you want to connect to.

5 Press Connect ) (left action key) to
connect to the network.

6 If prompted, enter the password
provided by the system administrator.

DID YOU KNOW? You can conserve battery
power by removing the Wi-Fi card or turning
off a Wi-Fi connection when you are not
planning to use it for an extended period.

TIP The wired equivalent privacy (WEP)
encryption method is enabled by default and
may interfere with your ability to connect to a
network that broadcasts its name. See
Connecting to a closed network to learn how
to enable or disable WEP encryption.

Connecting to a closed network

Since closed networks have additional
security features, your smartphone cannot
detect the network’s settings; you must
obtain the settings from the system
administrator and enter the settings

CUSTOMIZING YOUR SMARTPHONE

manually. You can also use these steps to
manually create a connection with an open
network.

1

o O A~ W

Wake up your smartphone's screen (see
Waking up the screen and turning it off),
and then insert the Wi-Fi card into the
expansion slot (see Removing and
inserting expansion cards).

Tap Wi-Fi ] in the title bar.

74 | settings R

Configure Wireless Network [7)
The Internet -

[ This is a device-to-devic (ad-hac)
connection

Connects to:

General [ Ketwork Key | 802.1x

Select the Settings link.

Select Network Cards [@% .

Select Add New.

On the General tab, set the following:

Network name: Specifies the SSID
provided by the system administrator.
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Connects to: Specifies whether this
connection connects to the Internet or
to Work. You may need to select Work
to access a corporate intranet.

This is a device-to-device (adhoc)
connection: Indicates whether you're
connecting to another device or to an
access point (network).

Select the Network Key tab, and then
set the following:

Authentication: Sets the method used
to identify devices that connect to the
network.

74 | Settings

Configure Network Authentication )

Authentication:

Data Encryption:  [yWEP -
[ [he key is automatically provided

Key index:

Hetwork Key | 802.1x
B

« Open: Indicates that the network
uses open authentication.

« Shared: Indicates that the network
uses shared authentication.

« WPA: Indicates that the network is a
WPA network that uses 802.1x
protocols.

« WPA-PSK: Indicates that the network
is a WPA network that requires a
pre-shared key (password).

Data Encryption: Sets the encryption
method. The options in this list vary
based on your Authentication setting.

« Disabled: Turns data encryption off.

« WEP: Turns on the wired equivalent
privacy encryption method.

« TKIP: Turns on the temporal key
integrity protocol encryption method.
This method is often used to encrypt
WPA and WPA-PSK connections.

The key is automatically provided:
Indicates whether you need to specify
the Network key and Key index provided
by your system administrator, or
whether the network provides this
information. The availability of these
options varies based on your
Authentication and Data Encryption
settings.
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8 Select the 802.1x tab, and then set the
following if available (the settings vary
based on your settings on the other
tabs and on the supported features of
your Wi-Fi SDIO card):

74 | Settings 1 = B

Configure Network Authentication i)

|luse IEEE 802, 1x netwark access cantrol

EAP type: [PEAP -

General | Network Key ‘ 802.1x ‘

Use IEEE 802.1x network access
control: Lets you set these parameters
if required by the network.

EAP type: Specifies the extensible
authentication protocol type.

9 Press OK (@].

Selecting a Wi-Fi network

After you set up a Wi-Fi connection, it's
easy to connect to that network. If you

have access to multiple Wi-Fi networks,

CUSTOMIZING YOUR SMARTPHONE e

you can select which network you want to
connect to.

1

g A WN

Wake up your smartphone's screen (see
Waking up the screen and turning it off),
and then insert the Wi-Fi card into the
expansion slot (see Removing and
inserting expansion cards).

Tap Wi-Fi | in the title bar.

Select the Settings link.

Select Network Cards Bf

Highlight the network you want to
connect to.

Press and hold Center @ to open the
shortcut menu, and then select
Connect.

TIP Insert the Wi-Fi card into your smartphone
to automatically connect to the Wi-Fi network
you connected to most recently if it is
available.

pID You know? \When you are browsing the
Internet or performing another Wi-Fi activity,
you can answer a call without interrupting that
activity.
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Managing ISP settings

Your smartphone is already set up to
connect to the Internet using a high-speed
data connection on your wireless provider
network. To connect to the Internet, simply
start Internet Explorer Mobile.

For special situations, such as connecting
to your Internet service provider (ISP) or a
remote access server (RAS), you can set
up another connection. Before you begin,
obtain the following information from your
ISP or system administrator:

« ISP server phone number or access
point

« Username

» Password

Press Start and select Settings.

2 Select the Connections tab, and then
select Connections #3s.

3 On the Tasks tab, select Manage
existing connections.

4 Select the Modem tab.

5 Highlight the connection you want to
view or change, and then select Edit, or
to create a new connection, select
New.

6 Follow the onscreen instructions to edit
or create the connection.

Connecting to a VPN

If you want to use your smartphone to
access your corporate email account or
other files on your corporate server, you
may need to set up a virtual private
network (VPN). A VPN enables you to log in
to your corporate server through the
company'’s firewall (security layer).

You need to set up a VPN to access a
corporate server in either of the following
situations:

« Your company’s wireless local area
network (LAN) is outside the firewall.

» Your company'’s wireless LAN is inside
the firewall, but you are accessing the
network from outside the firewall (for
example, from a public location or at
home).

CONNECTION SETTINGS



Check with your company's system
administrator to see if a VPN is required for
accessing the corporate network. If you
need a VPN, you must purchase and install
a third-party VPN client to use this feature.

Before you begin setting up a VPN, ask
your system administrator for the following
information:

« Your username and password

« Your server's domain name

« Your server's TCP/IP settings

« Your server's host name or IP address

1 Install your third-party VPN client (see
Installing applications).

2 Press Start (&) and select Settings.

3 Select the Connections tab, and then
select Connections §%.

4 On the Tasks tab, select Add a new
VPN server connection.

5 Follow the onscreen instructions for
entering the settings provided by your
corporate system administrator.

CUSTOMIZING YOUR SMARTPHONE

TIP To manually start a data connection on
your wireless provider network or another
network, go to Connections Settings. On the
Tasks tab, select Manage existing
connections. Tap and hold the connection
you want to start, and then select Connect
from the shortcut menu.

VPN servers may require that you install
specific VPN software (sold separately) on
your smartphone. Go to www.palm.com for
more information.

Setting up a proxy server

1 Press Start (&) and select Settings.

2 Select the Connections tab, and then
select Connections ie.

3 On the Tasks tab, select Set up my
proxy server.

4 Check both boxes near the top of the
screen.

5 Select Proxy server and enter the proxy
server name.

6 Press OK (@].

TIP To change settings such as the port
number, proxy server type, or credentials,
select Advanced.
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Ending a data connection

If your service plan includes
minutes-of-use fees for data connections,
you can reduce costs by ending the data
connection when you've finished browsing
the web.

Usgthe stylus to tap the data arrows P
or #* on the title bar.

Select Disconnect from the shortcut
menu.
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Troubleshooting

Sometimes you need a helping hand. The topics in this chapter
provide additional information for resolving common problems,
transferring your info from another device, or improving the
performance of your smartphone. You can also visit
www.palm.com/treo700wx-support for even more up-to-date
information.

Benefits
« Resolve common problems
« Transfer info from another device

« Improve the battery and memory
performance of your smartphone

CHAPTER
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Transferring info from
another device

TROUBLESHOOTING @

Trouble installing the
desktop software?

For information on transferring your info
from a previous Windows Mobile® device
or from a Palm OS® device to your new
Palm® Treo™ 700wx smartphone, visit
www.palm.com/treo700wx-support.

IMPORTANT To prevent your smartphone
from malfunctioning, do not use a backup
utility to transfer your info from another
device to your new smartphone. In
addition, do not use a backup utility to back
up and restore your info if you update your
device's operating system.

DID YOU KNow? You can purchase a third-party
application that lets you run Palm OS®
applications on your Treo 700wx smartphone.
DID YOU KNow? |f you have questions about
Windows Mobile, you can go to the Microsoft
Windows Mobile website. Search for Palm
devices or Pocket PCs for information.

The Getting Started CD installs the
software and drivers that let you
synchronize with Microsoft® Office
Outlook® for Windows. You can also use
the CD to install the Outlook software if it
is not already on your device. You should
install and open Outlook before you install
or use the ActiveSync Software.

If you want to synchronize with a different
personal information manager (PIM), you
must install a third-party solution. Contact
the PIM's author or vendor to learn
whether software is available for your Treo
700wx smartphone.

1 Shut down your computer, and then
turn it on again.

2 Onyour computer, click Start > Control
Panel > Add or Remove Programs.

3 Remove Microsoft ActiveSync if it is on
your computer.
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Quit any active applications, including
virus scanners and Internet security
applications.

Make sure you're installing the version
of the software that came with your

smartphone on the Getting Started CD.

Other versions may not work with this
smartphone.

Make sure your computer profile
includes administrator rights to install
software. In large organizations, these
are usually granted by the system
administrator.

Resetting your
smartphone

Use one hand to press the battery
door release, and use the other hand to
slide the battery door downward to
remove it from your smartphone.

Use the stylus tip to gently press the
reset button on the back of your
smartphone.

Wait for the progress bar on the Treo
logo screen to fill before continuing to
use your smartphone.

TIP You can also do a soft reset by unplugging
your smartphone from a power source (if
connected) and then removing the battery and
reinserting it.

pID YOu know? |f the phone or Bluetooth
signals were on before a reset, these signals
automatically turn on after the reset.

Performing a soft reset

Performing a soft reset is similar to
restarting a computer. If your smartphone
is not responding or you have trouble
synchronizing with your computer, a soft
reset may help.
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Performing a hard reset

A hard reset erases all personal
information, such as appointments,
contacts, and tasks, as well as programs
you have added, such as third-party
software on your smartphone. Never do a
hard reset without first trying a soft reset.
You can restore previously synchronized
information the next time you sync.

IMPORTANT Synchronize to restore your
Outlook data, such as Outlook email,
Calendar, Contacts, Notes, and Tasks. You
can use a backup and restore solution

TROUBLESHOOTING @
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(make sure it's an application that's
approved by Palm) to restore
configurations and preferences such as
speed-dial buttons, SMS entries, call log
information, and personal settings.

A hard reset can tell you whether a
problem stems from your smartphone or
from an application installed on it. If you do
not experience the problem after you
perform a hard reset, the problem may be
related to software you installed. See
Third-party applications for suggestions
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about diagnosing third-party software

issues.

1

Use one hand to press the battery
door release, and use the other hand to
slide the battery door downward to
remove it from your smartphone.

If the screen is off, press Power/End
(@) to wake up the screen.

While pressing and holding Power/End
@, use the tip of the stylus to gently
press and hold the reset button on the
back of your smartphone.

Continue pressing and holding both
buttons until the “Erase all data?”
prompt appears.

Press Up a to confirm the hard reset.

Wait for the progress bar on the Treo
logo screen to fill before continuing to
use your smartphone.

(Optional) Sync your smartphone with
your computer to restore your
previously synchronized info. Connect
your smartphone to your computer,
press Menu C_— (right action key),
and then select Programs >
ActiveSync > Sync. If you use a backup
utility, you may also need to restore a

backup to recover additional info and
settings.

TIP Some third-party applications do not
create a backup on your computer when you
synchronize. If you do a hard reset, you may
lose info in these applications and you need to
reinstall the application on your smartphone
after the hard reset. Please contact the
developer to find out if your info is backed up
during synchronization.

pIb You know? \When you synchronize after a
hard reset, the source folder in My
Documents changes from Treo My
Documents to WM_your name.

Replacing the battery

Your smartphone comes with a replaceable
battery. Be sure to use a replacement
battery from Palm that is compatible with
Palm Treo 700wx smartphones.

1 Press Power/End (@ to turn off the
screen.

2 Use one hand to press the battery
door release and use the other hand to
slide the battery door downward to
remove it from your smartphone.
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3 Place a finger in the notch between the 6 Wait for the screen to turn on, and then z
stylus and the battery and lift the enable the network time or set the date
battery up at a 45 degree angle. and time when prompted.

4 Align the battery contacts with the

phone contacts inside the battery TIP Be sure to dispose of your old battery in an
compartment evironmentally responsible and legal way. In

) some areas, disposal in household or
5 Insert the battery into the compartment business trash is prohibited.

at a 45 degree angle, pressing it into
place. Slide the battery door onto the
back of the smartphone until it clicks
into place.

DID YOU KNOow? Your smartphone stores all
your info even when you remove the battery.

Battery door
release
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Performance

The applications are running slower than
usual
1 Press Start [#) and select Settings.
2 Select System, and then select
Memory .
3 Select Running Programs.
Select Stop All to close all your open
applications.
5 Press OK [@].
If the previous steps don't fix the problem,
try doing a soft reset (see Performing a soft
reset). If the problem persists, follow these
steps to turn off the Voice Command
setting, if it is enabled:

1 Press Start [#) and select Settings.

2 Select the Personal tab, and then
select Voice Command 3’7’.

3 Uncheck the Enabled box.
Press OK [@].

TIP Be sure that third-party applications are
compatible with Windows Mobile version 5.2
or later. Applications written for earlier
versions can have performance problems. If
you can try a free version of the software
before purchasing it, you can test it first to
make sure it works properly.

Battery performance

To extend the battery performance of your
smartphone, turn off the applications and
features that run in the background if they
are not being used.

Turn off Bluetooth wireless technology
1 Go to your Today screen, and then tap
Bluetooth ().

2 Uncheck the Turn on Bluetooth box to
turn off your smartphone’s Bluetooth
feature.

3 Press OK (@].
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Turn off the Voice Command setting
1 Press Start (&) and select Settings.

2 Selectthe Personall_tiab and then select
Voice Command 35’.

3 Uncheck the Enabled box.
4 Press OK (@].

Reduce the amount of time the backlight
stays on when not in use

1 Press Start (&) and select Settings.

2 Select the System tab, and then select
Backlight.

3 Set the time interval on the Battery
Power tab and on the External Power
tab.

4 Press OK (©].

Adjust the screen brightness
1 Press Option @), and then press @.

2 Press Left 4 and Right ) to adjust the
brightness.

3 Press OK (@].

Adjust the automatic power off setting
1 Press Start (&) and select Settings.
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2 Select the System tab, and then select
Power {k

3 Select the Advanced tab and set
whether your smartphone turns off
automatically after a specified period of
inactivity while on battery power.

4 Press OK (@] to finish.

Screen

The screen appears blank

1 When the time period specified in
Backlight Settings expires, the screen
dims; one minute later, the screen
automatically turns off. Press any key
except Power/End to wake up the
screen. Pressing Power/End hangs up
the call.

2 Look closely at the screen. If you can
see a dim image, try adjusting the
screen brightness (see Adjusting the_
brightness).

3 If that doesn’t work, perform a soft
reset (see Performing a soft reset).
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If that doesn't work, connect your
smartphone to the AC charger (see
Charging the battery) and perform a soft
reset again.

If that doesn’t work, perform a hard
reset (see Performing a hard reset).

The screen doesn’t respond accurately to
taps or it activates wrong features

1

Make sure there is no debris trapped
under the edges of the screen.

Press Start (%) and select Settings.

Select the System tab, and then select
Screen .

On the General tab, select Align
Screen.

Follow the onscreen instructions for
aligning the screen.

Press OK (@].

TIP To find carrying cases that protect the
screen, and other useful accessories, visit
www.palm.com

TIP Make sure that the third-party applications
support 240x240 screen resolution. Some
older applications have screen-size limits.

Network connection

Signal strength is weak

1

If you're standing, move about 10 feet in
any direction.

If you're in a building, move near a
window. Open any metal blinds.

If you're in a building, move outdoors or
to a more open area.

If you're outdoors, move away from
large buildings, trees, or electrical wires.

If you're in a vehicle, move your
smartphone so that it's level
with a window.

TIP Become familiar with low coverage areas
where you live, commute, work, and play, so
you know when to expect signal strength
issues.

My smartphone won’t connect to the
wireless network

1 Try the preceding suggestions for weak

signals.
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2 Turn off your smartphone and turn it on
again (see Turning your phone on and
off).

3 Perform a soft reset (see Performing a
soft reset).

4 Depending on where you are on a
network and certain coverage
conditions, you might experience
interruptions with your phone operation
while using a Wi-Fi card. Palm
recommends that you turn off the
phone radio when using any Wi-Fi card
or remove the Wi-Fi card when not in
use to ensure that you can always make
and receive phone calls. For
EMERGENCY calls, always remove the
card from your smartphone to ensure
optimal connectivity.

My smartphone seems to turn off by itself

If a system error and reset occur, the
phone automatically turns on if it was on
before the reset. However, if your
smartphone can’t determine if your phone
was on before the reset, it does not
automatically turn on the phone (see
Turning your phone on and off).

TROUBLESHOOTING @

I can’t tell if data services are available

The following icons appear in the title bar
to indicate whether data services are
available:

key TERM 1XRTT (Single carrier [1x] radio
transmission technology): A wireless
technology that can provide fast data transfer
and Internet access with average speeds of
60-80Kbps and bursts up to 144Kbps.

key TERM EVDO (Evolution Data Optimized): A
wireless broadband technology that is
designed for very high-speed data transfer
with average download speeds of
400-700Kbps, capable of reaching speeds up
to 2Mbps, and upload speeds up to 156Kbps.

Ed or EEd The EVDO or 1xRTT wireless
network is within range. You
can make or receive calls or

open a data connection.

E¥s or ™

& &

EVDO or 1xRTT wireless
network, but you are not

actively transmitting data. You
can still make or receive calls.

=% Your phone is connected to an
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Your phone is on and an EVDO
or 1xRTT data connection is
active. If an EVDO data
connection is active, you can
still make or receive calls.
When you make or receive a
call, the data transmission is
automatically interrupted. If a
1xRTT data connection is
active, you can still make calls,
but you cannot receive calls
(incoming calls go to
voicemail). When you make a
call the data transmission is
automatically interrupted.

Your smartphone is connected
to a computer or network that
is providing a data connection.

A data connection is not
available or the phone is
turned off (the wireless
connection is off).

My smartphone won’t connect to the
Internet

Your smartphone supports 1xRTT or EVDO
wireless data networks. To connect to the
Internet, you must subscribe to data
services with your wireless provider.

Contact your wireless provider to verify
that your subscription plan includes data
services and that these services have
been correctly activated. Your wireless
provider should also be able to tell you if
there are any outages in your location.

Press and hold Power/End (@ to turn
off your phone. Then press and hold the
same button to turn it back on again.

Perform a soft reset (see Performing a
soft reset).

Confirm that data services are correctly
configured on your smartphone:

Press Start (%) and select Settings.

Select the Connections tab, and then
select Connections 8%

On the Tasks tab, select Manage
existing connections.
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If Broadband Access appears in the list,
press OK (®]. If not, contact your
wireless provider for assistance.

I can’t send or receive text messages

Make sure your phone is on (see
Turning your phone on and off).

Contact your wireless provider to verify
that your plan includes messaging
services, that these services have been
correctly activated, and that they are
available at your location (your wireless
provider should be able to tell you if
messaging services have been
experiencing transmission delays).

If possible, contact the recipient of the
message, and make sure the receiving
device can handle the type of message
you're sending.

If a text message arrives but does not
display a notification, perform a soft
reset (see Performing a soft reset).
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| can’t make or receive calls using a
hands-free device with Bluetooth®
wireless technology

Verify all of the following:

The Turn on Bluetooth box is checked in
Bluetooth Settings.

Your Bluetooth device is charged and
turned on.

Your smartphone is within range of the
hands-free device. Bluetooth range is
up to 30 feet in optimum environmental
conditions, which include the absence
of the following: obstacles, radio
interference from nearby electronic
equipment, and other factors.

The Bluetooth Settings screen is closed.

You are away from other devices using
the 2.4 GHz radio frequency, such as
cordless phones, microwaves, and
WI-Fi® equipment. If this is impossible,
move the phone closer to the
hands-free device.

The device specifications are
compatible with your smartphone.
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| lost the connection between my
smartphone and my Bluetooth headset

1 Press Start (%), and then select

Settings.

f. | File Explorer Y o X
[ My Documents - Name
[ Business

[C3My Music

[CiMy Pictures

(T Personal

[ Templates

[5]camera 11/22/05 1508
Extend Your H.. 11/22/05 281K
[_Power Tips 11/22/05 215K

up 1] Menu

Select the Connections tab, and then
select Bluetooth.

Select the Devices tab.
Select your headset name from the list.

In Partnership Settings, make sure the
Hands Free option box is checked.

Select Save.
Highlight the headset name.

Press and hold Center @ to open the
shortcut menu, and then select Set as
Hands-Free.

9 Test your headset by making or
receiving a call.

If the headset still doesn't work, delete the
existing partnership and create a new one.
To delete the partnership:

1 Press Start (&), and then select
Settings.

2 Select the Connections tab, and then
select Bluetooth.

3 Select the Devices tab.
Highlight the headset device name.

5 Press and hold Center @ to open the
shortcut menu, and then select Delete.

6 Create a new partnership (see Setting
up a Bluetooth connection.)

Synchronization
(ActiveSync’
software)

Synchronization lets you back up the
information on your smartphone onto your
computer. If you ever need to perform a
hard reset or otherwise erase all your

SYNCHRONIZATION (ACTIVESYNC® SOFTWARE)
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information on your smartphone, you can synchronization is successful, you do not
synchronize your smartphone with your need to complete the remaining steps.
computer to restore the info. To make sure
you always have an up-to-date backup of
your info, synchronize frequently.

CHAPTER

Verify that the USB sync cable is
securely connected at all points (see
Synchronizing contacts and other info).
Before you attempt to synchronize, make 2 | ook for the ActiveSync 4% icon at the

sure you've installed the desktop ‘ top of your smartphone’s screen and
synchronization software from the Getting the ActiveSync @ icon in the taskbar

Started CD. on your computer to make sure the
ActiveSync software is running on your
DID YOU KNOW? You can go to the Windows computer.
R gl fio (eI el iie i 3 Double-click the ActiveSync @ icon in

www.windowsmobile.com.

your taskbar. From the File menu,
select Connection Settings. Make
sure the Allow USB connections box
is checked, and then click Connect.

DID YOU KNOow? A common cause of sync
problems is the presence of protective
software, such as VPNs or firewalls, on your
computer or network.

TIP If you are synchronizing to an Exchange 4 Perform a soft reset (see Performinga.

Server and you're unable to change your lock soft reset).
settings, check with your system 5 Restart your computer and make sure
administrator to find out if a system wide ActiveSync is running.

locking policy is in place. . ,
g porey P 6 If problems persist and you're

synchronizing through a USB hub, try
connecting the sync cable to a different
USB port or directly to your computer's
As you complete the following steps, built-in USB port.

synchronize after each step. If the 7

ActiveSync Desktop does not respond to
sync attempt

If you're already synchronizing through a
built-in USB port on the front of your
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computer, move the sync cable to a
USB port on the back of your computer
(if your computer has USB ports in both
places).

Uninstall the desktop software that
came with your smartphone, and then
insert the Getting Started CD that came
with your smartphone and repeat the
installation process.

Switch to the USB serial synchronization
method. Some firewall software does
not allow the default USB
synchronization model (RNDIS) to
operate properly. If this is the case,
switching to a USB serial
synchronization method will allow
ActiveSync to work properly.

« Press Start (&) and select Programs.

« Select UsbSwitch 1.

« Press OK [@] to dismiss the
confirmation message.

10 Verify with your computer hardware

vendor that your operating system
supports your internal USB controller.

Synchronization finishes but info doesn’t
appear where it should

With the included software, your
smartphone can synchronize with the
root folders of Contacts, Calendar,
Tasks, and Notes. If you want to
synchronize with a global Exchange
Address Book, you must copy the
addresses to your local Contacts list in
Microsoft Office Outlook (right-click the
addresses and select Add to Personal
Address Book).

Microsoft Office Outlook subfolders and
public folders are not accessible with
the included software. You may want to
use a third-party solution instead.

If you're trying to sync offline, be sure
to set your Microsoft Office Outlook
Calendar, Contacts, Notes, and Tasks to
be available offline.

If you're still having problems, try the
following:

« Make sure you're synchronizing with
the intended desktop personal
information manager (PIM). The
Getting Started CD lets you
synchronize with Microsoft Office
Outlook for Windows. If you use a

SYNCHRONIZATION (ACTIVESYNC® SOFTWARE)



different PIM, you need to install
third-party software to synchronize.
For more information consult the
company that makes the PIM.

Open ActiveSync on your computer,
and make sure the necessary
synchronization settings are set to
synchronize the files.

Uninstall the ActiveSync software,
reboot your computer, and then insert
the Getting Started CD that came
with your smartphone and repeat the
installation process.

Synchronization starts but doesn’t finish

» Make sure that you installed the
desktop software that came with
your smartphone. If you're not sure
whether this software is installed,
reinstall it.

« |f you're trying to sync offline, be sure
to set your Microsoft Office Outlook
Calendar, Contacts, Notes, and Tasks to
be available offline.

My media files won’t sync

1 Make sure you have Windows Media
Player 10 installed on your computer.

TROUBLESHOOTING @

2 Reinstall your synchronization software
from the Getting Started CD that came
with your smartphone. Media file
synchronization fails if you installed the
synchronization software before you
installed Windows Media Player 10.

My appointments show up in the wrong
time slot after | sync

1 Make sure that you installed the
desktop software that came with
your smartphone. If you're not sure
whether this software is installed,
reinstall it.

2 Open Microsoft Office Outlook and
correct the wrong entries.

3 Manually enter any information you've
added to your smartphone since the last
time you synchronized.

4 Synchronize your phone and your
computer.

5 Disable local network time. By default
your smartphone synchronizes the date,
time, and time zone with your wireless
provider network whenever your phone
is on and you are inside a coverage area.
You can disable this option in Clock &
Alarms Settings by selecting More and

CHAPTER
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then unchecking the Enable local
network time box. See Setting the date
and time for more information.

You should now be able to assign time
zones to your events without encountering
this problem.

My scheduled sync doesn’t work

By default, a scheduled sync does not work
while you are roaming. This is to prevent
roaming charges on your account. If
roaming charges are not a concern, follow
these steps to continue your sync schedule
while roaming:

1 Press Start and select Programs.

2 Select ActiveSync @ .

3 Press Menu = (right action key) and
select Schedule.

4 Check the Use above setting when
roaming box.

5 Press OK (@].

An alert tells me that ActiveSync
encountered a problem on the server
There is a temporary problem with the

server or the server may be temporarily
overloaded. Try again later, and if the

problem persists, contact your system
administrator.

An alert tells me that there is not enough
free memory to sync my info

ActiveSync ran out of storage space. Try
the following:

1 Go to Memory Settings and close all
running programs. See Closing
applications for details.

2 If the problem persists, see Making
room on your smartphone for
suggestions of other ways to free up
space on your smartphone.

An alert tells me that the server could not
be reached

Your smartphone had to wait too long to
connect to the Exchange Server. The
connection may have been lost, the server
may be temporarily overloaded, or the
server may have encountered an internal
error. Check your Exchange Server name
and proxy server settings (see
Synchronizing with an Exchange Server),
and try again later.
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An alert tells me that ActiveSync
encountered a problem with [item type]
[item name]

There is an error in synchronizing a single
item. You can correct this error only by
removing the item that caused the error. If
you sync again to see if the error persists,
be aware that items causing this type of
error are skipped and do not show up
again.

An alert tells me that my account
information could not be detected

When you set up the Exchange Server
sync options, the credentials page was left
blank. Correct the credentials (see
Synchronizing with an Exchange Server), or
set up your smartphone to sync only with a
computer, and try to sync again.

An alert tells me the device timed out
while waiting for credentials

The Exchange Server credentials screen
was left open too long. Re-enter the
Exchange Server credentials, and try to
sync again.

TROUBLESHOOTING @

My Today screen settings are not restored
after a hard reset

CHAPTER

Settings such as the background image and
plug-in choices are not backed up during
synchronization, so they can't be restored
after a hard reset. If you use a backup
utility, you may be able to restore a backup
to recover your Today screen settings and
other additional info.

| can’t synchronize using a Bluetooth
connection

Before you begin, make sure your
computer is equipped with Bluetooth®
wireless technology, either built-in or
through a Bluetooth card. Make sure that
the computer’s Bluetooth setting is
discoverable.

1 On your computer, right-click the gray
ActiveSync icon in the Windows
system tray, and select Connection
Settings.

2 Check the Allow connections to one
of the following box, and then select
Bluetooth.

3 On your smartphone, go to your Today
screen, and then tap Bluetooth 9
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Check the Turn on Bluetooth box to
turn on your smartphone's Bluetooth
feature.

Press OK (@.

Press Start and select Programs.
Select ActiveSync @ .

Press Menu = (right action key) and
select Connect via Bluetooth.

If this is the first time you're making a
Bluetooth connection to this computer,
follow the onscreen prompts for setting
up a Bluetooth partnership with this
computer.

10 Select Sync.
11 When synchronization has finished,

press Menu 2 (right action key) and
select Disconnect Bluetooth.

Email

| have problems using my account

Occasionally you may experience problems
in using an email account after you set it
up. If you followed the account setup
procedure and are experiencing problems

in using the account, verify that the
account complies with your email
provider’s requirements by following
these steps:

Verify both your password and your
username for your email account.

Some wireless service providers require
you to be on their network to use your
email account. If this is the case, be
sure to use your provider’'s network as
the connection type for the account.

Some email service providers have
other requirements specific to their
service. For example, Yahoo! requires
you to set up POP mail forwarding for
your Yahoo! account to download email
messages to your smartphone. Check
with your service provider to see if any
providerspecific requirements exist.

Service provider settings frequently
change. If your email account was
working but you are currently
experiencing problems, check with your
service provider to see if any of the
account settings have changed.

EMAIL
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| have problems sending and receiving
email

| have problems sending email
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If you are able to receive email messages
but cannot send them, try these steps,
in turn:

Short periods of time when email is
unavailable are common due to server
problems or poor wireless coverage. If you
have problems sending or receiving mail
for an extended period of time, check with
your ISP or email service provider to verify
that the service is working properly.

« Make sure your ISP or email provider
allows you to access email on a
smartphone. Some providers do not
offer this option at all; other providers
require an upgrade to access email on a

Auto Sync is not working smartphone.

« Turn on ESMTP Many services require
authenticated access, or ESMTP to use
their SMTP servers.

« Press Start @ select Programs, and
then select ActiveSync @ . Press

If Auto Sync is occurring and you turn your
smartphone off or the connection to your
email service provider is disconnected, the
Auto Sync fails.

Check the synchronization schedule to
make sure that Auto Sync is set to
occur at the expected day and time. See
Setting the synchronization schedule for
details.

Press Start (&), select Programs, and
then select ActiveSync @& . Press
Menu = (right action key) and select
Configure Server. Make sure that the
verify password setting is on. This is
required for overthe-air synchronization.

Menu — (right action key) and select
Configure Server. Make sure the SSL
box is checked.

Enter the name of a different outgoing
mail server for sending mail. Many ISPs,
such as cable companies, require that
you have an Internet connection to their
network to send email through their
servers. In this case, you can almost
always receive email from these
accounts, but if you want to send email,
you must send it through another
server.

EMAIL
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| have problems synchronizing messages
on my smartphone with messages on my
computer

Make sure you have chosen the same
settings for the account on both your
smartphone and your computer. For
example, if the account is set up on your
smartphone to use the POP protocol,
check the ActiveSync settings on your
computer to make sure that POP is
selected as the protocol for that account.

My vCard or vCal email attachment isn’t
forwarding correctly

Microsoft Office Outlook provides several
features that work with email client
software on a Windows computer. For
these features to work correctly, the email
client software must be properly set up.
Follow these steps to check the settings:

1 Click Start on your computer, and then
select Settings.

2 Select Control Panel.

3 Select Internet Options, and then click
the Programs tab.

4 Make sure that the email field is set to
the correct email client software.

5 Click OK.

6 Start the email client software and
make sure it is configured as the default
MAPI client. Consult the documentation
for your desktop email application for
more information.

When | sync with my Exchange Server my
info is not downloading to my
smartphone

Check with your system administrator to
obtain the name of the mail server that
offers you wireless access to the corporate
mail system. If you cannot obtain the name
of this server (some companies do not give
it out, because they do not want wireless
access to their servers), you cannot use
ActiveSync to synchronize with the
Exchange Server. You can also check the
following setting:

1 Press Start and select Programs.
2 Select ActiveSync @.

3 Press Menu = (right action key) and
select Configure Server.

4 Make sure the SSL box is checked.
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I can’t access a page

First, make sure you have Internet access:
Open Internet Explorer Mobile and try to
view a web page you've loaded before. To
ensure that you're viewing the page
directly from the Internet, press Menu
C—— (right action key) and select Refresh.
After confirming your Internet connection,
try to view the page in question again. If it
comes up blank, press Menu T (right
action key) and select Refresh.

If you're still having trouble, the page may
contain elements that are not supported by
Internet Explorer Mobile, such as Flash,
Shockwave, VBScript, WML script, and
other plug-ins.

Some websites use a redirector to their
true home page (for example, if you enter
the address http://www.palm.com/support
it may resolve to http://www.palm.com/us/
support). If Internet Explorer Mobile can’t
follow the redirect, try using a desktop
browser to see the landing page of the
redirector, and enter that address in
Internet Explorer Mobile.

TROUBLESHOOTING @
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TIP Your smartphone can open your email
application when you select an email address
on a web page. If nothing happens when you
select the link, try setting up your email
application first.

An image or map is too small on my
smartphone screen

Internet Explorer Mobile has several
viewing modes: One Column, Default,
Desktop, and Full Screen. Switch to
Desktop to see the full-size image (see
Viewing a web page).

A secure site refuses to permit a
transaction

Some websites don't support certain
browsers for transactions. Please contact
the site’'s webmaster to make sure the site
allows transactions using Internet Explorer
Mobile.

Camera

Here are some tips for taking good pictures
with the built-in camera:
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o Clean the camera’s lens with a soft,
lint-free cloth.

o Take pictures in bright lighting
conditions. Low-light images may be
grainy, due to the sensitivity of the
camera.

o Hold the camera as still as possible. Try
supporting your picture-taking arm
against your body or a stationary object
(such as a wall).

« Keep the subject of the pictures still.
Exposure time is longer with lower light
levels, so you may see a blur.

« For best results, verify that you have the
brightest light source coming from
behind you, lighting the subject’s face.
Avoid taking indoor pictures with the
subject in front of a window or light.

« Make sure the subject is at least 18
inches away from the camera to ensure
good focus.

Remember that when you synchronize,
your Camera images are stored in the
C:\Documents and
Settings\<Username>\My Documents\Treo
My Documents folder on your hard drive

(see Viewing pictures and videos on your
computer).

DID YOU KNOw? Pictures are 16-bit color.
Resolution settings range from 1280 x 1024 to
160 x 120 pixels (1.3 megapixels to VGA).
Video resolution settings range from 352 x
288 to 176 x 144 pixels. You can change the
resolution setting by pressing Menu (right
action key) and selecting Resolution (still
images) or Quality (video).

The Camera preview image looks strange

Some third-party applications overwrite
your smartphone’s color settings with their
own 8-bit color settings. This can affect the
Camera Preview Mode. Delete third-party
applications one by one until the preview
image improves.

Third-party
applications

Sometimes, third-party applications can
cause conflicts on your smartphone.
Third-party applications that modify
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wireless features may affect your
smartphone's performance and may
require extra troubleshooting. Use caution
when installing the following types of
applications:

Ringtone managers
Caller ID applications
Instant messaging

Applications that modify when your
phone or data connections turn on or off
and how your phone behaves

If you recently installed an application and
your smartphone seems to be stuck, try
the following:

1

2

Perform a soft reset (see Performing a
soft reset).

Make sure the third-party application is
compatible with the Windows Mobile
version 5.2 operating system on your
smartphone.

Delete the most recently installed
application from your smartphone (see
Removing applications).

If the problem persists, perform another
soft reset.

TROUBLESHOOTING @

5 If possible, synchronize or use a backup
utility to back up your most recent info.
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6 Perform a hard reset (see Performing a
hard reset).

7 Synchronize or restore your backup to
restore the info in your built-in
applications.

8 If the problem is resolved, begin
reinstalling your third-party applications
one at a time.

9 |If the problem recurs, delete the last
application you installed and report the
problem to its developer.

TIP Remember that not all third-party
applications were written with the Treo 700wx
smartphone keyboard and 5-way navigator in
mind. You may encounter strange behavior or
errors in these applications if you use the
keyboard and the 5-way navigator.

Getting more help

Contact the author or vendor of any
third-party software if you require further
assistance.
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Making room on your
smartphone

If you store a large number of records, or
install many third-party applications, the
internal memory on your smartphone may
fill up. Here are some common ways to
clear space on your smartphone:

« Camera: Large images take up a lot of
memory. Move images to an expansion
card or delete images from your
smartphone (see Viewing pictures and
videos on your computer).

« Messaging: Email attachments can
consume excessive memory. Move
attachments to an expansion card, or
delete large files from your smartphone
(see Managing your messages). You
may also want to empty the deleted
items folder.

- Internet: If you save links to pages
you've visited in Internet Explorer
Mobile, you may want to clear all recent
pages (see Customizing your Internet
Explorer Mobile settings).

» Third-party applications: You can
delete infrequently used applications or
move them to an expansion card (see
Copying or moving applications and files

between your smartphone and an

expansion card).
Also, remember that your smartphone
includes an expansion card slot, and that
you can store applications and information
on expansion cards. However, you still
need free memory on the smartphone
itself to run applications from an expansion
card.

Voice quality

Is the other person hearing an echo?

« Try decreasing the volume on your
smartphone to avoid coupling
or feedback on the other person’s end.
This applies to both the speakerphone
and to the handset ear piece.

« Position the smartphone closer to your
ear to prevent sound leaking back to the
microphone. Keep your hand away from
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the microphone hole, which is on the
lowerright side of your smartphone.

« |f you're using Speakerphone mode
with your smartphone lying on a flat
surface, try turning the smartphone
face-down (so that the screen faces the
surface).

Are you hearing your own voice echo?

Ask the other person to turn down their
volume or to hold the smartphone closer to
their ear.

TROUBLESHOOTING

Is your voice too quiet on the other end?

Be sure to hold the bottom of the
smartphone, or the hands-free
microphone, close to your mouth.

Check the signal strength indicator. If the
signal is weak, try to find an area with
better coverage.

e
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Terms

1xRTT (Single-carrier [1x] radio
transmission technology)

A wireless technology that can provide fast
data transfer and Internet access with
average speeds of 60-80Kbps and bursts
up to 144Kbps.

ActiveSync®

The technology that exchanges and
updates the information on your
smartphone with the information on your
computer.

Alt (alternative)

A keyboard key. Press Alt and then
press a letter on the keyboard to access
variations such as international characters
and symbols.

Auto-off interval

The time of inactivity that passes before
the screen on your smartphone turns off.
The wireless features on your smartphone
are unaffected by this setting.

Beam

The process of sending or receiving an
entry or application using the infrared port
on your smartphone.

Desktop software

A PIM application for computers, such as
Microsoft Outlook, that helps you manage
your personal information and keep your
personal information synchronized with
your smartphone.

EVDO (Evolution Data Optimized)

A wireless broadband-like technology that
is designed for very high-speed data
transfer with average download speeds of
400 to 700 Kbps.

Infrared (IR)

A way of transmitting information using
light waves. The IR port on

your smartphone lets you transfer
information between other IR devices
within a short radius.

Lithium lon (Li-lon)

The rechargeable battery technology used
in Treo 700wx smartphones.

TERMS
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My Mobile Devices

The component on your Windows
computer that enables you to install
applications and other information on your
smartphone.

Option ©
The keyboard button that lets you access

the alternative feature that appears above
the letter on each key.

Phone Off

When your Phone is off, your smartphone
is not connected to any wireless network
and "Phone Off” appears instead of your

wireless provider's name. You can still use
the organizer and other features.

Phone/Send (&)

The button on your smartphone that
provides quick access to your Today
screen.

PIM (personal information manager)

A genre of software that includes
applications such as Microsoft Outlook,
Palm® Desktop software, Lotus Notes, and
ACT!. PIMs generally store contacts,
schedules, tasks, and memos.

SMS

The service that exchanges short text
messages almost instantly between
wireless devices. These messages can
usually include up to 160 characters. Your
Treo 700wx smartphone can send and
receive text messages while you are on a
voice call.

SSID

The name that identifies a Wi-Fi network. If
a network does not broadcast its SSID, you
must get the SSID from the system
administrator in order to connect to

the network.

Start

The menu on your smartphone from which
you can open all applications.

Username

The name associated with your
smartphone that distinguishes it from
other Windows Mobile® devices. When
you first synchronize your smartphone, you
are asked to give it a username.

TERMS



Wi-Fi access point Windows Mobile

A network device with an antenna that The operating system of your Treo 700wx
provides wireless connections to a larger smartphone.
network. Also called a hotspot.
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Regulatory
Information

FCC Statement

This equipment has been tested and found to comply with the limits
for a Class B computer peripheral, pursuant to part 15 of the FCC
Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there
is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different
from that to which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

This device complies with part 15 of the FCC Rules. Operation is

subject to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

RF Safety Exposure

To Radio Frequency Energy (RFE) Radio transmitting devices radiate
Radio Frequency (RF) energy during its operation. RF energy can be
absorbed into the human body and potentially can cause adverse
health effects if excessive levels are absorbed. The unit of
measurement for human exposure to RF energy is “Specific
Absorption Rate” (SAR).

The Federal Communications Commission (FCC), Industrie Canada
(IC), and other agencies around the world have established limits that
incorporate a substantial safety margin designed to assure the safety
of all persons using this equipment.

In order to certify this unit for sale in the US, Canada and Europe this
unit has been tested for RF exposure compliance at a qualified test
laboratory and found to comply with the regulations regarding
exposure to RF Energy.

SAR was measured with the unit transmitting at its maximum
certified RF power. Often, however, during normal operation the unit
will transmit much less than maximum power. Transmit power is
controlled automatically and, in general is reduced as you get closer
to a cellular base station. This reduction in transmit power will result
in a lower RF energy exposure and resulting SAR value.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users
MUST use one of the following types of bodyworn accessories.

e A Palm® brand body-worn accessory that has been tested for
SAR compliance and is intended for use with this product.

* Anaccessory that contains NO metal (snaps, clips, etc) and
provides AT LEAST 1.5 cm of separation between the users body
and the unit.

Do NOT use the device in a manner such that it is in direct

contact with the body (i.e. on the lap or in a breast pocket). Such use
will likely exceed FCC RF safety exposure limits. See
www.fce.gov/oet/rfsafety/ for more information on RF exposure
safety.

The Palm® Treo™ 700wx smartphone may be used with a Wi-Fi®
SDIO card; however, the user must ensure that the SDIO Wi-Fi card
has been approved by the FCC for use with the Treo 700wx
smartphone. For a list of SDIO Wi-Fi cards approved by the FCC for
use with the Treo 700wx smartphone, please go to www.palm.com/
support.

If using a SDIO Wi-Fi card not approved for use with the Treo 700wx
smartphone by the FCC, the user must turn off the phone (CDMA
radio) on the Treo 700wx smartphone.

REGULATORY INFORMATION
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Use of an SDIO wireless transmitter that is not approved in
conjunction with the phone (CDMA radio) is not authorized by the Maximum Scaled SAR Values (W/kg)
FCC and may exceed FCC RF exposure guidelines.

Band CDMA Cellular CDMA PCS
Responsible party Head SAR (WKg) (WKg)
(North America) (Held to Ear) 1.26 1.26
Palm, Inc.

’ Body SAR W/K W/K,
950 W. Maude Ave. ot ‘104 9 ‘55/ o
Sunnyvale, CA 94085
USA
www.palm.com For SAR values when used with a SDIO Wi-Fi card go to

ww.palm.com, r

Antenna Care/Unauthorized Modifications
FCC OET Bulletin 65 Supplement C

Use only the supplied integral antenna. Unauthorized antenna
modifications or attachments could damage the unit and may violate
FCC regulations. Any changes or modifications not expressly Radiated Emissions: EN 55022
approved by the party responsible for compliance could void the

Safety: EN 60950: 2000 (Jan-2000)

user's authority to operate the equipment. FCCID-O8RIMI
IC ID: 3905A-JIMI
Potentially Unsafe Areas
Potentially explosive atmospheres: Turn off your smartphone when
you are in any areas with a potentially explosive atmosphere, such as Palm
fueling areas (gas or petrol stations) or storage facilities for fuel or
chermicels Treo 700wx
Declaration of Conformity

Treo 700wx Model

Palm declares that the above model of Treo 700wx smartphone is
compliant with the regulations below. The declaration applies to the
smartphone and its associated accessories (power supply, headset,
and USB cable) where applicable
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F i Unsafe Areas / Potentially explosive

Using TTY

ATTY (also known as TDD or text telephone) is a
telecommunications device that allows people who are deaf or
hard of hearing, or who have speech or language disabilities, to
communicate by telephone.

Your Palm Treo 700wx smartphone is compatible with select TTY
devices. You can connect a TTY/TDD machine to your smartphone
through the headset jack, but you cannot use your headset jack
with a headset or hands-free kit while this mode is enabled.
Please check with the manufacturer of your TTY device for
connectivity information and to ensure that the TTY device
supports digital wireless transmission.

To use TTY, you may need to make additional arrangements with
your network operator. Please contact your network operator’s
customer service department for more information.

1 Press the Start button and select Settings.
Select Personal, and then select Phone.

Select Phone.

AW N

Select the TTY/TDD list, and then select either Default mode,
VCO mode, or HCO mode. Select Off to disable TTY.

5 Press OK. A keyboard icon appears at the top of your Today
screen whenever TTY is enabled.

FCC Hearing Aid Compatibility

Your Treo is compliant with the FCC Hearing Aid Compatibility (HAC)
requirements. For additional HAC information, including the HAC
rating of this product, please go to www.palm.com/treocHAC.

Operational Warnings

IMPORTANT INFORMATION ON SAFE AND EFFICIENT
OPERATION. Read this information before using your integrated
multi-service portable radio.

For the safe and efficient operation of your radio, observe these
guidelines:

atmospheres Obey all signs and instructions regarding turning off
your smartphone. In particular, turn off your smartphone when you
are in any areas with a potentially explosive atmosphere, such as
fueling areas (gas or petrol stations, below deck on boats), storage
facilities for fuel or chemicals, blasting areas and areas near electrical
blasting caps, and areas where there are chemicals or particles (such
as metal powders, grains, and dust) in the air.

Interference to Medical and Personal Electronic Devices Most
but not all electronic equipment is shielded from RF signals and
certain electronic equipment may not be shielded against the RF
signals from your smartphone.

Pacemakers The Health Industry Manufacturers Association
recommends that a minimum separation of six inches (6") be
maintained between a smartphone and a pacemaker to avoid
potential interference with the pacemaker. These recommendations
are consistent with the independent research by the
recommendations of Wireless Technology Research.

Persons with pacemakers should:

*  ALWAYS keep the smartphone more than six inches from their
pacemaker when the smartphone is turned ON.

* Not carry the smartphone in a breast pocket.

* Use the ear opposite the pacemaker to minimize the potential for
interference.

e Turn the smartphone OFF immediately if you have any reason to
suspect that interference is taking place.

Audio Safety Some hearing aids may be affected by some digital
smartphones. You may want to consult your doctor in the event of
you experience interference with your hearing aid while using your
smartphone. When using the speakerphone feature, it is
recommended that you place your smartphone at a safe distance
from your ear.

Other Medical Devices If you use any other personal medical
device, consult the manufacturer of your device to determine if it is
adequately shielded from external RF energy. Your physician may be
able to assist you in obtaining this information.
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Turn your smartphone OFF in health care facilities when any
regulations posted in these areas instruct you to do so. Hospitals or
health care facilities may be using equipment that could be sensitive
to external RF energy.

Interference to Other Electronic Devices RF energy may affect
improperly installed or inadequately shielded electronic operating and
entertainment systems in motor vehicles. Check with the
manufacturer or representative to determine if these systems are
adequately shielded from external RF energy. Also check with the
manufacturer of any equipment that has been added to the vehicle.

Repetitive Motion Injuries \When using the keyboard or playing
games on your smartphone, you may experience discomfort in your
neck, shoulders, hands, arms, of other parts of the body. To avoid
any injury, such as tendonitis, carpal tunnel syndrome, or other
musculoskeletal disorder, make sure to take necessary breaks from
use, take longer rests (such as several hours) if discomfort or tiring
begins, and see a doctor if discomfort persists.

Blackouts and Seizures Blinking lights, such as those experienced
with television or playing video games, may cause some people to
experience blackout or seizure, even if never experienced before. In
the event a smartphone user should experience any disorientation,
loss of awareness, convulsion, eye or muscle twitching or other
involuntary movements, stop use immediately and consult a doctor.
Individuals with personal or family history of such events should
consult a doctor before using the device. To limit the possibility of
such symptoms, wherever possible every hour take a minimum of 15
minutes, use in a well lighted area, view the screen from the farthest
distance and avoid exposure to blinking lights if you are tired

Aircraft While in aircraft, follow all instructions regarding the
operation of your smartphone. Use of your smartphone while on
board on aircraft must be done in accordance in compliance with
airline instructions and regulations.

Vehicles with Air Bags Your smartphone should not be placed in a
position that would affect the operation of air bag deployment or in a
position that, should the air bag inflate, could propel the smartphone.
Air bags will inflate with great force and care should be taken to
protect within a vehicle that has air bags.

Battery Your smartphone includes an internal lithium ion battery.
Please note that use of certain data applications can result in heavy

battery use and may require frequent battery charging. Any disposal
of the smartphone must comply with laws and regulations pertaining
to lithium ion batteries.

Dri

ng Safety Tips Overview

Always obey all laws and regulations on the use of smartphones in
your driving area.

Safety — Your most important call. The Wireless Industry reminds
you to use your smartphone safely when driving.

1 Get to know your smartphone and its features, such as speed
dial and redial.

2 When available, use a hands-free device.
3 Position your smartphone within easy reach.

4 Let the person you are speaking to know you are driving; if
necessary, suspend the call in heavy traffic or hazardous weather
conditions.

5 Do not take notes or look up phone numbers while driving.

6 Dial sensibly and assess the traffic; if possible, place calls when
you are not moving or before pulling into traffic.

7 Do not engage in stressful or emotional conversations that may
divert your attention from the road.

8 Dial 9-1-1 to report serious emergencies -it's free from your
smartphone!

9 Use your smartphone to help others in emergencies.

il
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Call roadside assistance or a special non-emergency wireless
number when necessary.

Driving Safety Tips Details

1 Get to know your smartphone and its features such as speed dial
and redial. Carefully read your instruction manual and learn to
take advantage of valuable features most smartphones offer
including, automatic redial and memory dial-most smartphones
can store up to 99 numbers in memory dial. Also, work to
memorize the smartphone keypad so you can use the speed dial
function without taking your attention off the road.
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When available, use a hands-free device. A number of hands-free
smartphone accessories are readily available today. Whether you
choose an installed mounted device for your smartphone or a
speaker phone accessory, take advantage of these devices if
available to you.

Position your smartphone within easy reach. Make sure you
place your smartphone within easy reach and where you can
grab it without removing your eyes from the road. If you get an
incoming call at an inconvenient time, let your voice mail answer
it for you.

Suspend conversations during hazardous driving conditions or
situations. Let the person you are speaking to know you are
driving; if necessary, suspend the call in heavy traffic or
hazardous weather conditions. Rain, sleet, snow and ice can be
hazardous, but so is heavy traffic. As a driver, your first
responsibility is to pay attention to the road.

Do not take notes or look up phone numbers while driving. If you
are reading an address book or business card while driving a car,
or writing a “to do” list, then you are not watching where you are
going. It's common sense. Don't get caught in a dangerous
situation because you are reading or writing and not paying
attention to the road or nearby vehicles.

Dial sensibly and assess the traffic; if possible, place calls when
you are not moving or before pulling into traffic. Try to plan your
calls before you begin your trip, or attempt to coincide your calls
with times you may be stopped at a stop sign, red light or
otherwise stationary. But if you need to dial while driving, follow
this simple tip-dial only a few numbers, check the road and your
mirrors, then continue.

Do not engage in stressful or emotional conversations that may
be distracting. Stressful or emotional conversations and driving
do not mix-they are distracting and even dangerous when you are
behind the wheel. Make people you are talking with aware you
are driving and if necessary, suspend phone conversations which
have the potential to divert your attention from the road.

Use your smartphone to call for help. Your smartphone is one of
the greatest tools you can own to protect yourself and your
family in dangerous situations-with your smartphone at your side,
help is only three numbers away. Dial 9-1-1 in the case of fire,

traffic accident, road hazard, or medical emergencies.
Remember, 9-1-1is a free call on your smartphone!

9 Use your smartphone to help others in emergencies. Your
smartphone provides you a perfect opportunity to be a “good
Samaritan” in your community. If you see an auto accident, crime
in progress, or other serious emergency where lives are in
danger, call 9-1-1, as you would want others to do for you.

=
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Call roadside assistance or a special wireless non-emergency
assistance number when necessary. Certain situations you
encounter while driving may require attention, but are not urgent
enough to merit a call to 9-1-1. But you can still use your
smartphone to lend a hand. If you see a broken-down vehicle
posing no serious hazard, a broken traffic signal, a minor traffic
accident where no one appears injured, or a vehicle you know to
be stolen, call roadside assistance or other special
non-emergency wireless number.

NOTICE FOR CONSUMERS WITH HEARING
DISABILITIES

Digital Phones to be Ci with Hearing Aids  On
July 10, 2003, the Federal Communications Commission (FCC)
modified the exemption for wireless phones under the Hearing Aid
Compatibility Act of 1988. This means that wireless phone
manufacturers and service providers must make digital wireless
phones accessible to individuals who use hearing aids

For more information, please go to the FCC's Consumer Alert on
accessibility of digital wireless phones at http://www.fcc.gov/cgb/
consumerfacts/accessiblewireless.html.

Wireless telephones are hand-held phones with built-in antennas,
often called cell, mobile, or PCS phones. These phones are popular
with callers because they can be carried easily from place to place.

Wireless telephones are two-way radios. When you talk into a
wireless telephone, it picks up your voice and converts the sound to
radio frequency energy (or radio waves). The radio waves travel
through the air until they reach a receiver at a nearby base station.
The base station then sends your call through the telephone network
until it reaches the person you are calling.
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Making a
Phone Call

AN

Receiving a
Phone Call

When you receive a call on your wireless telephone, the message
travels through the telephone network until it reaches a base station
close to your wireless phone. Then the base station sends out radio
waves that are detected by a receiver in your telephone, where the
signals are changed back into the sound of a voice.

The Federal Communications Commission (FCC) and the Food and
Drug Administration (FDA) each regulate wireless telephones. FCC
ensures that all wireless phones sold in the United States follow
safety guidelines that limit radio frequency (RF) energy. FDA monitors
the health effects of wireless telephones. Each agency has the
authority to take action if a wireless phone produces hazardous levels
of RF energy.

FDA derives its authority to regulate wireless telephones from the
Radiation Control provisions of the Federal Food, Drug, and Cosmetic
Act (originally enacted as the Radiation Control for Health and Safety
Act of 1968).

[http://www.fda.gov/cdrh/comp/eprc.html].

FCC derives its authority to regulate wireless telephones from the
National Environmental Policy Act of 1969 (NEPA) and the
Telecommunications Act of 1996

http:, fcc.gov/telecom.html]. Updated 7/16/2003

Hands-Free Capability All CTIA Certified portable products provide
the consumer with a toll-free number for the purchase of a
compatible hands-free device. 1-800-881-7256

STATIC ELECTRICITY, ESD, AND YOUR PALM DEVICE

Electrostatic discharge (ESD) can cause damage to electronic devices
if discharged into the device, so you should take steps to avoid such
an occurrence.

Description of ESD  Static electricity is an electrical charge caused
by the buildup of excess electrons on the surface of a material. To
most people, static electricity and ESD are nothing more than
annoyances. For example, after walking over a carpet while scuffing
your feet, building up electrons on your body, you may get a shock—
the discharge event—when you touch a metal doorknob. This little
shock discharges the built-up static electricity.

ESD-susceptible equipment Even a small amount of ESD can
harm circuitry, so when working with electronic devices, take
measures to help protect your electronic devices, including your
Palm® device, from ESD harm. While Palm has built protections
against ESD into its products, ESD unfortunately exists and, unless
neutralized, could build up to levels that could harm your equipment.
Any electronic device that contains an external entry point for
plugging in anything from cables to docking stations is susceptible to
entry of ESD. Devices that you carry with you, such as your Palm
device, build up ESD in a unique way because the static electricity
that may have built up on your body is automatically passed to the
device. Then, when the device is connected to another device such
as a docking station, a discharge event can occur.

Precautions against ESD Make sure to discharge any built-up
static electricity from yourself and your electronic devices before
touching an electronic device or connecting one device to another.
The recommendation from Palm is that you take this precaution
before connecting your Palm device to your computer, placing the
device in a cradle, or connecting it to any other device. You can do
this in many ways, including the following:

e Ground yourself when you're holding your device by
simultaneously touching a metal surface that is at earth ground.
For example, if your computer has a metal case and is plugged
into a standard three-prong grounded outlet, touching the case
should discharge the ESD on your bodly.

* Increase the relative humidity of your environment.

* Install ESD-specific prevention items, such as grounding mats.
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C.

diti that ent ESD Conditions that can

contribute to the buildup of static electricity in the environment
include the following:

Low relative humidity.

Material type (The type of material gathering the charge. For
example, synthetics are more prone to static buildup than natural
fibers like cotton.)

*  The rapidity with which you touch, connect, or disconnect
electronic devices.

While you should always take appropriate precautions to discharge
static electricity, if you are in an environment where you notice ESD
events, you may want to take extra precautions to protect your
electronic equipment against ESD.
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Specifications

Radio .

CDMA 800 (digital cellular), 1900 (PCS), and 1400 (GPS)
EVDO and 1XRTT

Phone features .

Personal speakerphone

Hands-free headset jack (2.5 mm, 3-barrel connector)
Microphone mute option

TTY compatible

3-way calling

Processor technology .
Expansion .

Intel XScale™ processor, 312MHz
SD/MultiMediaCard/SDIO card slot

Battery .

Rechargeable Lithium lon
Removable for replacement
3.5 hours full charge time

Operating system .
Camera .

Windows Mobile® 5.2.2 Pocket PC Phone Edition
Still image capture resolution: 1280 x 1024, 1.3 megapixel
Automatic light balance

Size .

5.08in. x 2.28 in. x 0.89 in. (129mm x 58mm x 22.5mm)
with antenna

Weight .

6.4 ounces (180 grams)

Connectivity .

Infrared (1.2 compliant)
Bluetooth® wireless technology (1.2 compliant)
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Display Touch-sensitive LCD screen (includes stylus)
65,536 colors (16-bit color)
User-adjustable brightness

Keyboard Built-in QWERTY keyboard plus 5-way navigator

Backlight for low lighting conditions

Included software

Today/Phone (includes
Speed Dial and Dial Pad)

Messaging (text and
email)

Internet Explorer Mobile
(web browser)

Camera
Pictures & Videos

Windows Media Player
Mobile

File Explorer

Contacts

Calendar

Tasks

Notes

Calculator

ActiveSync®

Direct Push Technology

Excel Mobile

Word Mobile
PowerPoint Mobile
Pocket MSN

Solitaire

Bubble Breaker

Voice Command
Downloads application
Quick Tour

Search

Terminal Services
Picsel PDF Viewer
Cubis (available on the
Getting Started CD)
Sprite Backup (available on
the Getting Started CD)
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System requirements

Windows 2000 or XP with USB port. Later versions may
also be supported.

Some wireless features require Microsoft Exchange
Server 2003 with Service Pack 2.

Operating and storage
temperature range

32°F to 104°F (0°C to 40°C)
5% to 90% RH
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Index

SYMBOLS
l'icon 10

NUMERICS

3G2 files 127, 128

5-way navigator 6, 21, 24,
231

802.1x page (Network
Authentication) 203

A

abbreviated dialing
preferences 178
AC charger 9
accented characters 30
Access page 196
accessing
alternate characters 30
applications 32, 185
battery status window 44
calculator 80
corporate email accounts
204, 228
Dial Pad 49
field lists 27

File Explorer 116, 158,
159, 169
information 33, 195
instant messages 101
menu items 26
on-device help 37
Outlook folders 222
Phone Settings screen 13
Quick Tour 37
secure websites 195, 229
shortcut menus 26, 203,
220
speed dial buttons 46
Tasks entry bar 77
the Internet 204, 218
Today screen 41, 236
voicemail 52
web pages 102, 104, 229
accessories 216
account types 86
accounts
accessing corporate 204,
228
getting help with 37
preventing unauthorized
use of 190, 195
setting up email 86-92
synchronizing 95
troubleshooting 226

Accounts page 97

action keys 6

activating items on screen 24

active calls
See also phone calls
adding a second 55
adjusting volume for 175
ending 13, 53, 56
managing 53, 54

active calls. See phone calls

ActiveSync icons 35, 43

ActiveSync software 14,
162, 221, 228
options 161

ActiveSync technology 235

Add Contact prompt 54

Add Server Source command
88

Add Server Source prompt
162

Add to Favorites command
104

adding
a second call 55
applications to Start menu

186
appointments 70, 71
attachments to email 93,
158

INDEX
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bulleted or numbered lists
141

caller ID pictures 67

connections 204, 205

contacts b4, 67

document templates 138,

142

email messages 93

expansion cards 166

favorites links 104

files to playlists 131

folders 142

notes 67, 76, 77

signatures 98

speed dial buttons 58

spreadsheets 144

tasks 75

untimed events 70, 71
address book 94, 100
Address page 94, 100
addresses

adding email 93, 94

entering message 85

messaging options for 100

multiple recipients 86

selecting email 23
adjusting screen brightness

184, 215

Advanced page (Power
Settings) 198, 215
advancing slides 143, 144
After calls from numbers...
setting 177
Agenda View (calendar) 69
alarm clock 194
alarm sounds 194
alarms
events and 71
setting system 194
setting vibrating 183
tasks and 75
turning on and off 183
Alarms page 194
albums 122
alert tones. See ringtones
aligning the screen 185
alignment settings
documents 141
spreadsheets 144
Allow cookies setting 107
Allow USB connections
check box 221
Alt key 28, 235
alternate characters 30
alternate characters list 30,
31
alternate phone numbers 47

animated images 122
animation 142, 143
anniversaries 71
Answer button 49
answering the phone 49, 55
antenna 5, 240
Appearance page 173, 174,
185
applications
See also third-party
applications
accessing help for 37
accessing shortcut menus
26
associating with buttons
186
battery life and 36
closing 15, 32, 197
copying 168
customizing 185-189
deleting 161, 232
displaying 197
downloading 159
error reporting for 195
included with smartphone
248
installing 158-160, 231
losing information in 212
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moving to expansion cards
168

opening 32, 167, 236

phone conversations and
running 53

reinstalling 212

running from expansion
cards 168, 232

storing 232

transferring information
from 34

troubleshooting 214

turning sounds on or off
for 183

viewing main menus 25

viewing memory usage for
197

appointments 72

See also events

adding 70

appearing in wrong time
slots 223

deleting 73

entering multiple 70

hiding 72

marking as private 72

reminders for 71, 74

scheduling repeating 71

viewing 69

Appointments page 74
Area code setting 63
arrow icons (navigator) 22
Assign a program list 187
attachments

See also email

adding 93, 158

downloading 96

embedded objects in 97

freeing internal memory

and 232

opening 96

receiving 96

storing 97, 100

troubleshooting 228
audio 50, 127, 128

See also media files;

music

audio accessories 62
authentication 203
Authentication list 202
auto shut off timer 165
Auto Sync, troubleshooting

227
auto-completion options 188
AutoCorrect command 125
Autofill setting 149
AutoFilter command 151

AutoFilter settings
(spreadsheets) 145

auto-keyguard feature 189,
190

Auto-Keyguard settings 190

Auto-lock settings 191

auto-off interval 235

back view (Treo smartphone)
7
backgrounds 119, 124, 133,
173
backing up information 212
backlight (keyboard) 29, 198
Backlight setting 215
Backspace key 28
backup utilities 209, 212,
225
backups, restoring 212, 225
battery
Bluetooth connections
and 111
charging 9-10
conserving power for 198
consumption factors 10
disposing of 213, 242
installing 8
maximizing life of 36
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replacing 212
specifications for 247
viewing remaining power
for 198
viewing status of 43
battery contacts 8
battery door release 6, 7
battery icon 10
battery performance 214
Battery Power page 198
battery status icons 43
battery status window 44
Beam... command 110, 114
beaming 110, 113-115, 158,
235
birthdays 71
Bluetooth devices
compatibility with 108
connecting to 108-110,
111,112
discovery setting for 111
phone calls and 62
sending and receiving
information over 110,
111
synchronizing with 111
troubleshooting 219, 220
Bluetooth feature 108, 111
Bluetooth icon 43, 111

Bluetooth Settings screen
110

Bluetooth status indicator 43

BMP files 127

Bold setting 140

border glow highlight 23

borders 144

Brightness command 120

brightness icons (camera)
120, 121

brightness, adjusting 120,
121,184, 215

browsing files and folders
157, 169

browsing the web. See web
browsing

built-in applications 37, 161,
248

bulleted lists 141

bullets 137

buttons
activating menus and 25
assigning voice

commands to 187
associating with
applications 186

calculator 80
creating speed dial 58
disabling 189

editing speed dial 60
on 5-way navigator 21
opening applications and
32
reassigning 186-187
selecting or activating 23
turning sounds on or off
for 183
Buttons page 133
Buttons Settings page 186

C

calculations 80, 145, 147
Calculator application 80
calculator buttons 80
Calculator icon 80
calendar
adding meeting requests
72
adding special events 70
displaying 69
removing events 73
setting alarms for 71
setting options for 74
unavailable time slots on
72
Calendar application
adding contacts and 67
customizing 74-75
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managing schedules with
70-73

selecting views 69
starting 69
synchronizing with 34
untimed events in 70

calendar views 69

call forwarding 57

Call Log 49, 58

Call Log command 49

Call Timers command 58

call waiting 55

call waiting notification
window 55

callback number 86

caller ID applications 231

caller ID blocking 54

caller ID pictures 67, 119,
176

calling plans 58

calls. See phone calls

camera
See also pictures
battery life and 36
capturing videos with 121
freeing internal memory

and 232

specifications for 247
taking pictures 119-120

troubleshooting 229-230
Cameraicon 119
camera lens 7
Camera page 126
Camera Preview Mode 230
camera settings 125-127
Cancel Bluetooth command
62
Cancel Mute 53
capitalization 29, 188
Caps Lock 29
capture resolution 247
carrying cases 216
case-sensitive searching
139, 152
cell patterns 144
cell phones. See wireless
phones
Center button (navigator) 21
certificates 105, 195
Certificates page 195
Change passcode button 191
changing
alarm sounds 194
connections 204
contacts 67
date and time settings 193
information 14, 152
lock codes 191

picture or video resolution
120, 121, 230
speed dial buttons 60
text 139
text size 184
character sets 106
characters
capitalizing 29, 188
entering 29, 188
phone calls and 52, 59
text messages and 85, 86
typing alternate 30
charging
smartphone 9
the battery 9-10
charging status 10
Chart command 151, 152
charts 145, 151, 152
chat rooms 37
check boxes 23
Clear Cookies setting 107
Clear History setting 107
Clear Now Playing command
132
Clear Type setting 184
Clock & Alarms Settings
page 193, 194
closed networks 200, 201
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closing
applications 15, 32, 197
battery status window 44
lists in fields 27
menus 26
screens 23
color settings 230
color themes 174, 185
colors 185
command buttons 187
commands 187
See also menus; specific
command
company lists 47
company names 47, 68
comparisons 151
completed tasks 75, 76
compliancy statement 240
components (Treo
smartphone) 1
compressed files 159
computers
connecting to 16
installing from 160
synchronizing with 14, 34,
163
system requirements 15
Conference button 56, 57

conference call
Flash mode 56
conference calls 56
Confidential setting 73
Configure Server command
162
Configure Wireless Network
page 201
configuring
data services 218
Exchange Server 162
TTY devices 176
wireless networks 201
Connect command 205
Connect via Bluetooth
command 112, 226
Connect via IR command
115
connecting
smartphone to PCs 16
to a headset 109
to Bluetooth devices 108—
110, 111, 112
to data service providers
204
to hands-free car kit 109
to mobile networks 216
to the Internet 204, 218
to VPNs 204-205

to Wi-Fi networks 200,
201, 203
connection icons 218
connections
accessing Internet and
115
adding 204, 205
changing 204
customizing 199-206
ending 206
manually starting 205
PCsand 115
precautions for 244
removing Bluetooth 110
synchronizing information
and 34
synchronizing over
infrared 115
troubleshooting 216-219
unavailable 218
Connections Settings page
204, 205
connectivity 247
conserving battery power
198
consumption (battery) 10
contacts
adding 54, 67
addressing to 85, 93
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alternate numbers 48
alternate phone numbers
for 47
assigning ringtones to 59,
67,123,176
changing 67
displaying 67
entering multiple 67
linking speed dial buttons
to 58
looking up 45
personalizing 176
removing 68
saving information for 54
selecting communication
method for 46
sending meeting requests
to 72
synchronizing 34
viewing details list for 46
Contacts application
customizing 68
managing contact
information with 67-68
starting 67
synchronizing with 34
Contacts list 45, 46
context-sensitive menus 26

continuous playback (slides)
144
cookies 107
Copy command 81, 106,
123,139, 169
copying
applications 168
items in folders 158
numbers 81
phone numbers 48, 49
pictures and videos 123
text 106, 139
copyrighted items 123
corporate email accounts 87
corporate mail systems 204,
228
corporate servers 204, 228
coverage area 11, 216
CPUs
connecting to 115
creating
appointments 70, 71
bulleted or numbered lists
141
caller ID pictures 67
connections 204, 205
contacts 54, 67
documents 137, 138
email messages 93

favorites links 104

folders 142

notes 77, 78

playlists 131

signatures 98

speed dial buttons 58

spreadsheets 144

tasks 75

templates 138, 142, 146

text messages 85

untimed events 70, 71

video ringtones 123

workbooks 146
cropping pictures 124
Currency page 185
currency symbols 185
current call. See active calls
customer service 37
customer support 37
Customize the playlists...

check box 128
customizing

applications 185-189

Calendar 74-75

camera 125-127

connections 199-206

Contacts application 68

dates and time 193

display settings 184-185
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Excel Mobile 154
format settings 184
Internet Explorer 106
Media Player Mobile 132
Messaging application 99
Notes application 79
phone 174-181
system settings 193-199
system sounds 181
Tasks application 77
Today screen 173
voicemail system 59
Word Mobile 142

Cut command 123, 139

D

daily schedules 69

data 146, 148, 211
See also information

Data Encryption settings 202

data formats 184

data service providers 204,
218

data services 2, 44, 180, 217

Data setting 179

data settings 179

data transfer 217

date formats 185

Date page 185

dates 148, 185, 193
See also calendar
Day View (calendar) 69
day-planner formats 69
decimal places 184
decimal symbols 184, 185
decompression utility 159
default format settings 184
default lock code 191
default template 142
default zoom level 188
defined names
(spreadsheets) 150
Delete Appointment
command 73
Delete Cells command 153
Delete command 98, 142,
154
Delete Contact command 68
Delete Files setting 107
Delete Task command 77
Deleted Items folder 938, 100
deleting
applications 161, 232
Bluetooth connections
110
certificates 195
contacts 68
directory services 95

documents 142

events 73

favorites links 105

files 158

items from playlists 132

items in folders 158

messages 98, 99

notes 79

pictures 125

sounds 175

speed dial buttons 60

tasks 77

workbooks 154

worksheets 154
desktop software 209, 235

See also applications
Device Setup Wizard 128
device, ESD and 244
devices

beaming to 113

caution for storing 7

compliancy for 241

configuring TTY/TTD 176

identifying 111, 202

setting up GPS 196

troubleshooting 219
diagnostic information 195
Dial Lookup list 13
Dial Pad 48, 49
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Dial Pad command 49

dial pad tones 176

dialing 12, 44-49, 55, 59

dialing preferences 177

Dialpad setting 176

digit grouping 184, 185

digital networks 180

Direct Push Technology 87

directory service 94, 100

Disable touchscreen check
box 190

Disconnect Bluetooth
command 112, 226

Disconnect command 206

discoverable setting 111

Dismiss button 51

display
See also screen
customizing 184-185
scroll settings for 189
specifications for 248

display formats 184

Display message on screen
check box 183

displaying
alternate characters 30
animated images 122
appointments 69
available applications 32

calendar 69
contacts 46, 67
daily schedules 69
documents 137
events 70, 73
items in folders 142, 153
memory usage 197
menus 25, 26
notifications 183
pictures 122, 127
power settings 198, 215
space on expansion cards
169, 197
spreadsheets 144, 145
tasks 76, 77
videos 122, 127
web pages 102, 106
wireless settings 199
document file types 137, 142
documentation 1
documents
See also Word Mobile
application
creating 137, 138
deleting 142
displaying 137
finding and replacing
operations in 139

moving or copying
operations in 139
opening 138
organizing 141
saving 138, 139, 142
sending 83
setting margins for 141
spell-checking 141
documents list 142
down arrow in fields 27
Down button (navigator) 21
downloading
applications 159
attachments 96
email 228
files 105
images 105, 122
ringtones 175
drafts 94
drawing 78
drivers 209
driving safety tips 242
dummy expansion card 166,
167

E

EAP type setting 203
earpiece 6
eBooks 36
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echoes 232
Edit command 124
Edit Speed Dial command 60
editing. See changing
electrostatic discharge 244—
245
email
adding attachments 93,
158
addressing 93, 94
creating messages for 93
dialing from 47
entering contact
information and 72
getting from corporate
servers 204, 228
messaging options for 99
priority settings for 93
receiving attachments
with 96
requirements for 1
selecting addresses 23
sending 93
troubleshooting 226-228
email accounts
setting up 86-92
setting up multiple
accounts 92
synchronizing 95

troubleshooting 226
E-mail application 34
email client software 228
email message icons 98
embedded images 97
emergency calls 179, 189
Empty Deleted Items
command 98
Enable local network time
check box 194, 224
Encoding setting 106
encryption 105, 202
End Conference button 56
End Show command 143
ending active calls 13, 53, 56
ending data connections 206
ending playback 130
endnotes 138
entering
alternate characters 30
data in spreadsheets 146,
148
information 14, 28, 188
lock codes 191
owner information 192
passwords 92, 191, 192
phone numbers 49
Erase all data? prompt 212
erasing. See deleting

error messages 182
error reporting 195-196
Error Reporting page 196
errors 195, 217
ESD (electrostatic discharge)
244-245
EVDO (defined) 235
eventicons 74
Event settings 183
events
categorizing 73
creating 70, 71, 72
deleting 73
hiding 72
marking as sensitive 72
reminders for 71, 74
Events check box 182
Excel applications 145
Excel files 135
Excel Mobile application
customizing 154
display settings for 146
formatting considerations
for 144
overview 144
searching in 152
starting 146
Excel Mobile icon 146
Exchange Address Book 222
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Exchange Server accounts
15, 86, 88, 162, 228
exiting applications 32, 197
expanding lists in fields 27
expansion card slot 5, 166,
247
expansion cards
adding applications 160
displaying available space
on 169, 197
freeing memory and 232
inserting 167
moving itemsto 142, 153,
168
opening items on 167
removing 167
renaming 169
saving items on 168
searchingon 157, 158
storing attachments on
97,100
transferring to 128, 132
types supported 166
extensible authentication
protocol 203
extensions (phone) 59
external power sources 198
Extra Digits button 52, 59
Extra Digits text box 59

F

factory-installed applications
37,161, 248
Favorites button 104, 105
Favorites buttons. See Quick
Keys
Favorites command 105
favorites links 104, 105
FCC Statement 239
features 1, 37
fields
accessing lists for 27
scrolling through 22
File Explorer 157, 158, 169
File Explorer icon 116, 158,
159
file lists 158
file names 138, 139, 141
file types 128, 137, 142
files 157, 204, 232
caution for deleting 158
filtering information 68, 151
filtering tasks 76
Find/Replace command 139,
152
finding
information 34, 152, 157
text 139
firewalls 204

first letter capitalization 29,
188
Flash mode 56
folder names 142
folders
accessing Outlook 222
adding documents to 140
arranging pictures and
videos in 124
browsing 157, 169
creating 142
displaying contents 142,
153
moving items to 142, 153
opening items in 158
organizing web favoritesin
104, 105
sorting contents 142, 153,
158
Font color setting 140
Font command 140
Font setting 140
fonts 137, 140, 144
footers 138
footnotes 138
forgetting passwords 191,
192
formatting
charts 152
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paragraphs and lists 140
spreadsheet cells 149—
150

system information 184

text 140
Formatting toolbar 141
formulas 144, 147, 154
forwarding

email 228

messages 98

phone calls 57

forwarding codes (phone) 57

freeing memory 161, 232

front view (Treo smartphone)

6
full charge (battery) 9
functions (spreadsheets)
144, 148

G

games 36

getting started 3

GIF files 122, 127

Global Positioning System
(GPS) 196

Go to Slide command 143

GPS devices 196

GPS Settings page 196

H

Hands Free check box 109
hands-free car kit 61, 109
hands-free devices 61, 110,
244
hanging indents 141
hanging up phone 53, 56
hard resets 191, 211
hardware 1
Hardware buttons box 183
Hardware page 196
headers 138
headset 61-62, 109
headset button 61
headset jack 6
hearing disabilities 176, 243
hearing-impaired 241
heat sources 36
help 37, 207, 231
Help command 37
Help screen 37
hiding
appointments 72
events 72
Tasks entry bar 77
Highlight setting 140
highlighting
alternate characters 30
items in lists 27

items on screen 22, 23
menu items 25, 26
multiple items 158
text 24, 140
hints (passwords) 192
History command 106
History list 106, 107
Hold button 53
home locations 193
Home Page setting 106
Hotmail accounts 87, 101
hypertext links. See links

icons
charging status 10
data services 217
email 98
events 74
phone status 41
signal-strength 11, 199
synchronization 35
IM messaging 85, 101
image files 127
images 97, 105, 229, 230,
232
See also pictures
IMAP accounts 87, 90, 97
inactivity 190, 198, 215
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Inbox 98
Indentation setting 141
indented lists 138
indenting text 141
indicator light 6, 9, 11
information
accessing 33, 195
backing up 212
changing 14, 152
entering 14, 28, 188
filtering 68, 151
losing 211
moving 168
protecting 189, 191
restoring 212
saving 168
searching for 34, 139,
152, 157
sorting 150
storing 166, 232

synchronizing 14, 34, 164,

221
transferring 209, 235
updating 14, 235
infrared port. See IR port
infrared transmissions 115,
235
Input Settings page 188

installation, troubleshooting
209, 211, 231

installing
applications 158-160, 231
desktop software 209
synchronization software

14,15

VPN clients 205
Windows drivers 209

instant messages 85, 101,
231

interference 112

internal memory 161, 232

Internet 204, 218

Internet Connection Speed
setting 133

Internet connections
accessing 115

Internet Explorer Mobile
102-107, 204, 229

IR port 5, 113, 235

ISP settings 204

ISPs (Internet service
providers) 87

Italics setting 140

items
accidentally activating 189
highlighting 22, 23
moving through 22

opening shortcut menus
for 26, 203, 220
selecting for Today screen
173
selecting or activating 24,
27
ltems page 173

J
JPEG files 127

K

Key index setting 202
keyboard
accessing alternate
characters on 30
dialing from 44
displaying alternate
characters list for 30
entering text from 29-30
locking 189, 190
pressing keys on 28
scrolling with 22
selecting menu items
from 26
setting key combinations
for 186
specifications for 248
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third-party applications and
231
keyboard backlight 29, 198
Keyguard 189
Keyguard Settings page 190
Known Caller setting 174

L

LANs 204
large files 232
LCD projector 144
leading zeros 185
Left button (navigator) 21
Legacy Pocket Word files
137
libraries (media) 130
Library command 129, 130
Library list 129
Library screen 130, 133
lightening bolt 10
lightning 10
Li-lon battery 235
See also battery
links
freeing internal memory
and 232
media files and 130
selecting or activating 23
text messages and 97

troubleshooting 229
list separators 185
List setting 141
Listen button 51
listening to
media files 62, 128
voicemail messages 51
lists
accessing 27
closing 27
creating 138, 141
formatting 140
highlighting items 22, 27
scrolling through 23
selecting items 23, 27
local area networks 204
locating information 34, 152,
157
Location Privacy icon 43, 179
Location Privacy setting 179
location-specific information
179, 184, 193, 196
lock codes 189, 191
Lockicon 104, 123
locking
spreadsheet rows and
columns 147
the keyboard 189, 190

Treo smartphone 189,
191

logging in to

corporate servers 204

secure websites 195
Long tones setting 176
lookup feature 45, 157
losing

information 211

passwords 191, 192

Treo smartphone 192
low coverage areas 216
low lighting conditions 29
lowercase letters 29

M

magnet 7

magnification. See zoom
settings

mail servers 204, 228

main menus 25

Make this device
discoverable setting 111

Manage existing connections
setting 205

Manage GPS automatically
check box 196

management tools 155

maps 196, 229
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margins 141
Match case box 139, 152
Match whole words only
check box 139, 152
maximizing battery life 36
measurement units 185
media files
creating playlists for 131
formats for 128
linking to 130
playing 129
transferring 128, 132
updating 131
media libraries 130
Media Player Mobile
customizing 132
overview 128
starting 129
media players 36
meeting requests 72, 75, 97
memory buttons 80
Memory page 107
Memory Settings page 197
memory usage 197
memory, freeing 161, 232
memos. See messages;
notes
Menu button 25
menu items, selecting 25, 26

menus 25, 26, 203, 220
Menus page 186
Message page 99
messages
See also text messages;
voice notes
adding signatures 98
addressing 85
creating email 93
deleting 98, 99
dialing from 47
displaying status of 98
forwarding 98
invalid characters and 86
listening to 51
phone calls and 53
rearranging 98
receiving notifications for
219
saving as drafts 94
selecting multiple 98
messaging
troubleshooting 219
Messaging application
accessing 85, 94
adding contacts and 67
customizing 99
overview 85
messaging applications 231

Messaging icon 85
Messaging list 98
messaging services 1, 219,
236
microphone 6, 53, 127
microphone icon 187
Microsoft Excel 145
Microsoft Exchange 2003
Server
Direct Push Technology
87
Microsoft Exchange Server.
See Exchange Server
Microsoft Office 135
Microsoft Outlook. See
Outlook
Microsoft Word documents.
See documents
microwaves 112
Missed call setting 174
mobile accounts 37
mobile devices
battery life and 36
getting help with 37
mobile networks 216
mobile phone numbers
See also wireless phones
Mobile to Market certificates
159
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modems 115-116

Modify Sheets command
150

Month View (calendar) 69

most recently dialed
numbers list 48

moving
documents to folders 142
information 168
pictures and videos 123
speed dial buttons 61
text 139
workbooks 153

moving around the screen
21-23

MP3 files 128

MSN Hotmail 87, 101

MSN Messenger Contacts
list 101

multi-connector 6

multimedia features 83, 117

multimedia messages
overview 83

MultiMediaCard expansion
cards 166

Multiple Networks Detected
dialog box 201

multiple recipients 86

music 50, 128, 130, 175

See also media files
Mute 53
My Device folder 158
My Device library 130
My Documents folder 157
My Mobile Devices folder
236
My Pictures folder 119, 121
My Playlists category 131
My Storage Card library 130
My Text command 86, 93
My Text phrases 85, 86, 93

N

names 236
naming
document files 138, 139,
141
folders 142
groups of pictures 126
speed dial buttons 58
workbooks 146, 153
worksheets 149
navigating the screen 21-23
navigator. See 5-way
navigator
negative numbers 185
Network Cards icon 201, 203

network connections 180,
199, 216-219

Network Key page 202

Network key setting 202

Network page 133

Network Selection pick list
180

New Appointment command
70

New Network Detected
dialog box 201

New Sound command 175

New Speed Dial command
58

notes
adding tasks and 76
creating 77, 78
entering contacts and 67
removing 79
saving 80

Notes application 77, 79

Notes icon 77

Notes list 79

Notes page 67

notification screens 51, 55

notifications
Bluetooth devicesand 111
displaying on screen 183
downloading sounds 175
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messages and 219
previewing ringtones 175
selecting 182
setting ringtones for 174
silencing sounds for 181
voicemail and 51
Notifications check box 183
Notifications page 174, 183
Now Playing playlist 131
Now Playing screen 131
number pad 12
Number page 184
number sign symbol 185
numbered lists 141
numbers
See also phone numbers
entering 30
formatting 144, 148, 184

o

Off Hold button 53

offline synchronization 222,
223

Off-peak times setting 165

OK button 6

on-device help. See help

online address book 94, 100

online forums 37

online support 37

open networks 199, 201
opening

applications 32, 167, 236

attachments 96

battery status window 44

calculator 80

characters list 30

Dial Pad 49

documents 138

File Explorer 116, 158,

159, 169

Help screen 37

items in folders 158

Outlook folders 222

Phone Settings screen 13

Quick Tour 37

shortcut menus 26, 203,

220

Today screen 41

web pages 102, 104, 229
operating system (Treo

Smartphone) 209
operating system (Treo

smartphone) 247
operating systems (PCs) 15
operating temperatures 249
operational warnings 241
Option button 22, 236
Option key 28, 30

Option Lock 30
options 26, 27, 73
Options page 188
organizer features 36, 65
orientation (slides) 143
Orientation page 143
Outbox 87, 98
Outlook
accessing folders for 222
client software and 228
downloading from 96
entering appointments in
70
entering contacts in 67
installing drivers for 209
synchronizing with 95
overdue tasks 76
owner information 192
Owner Information page 192

P

page breaks 138

Palm Powered devices 16,
209

Paragraph command 140

paragraph formatting 140

partial battery icon 10

passkeys 109

Password Settings page 192
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passwords 89, 92, 189, 191
Paste command 81, 106,
124
patches 161
patterns in workbooks 144
PCs
connecting to 115
PCS phones. See wireless
phones
PCs. See computers
Peak times setting 165
performance 214
personal information 191,
192, 235
personal information
manager 222
Personal setting 73
Personal Settings page 173,
174, 186, 187, 192
personalizing your
smartphone 171
phone
See also phone calls;
phone numbers;
smartphone
See also phone calls;
smartphone
adjusting volume 13, 175
advanced features 54-58

answering 49, 55

customizing 174-181

disabling touch-sensitive
feature for 189

downloading ringtones for
175

enabling as modem 115—
116

getting forwarding codes
for 57

hanging up 53, 56

Internet connections and
116

overview 41, 44

previewing ringtones 175

roaming and 180-181

running applications and
53

silencing ringer 50, 182

specifications for 247

turning off 13

turning on and off 11

viewing minutes usage for
58

waking up screen for 53

phone calls

See also phone numbers
See also phone; phone
numbers

ending 53, 56
entering extradigits for 52,
59
forwarding 57
hands-free devices and
110
making 44, 53, 55
placing on hold 53
receiving 49, 53
sending to voicemail 49
setting ringtones for 174
setting up conference
sessions for 56
troubleshooting 219
phone contacts 8
Phone dialog box 47
phone headset 61-62
phone lock feature 189, 190
phone numbers
See also phone; phone
calls
adding to messages 86
assigning to speed dial
buttons 58
checking 13
copying 48, 49
dialing 12, 44-49, 55, 59
entering manually 49
redialing most recent 48
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saving 54
selecting 23
Phone Off
236
Phone Settings page 176,
179,180
Phone Settings screen 13
phone status icons 41
Phone/Send button 6, 13,
236
Phone/Send icon 44
phone-off icon 11
phone-to-computer
connections 115
picture files 127
picture speed dial buttons
46, 58
pictures
as backgrounds 124, 173
as screensaver 126
assigning to contacts 176
changing resolution 120,
125, 230
creating caller ID 67
defaults for 119
deleting 125
editing 124
naming groups of 126
organizing 123

previewing 230
saving 126
sending 123
setting default size 126
synchronizing 127
taking 119-120
troubleshooting 229
viewing 122, 127
Pictures & Videos application
119, 120, 121
PIM applications 223, 235,
236
Play button 129
Play Slide Show command
122
Play sound check box 183
Play Sound list 194
playback icons 59, 129
Playback page 132, 143
Playback screen 132
playback, ending 130
playing
media files 129
presentations 143, 144
sounds 127, 175
voice notes 78
voicemail messages 51
playlist files 128
playlists 128, 131

PNG files 127
Pocket MSN application 101
POP accounts 87, 90
portable radio. See radio
ports. See IR port; USB ports
Power Settings page 198,
199, 215
Power/End button 6
PowerPoint files 135
PowerPoint Mobile
application 142-144
PowerPoint Mobile icon 143
precautions 244
preferences 171
roaming 180
See also customizing
preferences, setting. See
customizing
presentations 142, 143
See also PowerPoint
Mobile application
previewing
pictures 230
sounds 175, 183
priority levels 75
Priority list 93
privacy settings 179
private appointments or
events 72
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Private setting 72
processor 247
Program Buttons page 186
Programs check box 183
Programs page (GPS
Settings) 196
Programs screen 32
programs. See applications;
software
projectors 144
protected spreadsheets 145
protecting
expansion card slot 166
information 189
Treo smartphone 189—
193
proxy servers 205
punctuation marks 30
push
Direct Push Technology
87

Q

Quality command 121
Quick Keys 59

Quick Tour 37

quitting applications 32, 197

R

radio 241, 247
radio frequencies 239
RAS connections 204
Receive all incoming beams
check box 111
receiving
attachments 96
beamed information 114
email 227
meeting requests 97
text messages 86
Receiving Data message 114
rechargeable battery. See
battery
recipients, sending to
multiple 86
Record button 80
recording
ringtones 175
videos 121
voice notes 78, 188
recording toolbar 78
records 114
recurring appointments. See
repeating appointments
redialing phone 48
redirector (websites) 229
Region page 184

regional settings 184, 193
Regional Settings page 184
Regulatory Information 239
reminders

eventsand 71, 74

system alarms and 194

tasks and 75, 77

turning on and off 183
remote access server 204
remote synchronization 162
Remove Programs icon 161
Remove Programs page 1671
removing

applications 161, 232

Bluetooth connections

110

certificates 195

contacts 68

directory services 95

documents 142

events 73

expansion cards 167

favorites links 105

files 158

items from folders 158

items from playlists 132

messages 98, 99

notes 79

pictures 125
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sounds 175

speed dial buttons 60

tasks 77

workbooks 154

worksheets 154
Rename command 170
Rename/Move command

138, 141, 153, 168
renaming

documents 141

expansion cards 169

items in folders 158

workbooks 153

worksheets 150
Repeat check box 183
Repeat command 130
repeat patterns 71
repeating appointments 71
repeating current song 130
repeating sounds 183
repeating tasks 75
Replace All setting 139, 152
replacing

information 152

text 139

the battery 212
reset button 210
resetting Treo smartphone

191, 210, 211

resolution 119, 230
Resolution command 120
restoring information 212
restoring sound settings 182
retrieving voicemail 52
Return key 28
reverse type 23
revision marks 137
RF Safety Statement 239
Right button (navigator) 21
right-click menus 26
Ring tone list 175
Ring type list 175
ringer switch 5, 182
ringer volume 176
ringer, silencing 50, 182
ringtone IDs 176
ringtone managers 231
ringtones
assigning to contacts 59,
67,123,176
creating video 123
downloading 175
previewing 175
selecting 174
silencing 181
roaming 44, 165, 174, 180—
181
Roaming icon 180

Roaming Preferences
command 180

Roaming Preferences screen
180

Roaming setting 174

ROM updates 209

rotating pictures 124, 125

Running Programs screen
33, 197

S

Save As command 139
Save password check box
89, 92
Save to Contact Ring Tone
command 123
Save to Drafts command 94
Save to list 168
saving
documents 138, 139, 142
information 168
notes 80, 188
phone numbers 54
pictures and videos 126
workbooks 144, 146, 154
Schedule command 165
schedules
adding items to 70, 71,
72,75
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managing 70-73
organizing events for 73
removing events 73
removing tasks 77
sorting tasks on 76
unavailable time on 72
viewing daily 69
scheduling synchronization
164-165
screen
accessories for 216
activating items on 24
adjusting brightness 184,
215
aligning 185
backgrounds for 124, 173
caring for 6
disabling touch-sensitivity
for 189
moving around on 21-23
selecting items on 24
setting appearance of 173,
174, 185
troubleshooting 215
turning off 36, 198, 215
waking up 12, 53
Screen taps check box 183
screens, returning to
previous 23

screensavers 126
scroll arrows 23
scroll bar 23
scrolling 22, 73, 143, 189
SD expansion cards 166
Search dialog box 157
Search for list 157
Search icon 157
searching
contacts list 46
documents 139
spreadsheets 152
web pages 34, 104
searching for files 157, 158

searching for information 34,

139, 152, 157
searching for signal 36
secure websites 195, 229
security 189-193, 195
security certificates 105
Security page 107
security software 189
self-portrait mirror 7, 122
Send outgoing items...

setting 165
Send Sound command 175
sending

copyrighted items 123

email 93, 227

meeting requests 72, 75
pictures 123
text messages 86
videos 123

Sent folder 96, 99

Service Pack 2 87

Services page 179, 180

Set as Today Background
command 124

setting alarm clock 194

sheet list 147

Shift key 28, 29

Short Messaging Service.
See SMS messaging

Short tones setting 176

shortcut icons 32

shortcut menus 26

Show alphabetical index
setting 68

Show contact names only
setting 68

Show list 122

Show Options command
143

Shuffle command 129

side button 6

signal, searching for 36

signal strength 42, 216

signal-strength icon 11, 199
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signatures 98
silencing all sounds 182
silencing ringer 50, 182
silent alarm 182, 183
single carrier radio
transmission 217
Size setting 140
sketching 78
Skins page 133
Slide Show page 125
slide show toolbar 122
slide shows 122, 125, 144
slide timings setting 144
slider 23
slides 122
smartphone
See also Treo smartphone
caution for resetting 211
charging 9
components of 5-7
connecting to PCs 16
disabling touch-sensitivity
for 189
disposing of 242
freeing space on 161, 232
getting help with 37
locking 189, 191
losing 192
low light and 29

management tools for 155
monitoring status 41-43
moving around on 19
not responding 210, 231
not turning on 217
operational precautions for
241
personalizing 171
third-party applications and
230
unlocking 191
usage guidelines for 239
SMS messaging 85, 236
soft resets 9, 210
software
See also applications
hard resets and 211
included with smartphone
1,248
installing 14, 15, 209
songs. See music
Sort by list 150, 158
Sort command 150
sorting
folderitems 142, 153, 158
History list items 106
information 150
pictures and videos 124
tasks 76

Sound Mode positions 182
sounds
changing alarm 194
customizing system 181
playing 127, 175
previewing 175, 183
recording 175
selecting 182
setting Dialpad 176
setting ringtone 174
turning off 182, 183
Sounds & Notifications page
174,182
Sounds page 182
SP2 87
Space key 28
speaker 7, 128
Speakerphone 53
speakerphone 53
Speakerphone command 53
special characters. See
alternate characters
special occasions 70
specifications 247
speed dial buttons 46, 58-61
Speed Dial Options
command 60
Spell Check command 86, 93
spell-checking 86, 93, 141
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Spelling command 141
split bar 147
spreadsheet templates 144,

146, 154

spreadsheets

See also Excel Mobile
application; workbooks

accessing 135

changing order of
worksheets 149

creating 144

displaying 144, 145

entering data in 146, 148

filtering in 151

searching 152

sending 83

sorting in 150

Start button 6, 32
Start menu 32, 185, 236
starting

Calendar application 69
Contacts application 67
data connections 205
Excel Mobile 146
Internet Explorer 102
Media Player Mobile 129
Notes application 77
Pictures & Videos
application 119, 120

PowerPoint Mobile 143
Quick Tour 37
synchronization 164
Tasks application 75
Word Mobile 138

static electricity 244-245

status icons 41, 98

stereo adapters 62, 128

stereo headphones 128

Stillimage compression level
setting 126

Stop command 130

stopping playback 130

stopping synchronization 164

Storage Card page 169, 197

Storage Card setting 167,
168

storage card symbol 158

storage cards. See expansion
cards

Storage page 100

storage temperatures 249

storing
applications 232
attachments 97, 100
document files 140
information 166, 232
passwords 89
workbooks 153

Strikethrough setting 140

stylus 5

support information 37

swapping calls 56

Symbol command 146

symbols 30, 59, 146

sync cable 17, 222

sync conflicts 89

Sync Setup Wizard 162

synchronization
scheduling 164-165
setting options for 161
starting 164

troubleshooting 210, 220-

224,228
synchronization icons 35
synchronization software 14,

15

synchronizing

dates and time 194, 223

email accounts 95

information 14, 34, 164,
221

offline 222, 223

over Bluetooth
connections 111

over infrared connections
115

pictures and videos 127

274

INDEX



playlists 128
prerequisites for 14
remotely 162
web files 107
wirelessly 86, 108
with Exchange Server 162
with multiple computers
163
system alarms 194
system errors 217
system locks 189, 191
system requirements 15,
249
System Settings page 184,
185, 195, 196, 197
system sounds 181
system warnings 182

T

tables in documents 137
tabs, scrolling through 22
taking pictures 119-120
tapping 21, 24, 183, 216
tasks

adding 75

deleting 77

displaying 76, 77

marking as completed 76

marking as sensitive 76

setting reminders for 75,
77
Tasks application
customizing 77
filtering options for 76
starting 75
synchronizing with 34
Tasks entry bar 76, 77
Tasks icon 75
Tasks list 76
TDD devices 241
technical assistance 37, 231
temperature range 249
templates
documents 138, 142
spreadsheets 144, 146,
154
temporal key integrity
protocol (TKIP) 202
tentative appointments 70
text
aligning 141
changing 139
copying 106
correcting 86, 93, 141
entering 29-30, 188
finding and replacing 139
formatting 140
highlighting 24, 140

moving or copying 139

resizing 184

searching for 34, 139

selecting 23

word-processing features
for 137

text fields 22
text messages

See also messages
addressing 85
creating 85

links in 97

overview 83

phone numbers in 47
sending 86
troubleshooting 219

text messaging service 1
Text Size page 184

Text Speed Dial button 59
text speed dial buttons 46,

58

themes 174, 185
third-party applications

5-way navigator and 22,
231

accessing Outlook folders
and 222

freeing internal memory
and 232
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getting help with 160
installing 158
losing 2711
synchronizing information
and 15, 209
troubleshooting 212, 230
third-party vendors 15, 209
Thumbnail View 120, 121
Thumbnails button 121
time formats 185
Time page 185, 193
time settings 193
time zones 193
Today screen 33, 41, 236
customizing 124, 173
Today Settings page 173
tones. See ringtones; sounds
touchscreen. See screen
touchscreen lockout 189,
190
touch-sensitive feature 189
transferring
information 209, 235
media files 128, 132
transition effects (slides) 143
Transparency level list 124
Treo device
features of 1, 37
online support for 37

required items for 2
specifications for 247
Treo smartphone
See also smartphone
compatibility with
third-party vendors 15,
209
compliancy statement for
240
components of 1
resetting 191, 210, 211
turning on and off 11
Treo support web page 37
troubleshooting 207
TTY devices 176, 241
TTY/TDD options 241
TTY/TDD settings 176
Turn on Bluetooth check box
108, 214
turning keyboard backlight on
and off 29
turning off call forwarding 57
turning off screen 36, 198,
215
turning off system sounds
182
turning on alarms 194
turning on indicator light 10
turning phone on and off 11

Typing mode 79

U

unauthorized users 190, 195
unavailable connections 218
unavailable time slots 72
underlining text 137, 140
Unknown Caller setting 174
unlocking
smartphone 191
spreadsheet rows and
columns 147
unread messages 98
unretrieved voicemail 51
unsafe areas 240
untimed events 70, 71
Up button (navigator) 21
Update Library command
130
updating
information 14, 235
media files 131
operating system 209
uppercase letters 29, 188
URLs 130, 142
See also web links
USB hub 221
USB ports 17, 221
USB sync cable 17, 222

INDEX



Use above settings while
roaming setting 165
user discussion groups 37

usernames 236

\

vCal attachments 228
vCard attachments 228
Vibrate when... check boxes
175, 183
vibrating alarm 182, 183
video files 127
Video Mode command 121
Video page 127, 133
video ringtones 123
videos
adding sounds 127
adjusting volume for 175
changing resolution 121,
230
defaults for 122
limiting length 127
organizing 123
recording 121
saving 126
sending 123
synchronizing 127
viewing 122, 127

View Recording Toolbar
command 78
viewing
alternate characters 30
animated images 122
appointments 69
available applications 32
calendar 69
contacts 46, 67
daily schedules 69
documents 137
events 70, 73
items in folders 142, 153
memory usage 197
menus 25, 26
notifications 183
pictures 122, 127
power settings 198, 215
space on expansion cards
169, 197
spreadsheets 144, 145
tasks 76, 77
videos 122, 127
web pages 102, 106
wireless settings 199
virtual private networks. See
VPN connections
Voice Command buttons 187
voice mail buttons 59

Voice mail setting 174
voice notes 78, 188
voice privacy icon 43
Voice Privacy setting 179
voice quality 232
voice recording formats 188
voicemail
customizing 59
playing 51
roaming and 180
sending calls to 49
setting ringtones for 174
setting up 51
troubleshooting 177
viewing minutes usage for
58
voicemail controls 59
Voicemail icon 51
Volume button 6, 175
volume, adjusting 13, 175
VP icon 43
VPN clients 205
VPN connections 97, 204—
205

w

waking up screen 12, 53
warnings 182, 241
warranty 2
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web browser. See Internet
Explorer Mobile
web browsing 1, 104, 105
web links. See links
web pages
accessing 102, 104, 229
clearing links to 232
copying from 106
dialing from 47
display options for 102
downloading items from
105, 159
playing media files from
129,130
returning to recently
viewed 104, 106
searching 34, 104
security settings for 107
setting as home 106
troubleshooting 229
viewing 102, 106
Web search field 34, 104
websites
connecting to 102
ending connections 206
logging into secure 195
problems accessing
secure 229
Week View (calendar) 69

WEP networks 202

Wi-Fi connections 199-203

Wi-Fiicon 201

Wi-Fi routers 112

Wi-Fi SDIO cards 199

Windows Media Player. See
Media Player Mobile

wireless features 36

wireless networks 199, 201

Wireless page 199

wireless phones 36, 112,
243, 244

wireless provider accounts 1

wireless synchronization 86,
108

WLANSs. See wireless
networks

WMA files 128

WMV files 127, 128

Word application 135
See also documents

Word Completion page 188

word matching 139, 152

Word Mobile application
137-142

Word Mobile icon 138

word-processing features
137

workbook list 146, 154

workbooks

See also Excel Mobile
application;
spreadsheets

adding calculations 147

adding cells, rows, and
columns 149

adding charts 151, 152

adjusting column and row
size 150

creating 146

defining filters for 151

deleting 154

display options for 146

formatting options for
149-150

formulas in 147, 154

functions in 148

moving around in 147

naming 146, 153

organizing 153

removing cells, rows, and
columns 153

replacing information in
152

saving 144, 146, 154

searching 152

setting default template
for 154
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worksheet names 145
worksheets 147, 149, 150,
154
See also spreadsheets;
workbooks
WPA networks 202
WPA-PSK connections 202

Writing mode 79

Y
Year View (calendar) 69

Y4
ZIP files 159

Zoom command 120

zoom icons (camera) 120

zoom icons (presentations)
143

Zoom In command 143

zoom settings 145, 147, 188
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